Professional

August 2003
www.ppmag.com

Laurie Klein's infrared & hand-coloring
m Secrets to digital imaging & printing
m Tim Walden's relationship portraiture
m A gallery tour m Tim Meyer's neo-
classic portraiture m Converting from
color mThe sensuality of the darkroom
m State of the union: B8&W film


http://www.ppmag.com

Is this image film or digital?  We cant tell either.

Introducing the U.l Megapixel EOS-IDs. film. And even though it has almost twice the pixel resolution
Canon digital technology has blurred the line between film of previous professional cameras, the Imaging Engine
and digital. With the introduction of the EOS-IDs, still supports continuous shooting of 3 fps for up to
we've erased it. In fact, professionals all over the 10 consecutive shots.
world who have grown to rely on Canon digital are And every EF lens will work the same on the EOS-1Ds
now using this incredibly detailed, accurate and as it does on your 35mm EOS camera.
rugged camera in situations where they used to use In sum, the EOS-IDs is everything professional
only film. photographers have been looking for in a digital
The CMOS Sensor. The excitement about the camera. It's a camera that ensures your digital images
EOS-IDs begins with one of the world’s most will be appreciated just as much as your/film images.
advanced full-frame image sensors, the Canon- GOS-loa Not to mention, be mistaken for them.

developed CMOS. Now the EOS-IDs CMOS Sensor, with its amazing digital REVOLUTIONIZED photography m we REVOLUTIONIZED digital
11.1 megapixel capacity makes digital images virtually
indistinguishable from film.
And even as performance increases, thanks to CMOS technology,
energy consumption has been reduced. The NP-E3 battery pack lasts
up to a remarkable 600 exposures* on a single charge.
The CMOS Sensor is partnered with an equally impressive Imaging
Engine. This “super chip" processes and assembles image data with the

same color accuracy and the same tonal range you can expect from

Canon «now How

O JKH (ai»m | W Inc Canon and BOSan- rejjstcrwi iradurark.” and Canon knew Himand  ilitftil rwnluoonwd photography «* nvAmonard digital arc trademark- ofCanon Inc.
1»a0 © Barton BunMck. far more tnSimtalwn. wot us* woo.canoneos.com orcal! I-ntookGamw  * Tested at WF with - *c*>nl image review after each shot

More info? Circle 25



Whether you photograph big group
shots, architectural interiors or individual
portraits, Calumet’s Travelite Kits have
you covered. We’ve assembled everything
you need to shoot in the studio or on
location — except the subject! Each kit
includes a winning combination of
Travelite flashes with our top-selling
stands, lighting accessories and cases.
Besides removing the burden of
assembling your own system, Travelite
Kits also save you a bundle over buying
each component separately. With such
affordable prices, it’s no wonder that our
kits have earned the reputation as being

today’s best value in monolights.

Get the most for your hard-earned money with these affordable kits!

Travelite 375

Travelite 750

45" Silver/White Umbrella

120° Umbrella Reflector
24x32" Soft Box w/Adapter Ring
4’ Snoot

8 Travelite Stand

Carrying Case

Stand Bag

Special Kit Prices!

1-800-CALUMET (225-8638) toll-free ordering www.calumetphoto.com ordenng. information and inspiration 24/7

750w/s 750w/s
One-Head Umbrella Kit Two-Head Umbrella Kit
(CHI 550) (CHI 540)
— Two
One —
One Two
One 1\vo
One Two
One One
$549.99 $899.99

1500w/s

Two-Head Umbrella Kit
(CHI552)

$999.99

1875w/s 2250w/s
Three-Head Portrait Kit Three-Head Studio Kit

(CHI 575) (CHI554)
One
Two Three
Two TWo
Two Two
One One
One —
Three Three
One One
One One

$1499.00 =M HU'i'M

New York, NY 16 W. 19th St. « 212/989-8500 Cambridge, MA 65 Bent St. « 6J 7/576-2600 Bensenville, IL 890 Supreme Dr « 630760-7458
Chicago, IL 1111 N. Cherry * 312/440-4920 San Francisco, CA 2001 Bryant St. « 415/643-9275 Santa Barbara, CA 228 E Cota St. « 805/965-7053

Santa Ana, CA 1430 S. Village Way « 714/285-0143 Los Angeles, CA 1135 N Highland « 323/466-1238

Prices are subject to change without notice.
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The Black and White Issue

Features

40 Black-and-white fine art

Alive and well and hanging in the very best galleries
By Richard Pitnick

26 Black and white and infrared

Relationships, nature and the artistry of Laurie Klein
By Jeff Kent

Capture the essence of
relationships with B&W

Tim Waldens loose, emotionally charged style satisfies
his artistic yearnings—and his bank account

By Jeff Kent

©Huntington Witherill

Revisiting the B&W classics
Celebrate the past but shoot for the present
By Tim Meyer
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On the Cover:

Laurie Klein, of Brookfield, Conn.,
captured this image of Deborah
Steiner and Christopher Gagnon in
Cape May, N.J., where the bride had
spent her childhood summers. The
blend of dreamy landscape and cap-
tured intimacy are typical of Klein's
style, which she calls "Life Journey."
She photographed the couple using
Kodak High Speed Infrared film, rated
at ISO 400, with a Nikon 35mm FE 2
camera and a 35mm lens and 25R filter.
"l chose infrared film for its inherently
romantic quality,” says Klein. She sepia-
toned the image to reflect the Victorian
style of the surroundings, and hand-
colored the billowy clouds, sea grass,
and fence. Leaving the couple in black
and white added dimension to the
image. More on photographer Laurie
Klein, beginning on p. 26.

©Laune Klein
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®| FUJIFILM

Oat the Picture Hr

This is a business.
Fujifilm really understands that."

—MaryBeth McCormack

With Fujifilm Professional, you're in business.
Start with the Studiomaster PRO workflow
software package used for digital image editing,
presentation and ordering. It saves time for order
preparation and increases accuracy of order
details, eliminating error and waste.
Use it to place orders to a Frontier Pro Lab,

or print directly to a Pictrography. Options for retouching

include using the built-in tools or sending instructions to the

lab. Integration with top album companies enables the use

of Smart Pages to eliminate taping and gluing. That means

you can focus on building sales, profits and customer satisfaction.

The Colourkit Profiler Suite is color management software that provides
modularized components for profiling monitors, input and output devices, as
well as a batch processing utility. It's a professional, high-specification product
applicable to a large range of users at affordable prices, and it's even more

cost effective because you can purchase just those elements required.

For on-demand digital photo printing, the Pictrography * m
4500 Digital Printer delivers prints in just over a minute
with quality you have to see to believe. The Pictrography 4500

utilizes silver halide technology for true photographic prints.

. a
And there’s no better choice for lab-processed prints than

Fujicolor Crystal Archive Professional Color Paper. Vivid color,
rich tonal gradations and brilliant whites. All with lasting quality

your clients will enjoy for generations.

For more information call 1-800-800-FUJI, Option #2, or visit www.fujifilm.com n
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Mamiya

645 image shown actual size

optional film or digital backs]

It you arc thinking about buying any new professional
camera, film or digital, see 645AFD interactive CD first.
To get your FREE C”™> visit www.mamiya.com

MAMIYA AMERICA CORPORATION
8 Westchester Plaza, Elmsford, NY 10523

For Mamiya super saving bonuses visit www.mamiya.com
Phone: 914-347-3300 « Toll free FAX: 800-321-2205
www.mamiya.com ¢ E-mail: infomamiya.com
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( idled from thelJilts of the I'PA Loan Collection, Folio is a monthly samf>le of award-winning PPA-mmher photography.
The lj>an ( ollection is a select group of approximately 4(x> photographs chosen annually from more than 6,000 total entries.

Julie Lynn Hughes

In May 2001, the General
Federation of Women's Clubs
hosted a competition among
its branches to imitate David
Robinson's painting, "The
Women's Club." The Women's
Club of Stuart, Fla., hired Julie
Lynn Hughes, M.Photog.Cr., of
Abbey of London Studios to
capture its entry in the
competition. Shooting with a
Bronica ETRSI medium-format
camera and Bronica 75mm
/2.8 lens, Hughes exposed
Kodak Professional Portra
400NC film for Assecond,
somewhere between /16

and f/11. The lighting was
simple—a Novatron 600
watt-second light about 45
degrees camera left and a
second Novatron with
diffusion as fill opposite the
main light. The final image
was touched up in Adobe
Photoshop, where Hughes
also added the character at
the top right corner.

Eric J. Brun

Snapping images of a bride and
groom on their wedding day, Eric J.
Brun, PPA Certified, M.Photog.Cr., of
Contemporary Images Photography
in Omaha, Neb., captured
"Enchanted Forest" as the couple
took a romantic walk in the woods.
Shooting with a 20-year-old Canon
AE-1 Program 35mm camera and
Sakar 28-80mm lens fitted with a
vignetter and a deep red filter, Brun
exposed Kodak High Speed Infrared
HIE film rated at ISO 100 for A
second at f/16. Brun has created a
total of 11 PPA Loan Collection
prints with his trusted Canon.



Jon Marion

While setting up camp in the Mongolian
countryside, Jon Marion of Photography
by Jon Marion in Midvale, Utah, met a
group of nomadic herdsmen. After the
surprise of meeting a foreigner wore off,
the group consented to some
photographs. Marion captured "Mongolian
Horseman" with a Hasselblad 503CX
medium-format camera and Carl Zeiss
50mm f/4 Distagon CFi lens. He exposed
Kodak Tri-X 400 film for K5second at f/8.
Using natural sunlight, Marion also
employed a Hasselblad 4504 electronic
flash at the lowest setting to balance the
shadows. He used Kodak Sepia toner on
the grass and skin for the final image,
which is part of a gallery project
documenting the various nomadic tribes
and ethnic groups in Mongolia and Tibet.

©Jon Marion

©William Stevenson
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William Stevenson

William Stevenson,
M.Photog.Cr. Hon.M.Photog.,
of Naples, Fla., a past
president of Professional
Photographers of America,
captured "NBC, Eat Your
Heart Out" on vacation in
Hawaii. He lay on the
pavement between two
parked cars to capture this
peacock chasing hens in a
parking lot. Shooting with a
3.11-megapixel Canon
EOS-D30 digital camera and
Canon 28-135mm /3.5 EF
USM lens, Stevenson used
the camera's auto exposure
setting. He altered and
enhanced the color to his
satisfaction in Adobe
Photoshop. In addition to
winning numerous trophies,
Stevenson has been honored
with two PPA National Awards
and a Kodak Gallery Award.
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WHAT'S NEW « EVENTS « HOT PRODUCTS « GREAT IDEAS « ETCETERA

contact sheet

A MODERN VINTAGE

Today's timeless images
come in black and white



©Jack Spencer

egardless of subject matter, it is the
Runique quality of black and white and
the evocation of mood that photographer
Jack spencer, Of Nashville, Tenn., conveys
in his timeless black-and-white imagery. A
fine art photographer for almost 25 years,
Spencer blends refined toning with hand-
coloring techniques on traditional black-
and-white papers to recreate the patina
and feel of vintage photography.

"I'm drawn to old photographs, and | love
the way they're aged, tinted and faded,"
says Spencer. "l think there is more mystery
and a different kind of mood created in
black and white that you don't see in
color. Sometimes color gets in the way
and can be a distraction in a photograph.
Black and white seems to have more spirit
to it and appeals to me more."

In the darkroom, Spencer works like a
composer, using different combinations of
papers, chemistry and toner to strike the
proper mood and feeling for each subject.
"l never plan anything. Itry to allow the
image to dictate where it wants to go,"
explains Spencer. "Every negative has
something to say. | keep playing around
until it works and looks finished."

Spencer's first book of pictures of his
native South, "Native Soil," was published
by Louisiana State University Press in
2000. His next book, scheduled for release
fall 2004, is titled "Apariciones." This work
features landscapes and portraiture taken
in Mexico. Spencer has two upcoming
shows this fall in Bologna, lItaly, and in
New York at the Bonni Benrubi Gallery.

You can reach Jack Spencer by e-mail, at
zoza@comcast.net.

—Richard Pitnick

House passes small business h

mall business owners and their

employees have won a victory that
puts them one step closer to obtaining
reasonable health insurance. The U.S.
House of Representatives recently
passed H.R. 660, The Small Business
Health Fairness Act, by a margin of 262
to 162, with 11 members not voting.

Professional Photographers of America
—the only organization for professional
photographers that maintains a full-time
government affairs staff—was among
the organizations lobbying in favor of
the bill. The PPA campaign included the
mobilization of the association's 14,000
members by e-mail, an intense direct
lobbying campaign on Capitol Hill by
PPA CEO David Trust, and testimonials
from PPA members relating the difficulty
of obtaining reasonable health insurance.
Currently 28 percent of PPAs members
have no health insurance at all.

The bill proposes that professional asso-
ciations be allowed to offer members group
health insurance on a national basis, much
as large corporations and unions presently
offer the same health coverage to
employees in various states. If this bill is
enacted into law, it is expected to help
drive down premiums and make insur-
ance more affordable for small
businesses, including independent
professional photographers.

ISLATION

The efforts of PPA and its members were
part of a larger campaign by small busi-
ness owners through the Coalition for
Access and Choice Through Association
Health Plans. The AHP coalition consists
of more than 100 trade associations,
representing some 12 million small
businesses and 80 million employees.

HR 660 and the fight for affordable
health insurance now moves to the
Senate, which has been a stumbling
block for AHP legislation in previous
years. However, PPA and the other
members of the coalition believe that
this year represents their best
opportunity to convince the Senate to
move forward with the legislation.

Since the Bush administration has
already endorsed the AHP legislation,
the Senate is the only remaining
obstacle between small business owners
and affordable health care.

—Stephen Morris, operations manager,

PPA Copyright and Government
Affairs Department

5 GREAT FLICKS TO MAKE YOUR SHUTTER CLICK

If this summer of sequels and prequels
leaves you desiring more from the silver
screen, check out these stellar picks that
feature photographers in starring roles.

Amelia: This whimsical French love
story follows a benevolent young
waitress (Audrey Tautou) with slightly
mischievous ways through the streets and
Metro stations of Paris, as she tracks a
shy young man (Mathieu Kassovitz)
with a penchant for thrown-away
instant photos.

Blow Up: A nihilistic fashion
photographer (David Hemmings), bored
with his fast-paced life in 1960s London,
turns his lens on the seedier side of the
city, and winds up in the middle of a
sordid murder mystery. Also starring
Vanessa Redgrave.

Foreign Correspondent:
This Hitchcock classic
tells the story of an
American reporter
(Joel McCrea) who
gets mixed up in
international intrigue with an assassin
posing as a press photographer in the
days leading to World War II.
Nominated for six Academy Awards.
One Hour Photo: Robin Williams casts
off his comedic persona to portray a photo
lab employee who becomes obsessed
with a family through their snapshots.
Rear Window: Another great Hitchcock
thriller, Rear Window depicts the struggles
of a laid-up magazine photographer
(James Stewart) battling ennui with
voyeuristic fantasies about his apartment
neighbors. Also starring Grace Kelly.
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lympus plans to release the first-ever
O all-digital interchangeable lens SLR
system by this fall. Designed totally for digital,
the Olympus Digital SLR System with
Digital Specific Lenses comprises the E-1
digital SLR camera and an initial release of
four Zuiko Digital Specific Lenses, a
teleconverter, a flash and a power grip set.

With several years of research and develop-
ment behind it, the new Olympus Digital
SLR System sets out to prove that a camera
body and lenses designed to coordinate
with the image sensor can out-perform
film-digital hybrid systems for professional
photographers. Among the system's many
innovations, Olympus is touting image
quality, durability, speed and size.

In what looks to be the beginning of a
trend, Olympus chose quality over quantity
by incorporating Kodak's KAF-5101CE
CCD, a high performance, 5-megapixel
Super Latitude Full Frame Transfer CCD
that, according to Olympus, delivers the
highest dynamic range, least noise, and

best color of any sensor in its class. To
support the sensor, Olympus employs
TruePic Technology, new noise filter
technology and the Supersonic Wave
Filter, which uses high-speed ultrasonic
vibration to keep the sensor dust-free.
The E-1 body is made with a lightweight
magnesium alloy, has dimensions similar
to the E-20N, and weighs in at 23.2
ounces (without battery or CF card). With
second-generation coreless motors, the
Digital Specific Lenses achieve focus
speeds comparable to or better than film
SLR lenses. The E-1 can capture 3 frames
per second in any image quality mode, for
a burst of 12 frames—an impressive burst
rate, thanks to the separate camera
control SDRAM, a large SDRAM buffer,
and exceptional parallel processing.
Based on the Four-Thirds System, the
initial lenses available for the Olympus

Digital SLR deliver light directly to the
sensor. According to Olympus, the Zuiko
lenses yield higher resolution and twice
the resolving power of 35mm film lenses
built for digital. The first lenses to be
released for the E-1 will be a 15-54mm
f/2.8-3.5 (equivalent to a 28mm-108mm
lens on a 35mm film camera), a 50-200mm
/2.8-3.5 (100mm-400mm equiv.), a 50mm
/2.0 1:2 Macro (100mm Macro equiv.), and
a 300mm f/2.8 Super Telephoto (600mm
equiv.), along with a TC14 1.4X
Teleconverter.

The camera can capture images in JPEG
and RAW file modes simultaneously,
without slowing the capture speed. The
MSRP for the E-1 body is $2,199, with lens
options ranging from $599 for the 14-
54mm and 300mm lenses to $7,999 for
the 300mm lens.

—Joan T. Sherwood
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ONETIME ONEPLACE ONEPURPOSE

Family & Children

© lua ham

Wedding -

Marketing

© John Pran

& Management -

Seniors

© Sam Hydan

Beginning in 2004, PPA will hold all of its specialty conferences (Family & Children, Wedding, Marketing & Management and Seniors)
on a staggered schedule and grouped around a single trade show in January. This new format allows photographers to attend their
favorite specialty conference, while providing the added value of being able to attend programming at the other specialty conferences
all at one affordable price. We are adding fun and excitement while still providing top-notch education in an intimate environment along
with a Trade Show that will provide 3 days of high energy and educational information for all attendees. Please visit WWW .ppa.com for

more information.

Sunday, January 18 - Thursday, January 22, 2004 - Beau Rivage Resort & Casino, Biloxi, MS

12 . professional Photographer « August 2003

© Donna Swiecichowiki
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Profoto Acute2. Performance on-location

| “An assignment for the New York

| Times Magazine took me to Bangor,

| Maine, home of legendary writer
Stephen King, to do a story that
included among other things, his

= infamous accident. | knew my time

would be limited, and that I'd have
to shoot in two locations, because
in addition to the portrait, | wanted
a photograph of the van that
changed his life. | packed up my
Acutes knowing that I'd have all of
the power and versatility I'd need.

| Even though | had to shoot fast, my
Profoto light Shaping Tools gave me

[ exactly the quality of light | wanted.”

JEFF RIEDEL
©Jeff Riedel
L Get Profoto Acute2 Flash Head for only $100 E\{/Otf?t? blara. Elmsiord. NY 10523
imited time : estchester Plaza, Elmsford.
with Purchase of Acute2 of Acute2R Pro\{alue Pack Phone: 914-347-3300 « Toll free FAX: 800-321 2205
bonus>  (or Acute2 or Acute2R Rash Generator with 2 heads) www.Profoto-USA.com « E-mail: mfo@Profoto USA.com

Visit us at www.Profoto-USA.com for details


http://www.Profoto-USA.com
http://www.Profoto-USA.com
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Dark victory; triumph OVER SHADOWY SETTINGS

arkness is just fine for dancing, but it's
unite a problem when you're
documenting a wedding. If yoiVre having
trouble lighting dark, spacious interiors
like churches, reception halls and
synagogues, don't worry. You're not alone.
Experts Charles Maring, of Wallingford,
Conn., and Susan Jackson, PPA Certified,
of St. Louis, offer two different solutions
for one befuddled photographer:

Befuddled: I'm having trouble with big,
dark interiors. My studio lights only cover
a small area, and they can't be used for
photojournalism-style shots. The light from
my Canon Speedlite 420EX flash on my
Canon EOS 1Ds camera looks best
bounced, but you can't bounce very well
in an arched cathedral, and the recharge
time isn't always fast enough to catch
everything.

Charles Maring: Digital capture is a key

element in capturing images in dark
interiors, as digital tends to record more of

bogen

the ambient color saturation. How you
light dark interiors depends on whether or
not there's a subject in the foreground. If
not, simply expose for the brightest area
in the cathedral. Do not use a flash, and
set your camera on a tungsten-balanced
setting. Consider using a tripod and a
long exposure.

When there is a subject in the
foreground, | almost always use a flash. |
bounce the light, but | use a Stofen Omni-
Bounce (www.stofen.com). This little
plastic piece fits over the flash and sends
light forward as well as up. | usually stay in
close to my subject and use a wide-angle
lens, such as a 17-28mm. A fast aperture is
the key. | would definitely shoot at f/2.8
for both candids and portraits. Fast
aperture allows the ambient light in the
distance to remain bright, while the
subjects in the foreground are well lit.

Susan Jackson: When shooting weddings,
the only artificial lighting | use is my on-
camera flash, and sometimes an additional

strobe or spotlight when I'm at the
reception. Various combinations of the
following usually work well in low-light
interiors:

1. I drag the shutter consistently about M
second (sometimes even lower) and use
the on-camera flash for fill.

2. | rate my Fuji FinePix S2 Pro digital
camera at ISO 1600. It does a beautiful
job in low light.

3. I use really fast lenses (f/1.4).

4. | use my 70-200mm f/2.8G ED-IF AF-S
VR Zoom Nikkor lens so | can handhold
the camera in really low light.

5. I'will set up one Photogenic
Powerlight or Quantum Q flash at the
reception for more three-dimensional
lighting and still drag the shutter to pick
up ambient light. | add fill with my on-
camera flash.

6. When shooting formals in a dark
church, I mount the camera to a tripod
and drag the shutter about %second,
using a flash for fill.

7. At the reception, | will quite often
work off the videographer's light.

CARBON ONE SERIES TRIPODS. LONG, STRONG, UGHT AND
RIGID. UNIQUE 3 FACETED CARBON FBER COLUMN -

ELIMINATES ROTATION AND

INCREASES  STABILITY

» 3 INDEPENDENT LEG ANGLES - PUSHBUTTON

SETTING

QUICK ACTION LEG LOCKS

LOW ANGLE

ADAPTER mSTORES ON THE BOTTOM OF THE COLUMN

AVAILABLE IN 3 OR 4 SECTION MODELS

MODELS 441

AND 440 HAVE HORIZONTAL / VERTICAL COLUMNS,
SPIKED FEET AND BUILT-IN BUBBLE LEVEL

More info? Circle 29

Carbon
One 440 443 441 444

Closed 205 228 244 192

Min 10 118 125 87
Max 618 677 677 618
wt 36 35 35 3.6

Load 1 13.2 13.2 1
No. Sections 4 3 3 4

Order
Code W4 WD M3 D

Bogen Photo Corp., 565 East Crescent Ave, Ramsey, NJ 07446 Tel: (201)818-9500 Fax: (201)818-9177 www.bogenphoto.com


http://www.stofen.com
http://www.bogenphoto.com

Above: Shooting with a Nikon D1X digital
camera and a 17-35mm f/2.8 lens, Charles Maring
captured the details in this spacious interior by
exposing for 1/60 second at f/2.8. Using the
Auto White Balance camera setting,, he shot at
1SO 400, and bounced the light from the on-
camera flash through a Stofen Omni-Bounce.
Right: Shooting with a Nikon D1X camera and
17-35mm /2.8 lens, Maring exposed the CCD for
X second at /2.8 with his camera braced on a
tripod. With the white balance set to Tungsten
Mode, and using no flash, he shot at ISO 125.

More info? Circle 30

"-ages ©Charles Maring
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ugust in Atlanta. The sky hangs heavy
A and damp above the city,\and everything
moves kind of slow. Except for the ravenous
mosquitoes. Years ago, they'd politely wait
'til dusk to dine, but these recent exotic
imports have no manners whatsoever. All
in all, the greatest thing about the Great
Outdoors in summertime is that it's out there.

Thank heavens for indoor entertainment,
like books. The really good ones take you
everyplace you want to go in the air-
conditioned cool of your personal space.
To wit, "Searchings: Secret Landscapes of
Flowers," photographs by Barbara Bordnick,
the renowned New York fashion and portrait
photographer (Welcome Books, $40).

We all know about the birds and the bees,
but flowers? Who knew flora could exhibit
such passion? The golden beads of pollen
quivering on delicate pink petals, the siren
thrust of the stamen, the soft white down
guarding the innocence of a bud at the
threshold of full blossom...These gorgeous
close-ups, captured with Canon EOS digital
cameras and Canon lenses, are so intimate
as to make you blush. "Searchings" is a

In this new column, Features Editor Leslie Hunt
explores the influences at play in the cultural
climate of photography.

completely satisfying nature fix without
having to battle the elements.

Passion of any kind is largely unwelcome
in the world of cities and office cubes and
market surveys. That's one reason why it's
so refreshing to hear photographers like
PPA member Thomas Balsamo speak of
the passion they feel for their work. In PPs
June 2002 feature on Thomas, we talked
about his most recent passion, capturing
images that reveal the spirit of kids seemingly
lost behind the closed doors of autism.

In the recently published "Souls: Beneath
and Beyond Autism" (McGraw-Hill/Books
That Touch, $31.50), Thomas partners with
writer Sharon Rosenbloom to lovingly
show us that autistic kids aren't lost at all.
Writes Rosenbloom, "Beneath and beyond
autism there is...a will, a soul, an identity
that achieves the full measure of its creation.”
Her words and Thomas's beautiful black-
and-white images are passionate— never
maudlin—in the deepest, most spiritual
sense of the word. The response to the
book has been overwhelming and
gratifying, says Thomas.

"A man's style in any art
should be like his dress — it
should attract as little
attention as possible.”

—Samuel Butler

A portion of the proceeds from the sale
of this and other Books That Touch are
donated to the Ray of Hope, the nonprofit
organization founded by Thomas Balsamo
to promote the understanding of autism;
visit www.booksthattouch.com.

— Leslie Hunt

“Souls: Beneath and Beyond Autism,"” Thomas Balsamo
and Sharon Rosenbloom, published by McGraw-
Hill/Books That Touch. Images ©Thomas Balsamo.

From "Searchings:
Secret Landscapes of
Flowers," by Barbara

Bordnick. Published
by Welcome Books.
Images ©Barbara
Bordnick 2002.
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The PPA Continuing Education
Committee hopes that you are
taking advantage of the Super
Monday programs offered in
your community. The Committee's
primary concern is that profes-
sional photographers are getting
the continuing educational

opportunities that they deserve.

This lineup of November
classes represents programs
that attendees have told us
were beneficial and worth-
while,. so we've asked those
instructors to offer them
again. Other programs in
the catalog are being
offered for the first time by
accomplished photography
instructors who have seen

a need to bring new subject
matter to the professionals
in their community.

ALABAMA

Huntsville

Course # AL 10

Studio Management

Glenn W. Campbell, PPA Certified
Whether you are considering hiring your
first employee or you already employ 20,
this program will provide valuable
studio management and operation poli-
cies that will facilitate the smooth and
efficient performance of your business.
Learn hiring and firing procedures,
proper documentation and company-
wide communication. You will even
receive an employee manual that will
help you avoid difficulties in your
studio.

ARIZONA

Glendale

Course # AZ 10

Gentle Boot Camp— The Basics

Ty Bass, PPA Certified

Whether it new information or just a
review, make sure you have a firm grasp
of the basics. Join Ty for this gentle boot
camp and get a comprehensive, up-to-
date look at fundamentals, such as
composition, facial analysis, lighting and
posing. Please note that this program will
be held on Sunday, November 2, 2003 from
9:59 AM—5:59 PM.

CALIFORNIA

Encinitas

Course # CA 10 B

Out of the Bluel Blue Pixel H
Factory: Creativity at Work

Gigi Clark, PPA Certified,
M.Photog.Cr., API

Greet the morning with your "cup o’
Java" and a rise and shine special presen-
tation by award-winning wedding and
portrait photographer, Gigi Clark.
Expect an overwhelming menu of ideas
that you'll be able to immediately apply
to your bridal portraiture. Find out
ways to make your clients look great.
There will also be a dash of creative
marketing techniques to spice things up!
Be prepared to get more than you
bargained for! Bring S15.00 and you'll
get a personal "goody bag" full of
creative tools, materials, and a syllabus
or two! Please note that this program will
be heldfrom 9:30 AM - 5:30 PM.

Napa 8

Course # CA 20 BEE
Photoshop for Beginners

Lisa Jaeger

This course will be an introduction to
not only Photoshop (6.0 or 7.0), but all
things digital: digital workflow, color
management, retouching, layers and

Rocklin
Course # CA 30 HELDID
The Cutting Edge—Wedding
Presentations

Bryan Welsh, Cr.Photog.

Michele Santee

This will be an image-driven program
that demonstrates selling and marketing
that will give you control, speed and
results. Learn from Bryan and Michele,
as they show how they use various
selling and presentation programs to
take sales to the next level.

San Mateo
Course # CA 40 BI LE
Storytelling Environmental
Engagement Portraiture

Francis Wong, PPA Certified

Enjoy an exciting day with environ-
mental portrait photographer Francis
Wong. Explore his unique storytelling
style for photographing environmental
engagement portraits, using flash with
any shutter speed and 35mm cameras.
This workshop will be a hands-on day of
photographing on-location with a

model.

Solvang g M b
Course # CA 50

Back to the Basics—Learning to
Market Weddings

Marcia Mauskopf, PPA Certified

This class is a must for the beginning
photographer. Spend a day with Marcia,
as she details the ins and outs of
successful wedding photography
marketing techniques.

Class Sizes Are
Limited



Tustin E E
Course # CA 60

Digital

Basic Digital Photography &
Digital Workflow

Julie Diebolt Price

Julie will take the intimidation out of
digital photography by detailing how a
digital camera works—from image
capture to the computer. More than
that, she will cover digital workflow all
the way through client deliver)’

COLORADO

Denver

Course # CO 10

The Right Stuff

Sara Frances, M.Photog.Cr., API
Karl Arndt

Having trouble finding useful tips for
practical digital capture and .post
production? Leam Sara and Karls
secrets to fast, efficient, realistic work.
You'll save time, money and energy!
Please note that this program will be held
on Monday, November 10, 2003.

Grand Junction
Course # CO 20 E[E
A Day in the Life of a Digital
Portrait Studio

David H. Davis, PPA Certified,
M.Photog.Cr.

Streamline your studios operation trom
digital capture to deliver)'. Experience
actual sessions, archiving and retouching
images, projection, and production of
finished portraits. Then discuss with
David what steps you should take your-
self and what you should let your
professional lab do for you. Please note
that this program will be held on Monday,
November 10, 2003.

Register by
October 13th

for only

FLORIDA
Fort Myers

Course # FL 10 I Efﬂ
Wedding Photography from A-Z
Paul Foreman

If you're just starting out in wedding
photography, this class is for you. Paul
will explain some of the key compo-
nents of a successful business in this
field: marketing, equipment, organizing
groups, contracts and paperwork. You
will finish the day with a session of
posing and lighting with a live model.

Naples

Course # FL 20

Art & Soul of Digital Printing

Jim Chamberlain, PPA Certified,
M.Photog.MEI.Cr., API

Learn about the art & soul of digital
printing. Get the most from your digital
files by understanding software, color
profiles, paper, ink and your printers.

Ormond Beach

Course # FL 30 EECES
Pixels & Paints

Eddie Tapp, PPA Certified,
M.Photog.MEI.Cr., API

Jane Conner-ziser, Cr.Photog.

This will be a fun-filled day of gaining
digital know-how. You'll start out with
digital capture, work your way through
the entire digital workflow, and then
finally explore the artistic process and
color managed output.

GEORGIA

Atlanta

Course # GA 10

Blending Fine Art Techniques
with Photojournalism and
Traditional Wedding Coverage
Eileen Adams, PPA Certified

Students of this program will learn how
to blend techniques for optimum
wedding coverage. Eileen will introduce
you to a world of art direction and
artistic enhancement, focusing on
outdoor photography. If weather
permits, part of the workshop will be
conducted outdoors.

On Super Monday, November 3,
2003, professional photogra-
phers nationwide will host
professional imaging seminars
in their studios. You can be a
part of this educational event,
open to all, by attending a
seminar in your area for a
pre-registration enrollment fee
of only $99. This is your
opportunity to learn new skills,
improve your business, and
increase your profit margins.

Pre-register by October 13, 2003
and pay just $99. On-site regis-
tration is $120. Super Monday is
open to all photographers. PPA
members receive one service
merit for attending. Classes are
held from 9:00 a.m. - 5:00 p.m.
on Monday, November 3, 2003
unless otherwise noted. For
more information or to register
online, go to www.ppa.com or
call (800) 786-6277. Class sizes
are limited, so don't hesitate!
Register now!

CLASS TYPE: CLASS LEVEL:
Commercial Beginner
Wedding Intermediate
Portrait Advanced
Digital
Business
/Marketing
Sports

General


http://www.ppa.com

Atlanta

Course # GA 20

Digital Post Production

Kevin Ames, PPA Certified,
Cr.Photog., API

This program explores digital workflow
in Photoshop (possibly Photoshop 8) as
it relates to the photographer performing
his or her own post production. Topics
will include digital asset management,
workflow that will maximize image
quality, color and tone control, and
Atlanta

composites.

Course # GA 30 e
Batteries Not Included—A Digital
Introduction

Jeanine MacFarlane

Liz Taylor

Frightened by the prospect of a digital
transition? Break down the technology
barrier with Jeanine and Liz. They will
examine the operation of a digital
camera, outline a simple digital work-
flow and get you started with some basic

Photoshop tips. Explore costs, as well as
the pros and cons of going digital

Cartersville

Course # GA 40

Foundations of Portraits

Louis Tonsmeire, Cr.Photog., API
Take an intensive, day-long look at the
basics of portrait posing and lighting.
Louis shares his wit, wisdom, and years
of expenence as he covers the founda-
tions of successful studio and outdoor
portraiture.

Statesboro

Course # GA 50

Commissioned Portraits vs.
Session Fees

Lori Grice, PPA Certified

DeWayne Grice

Take this opportunity to explore the
possibility of commissioned photog-
raphy, and add more certainty to your
income Photography is the only an
form that allows clients to "try on" a
custom product to make sure they like
it Spend a day looking into other
options that could work for you.

CLASS TYPE: Commercial

Wedding

ILLINOIS

Alton

Course # IL 10

Keeping Light a Part of the
Equation

John Metcalfe, PPA Certified,
Cr.Photog.

Analyzing light is key to creating
phenomenal images. In this program,
John will explore the effects of different
types and styles of light, then teach you
to utilize each one to enhance the
subject.

Highland Park

Course # 1L 20

Enhanced Lighting Techniques
and the Elements of Style
Norman Phillips

Spend a day learning about ways to
enhance your wedding and portrait
photography. In this class, you will
explore lighting techniques that go
beyond the basics, as well as other tech-
niques for creating captivatingly unique
images.

La Grange

Course # 1L 30

Improving Your Creative
"Seeing"

Robert Bresnahan, M.Photog.
Photography is a visual art, so photogra-
phers have to be able to see beauty
where others can not. They view the
world in a different way, and that is what
makes their work so special. However,
there are a number of ways to improve
your skills of "seeing.” Bob will offer
some surpnsing suggestions, and your
work will benefit from the ideas
presented in this class.

Waukegan
Course # IL 40
Essentials of Lighting and Posing
Jim Tisby

Anthony Bass, PPA Certified,
Cr.Photog.

Jim and Anthony bring you an under-
standing of basic lighting and posing
that will allow you to build and main-
tain your customer base. Learn how to
effectively use a 4 light setup and how to
pose females, males and couples.

JH LT

Portrait Digital

INDIANA

Decatur

Course # IN 10 BLEU ]
Brian Andrews, PPA Certified,
M.Photog.Cr.

Marilyn Andrews

Particularly helpful for those just begin-
ning in digital weddings, this program
will cover Brian and Marilyns wedding
plan from the pre-wedding consultation
to the on-location digital photography,
including computer and organization
tips. They will also discuss the endless
options for image and album presenta-
tions.

Marion

Course # IN 20

A to Z for a Home-based Studio
Barry E. Boyer, PPA Certified

Reta Boyer

Operating a home-based studio can offer
numerous advantages, as well as many
challenges. We all need insight and
direction in maintaining a balance
between our business and personal life.
In business for over ten years, Barry and
Reta will cover sales and marketing,
indoor and outdoor prop construction,
lighting techniques, composition and
posing ideas.

South Bend E-I"-ﬂ
Course # IN 30

Making the Most of Your Digital
Tools

Dave Patnaude

Peter Gillespie

Is the digital process for you?
Experience studio processes in creating
digital products, from capture to print.
Follow Dave and Peter as they create a

complete digital studio session, sales
presentation and final print order.

Register On-Line!
Www.ppa.com

Sports Business/Marketing


http://www.ppa.com

Zionsville

Course # IN 40

Today's Brides

Jim Wyant, M.Photog.Cr.
Lois Wyant, M.Photog.Cr.
Hear the Wyants' ideas about what
todays brides want and how you can
give them the service that will keep
them satisfied. Your instructors will also
discuss ways to handle a fluctuating
economy.

IOWA

Clear Lake

Course # 1A 10

Photographic Sales Skills and
Outrageous Customer Service
Aletha Speaker, Cr.Photog., ABI
Craig Schmidt, PPA Certified,
M.Photog.Cr., ABI

This is the third module in the core
requirements for the Certificate of
Business Management program. It deals
with vitally important sales presentations
and customer service issues including:
consumer buying motives and character-
istics, telephone techniques, pre-sale
presentations, wedding consultations,
portrait planning sessions and projec-
tion appointments. The course will
also look at a variety of preview and
sales methods. Please note that this
program will be held on Sunday,
November 2, 2003.

ELBE

KANSAS
Olathe

Course ft KS 10 E-iELEE

Marketing Seniors & Outdoor
Lighting Challenges

Brad Crooks, M.Photog.

Leon Crooks, M.Photog.Cr.

Learn valuable techniques to reach the
senior market, including inexpensive
ways to reach large numbers of students
and proven networking techniques for
seniors. In the afternoon, Leon and Brad
discuss lighting techniques for outdoor
portraiture. Learn to overcome the chal-
lenges in outdoor situations and get the
best results, regardless of time of day.
Weather permitting, practical applica-
tions will be presented at a local waterfall
and park. Please note that this program will
be held on Monday, November 10, 2003.

Art/Technical General

Topeka

Course # KS 20 EELEE
Surviving the Digital Transition
Jim Sovanski

Is the digital revolution staring you in
the face? Not sure which way to go, or
is your transition not going as smoothly
as you'd like? This class is a survival
guide for converting to digital wedding
and portraiture. Jim will focus on your
needs and concerns, while searching for
specific solutions.

MARYLAND

Frederick

Course # MD 10

Website Development for
Photographers

John Stein, PPA Certified

This course is intended to give photogra-
phers valuable information for creating their
own websites. Some of the more popular
web design programs will be covered, along
with basic HTML coding. Selecting a
website hosting company will also be
discussed. Please note that this program will
be held on Tuesday, November 4, 2003.

Silver Spring

Course # MD 20

Win-Win: Creating Merit Prints
for Clients and Competition
Robert A. Nicholson, PPA Certified,
M.Photog.Cr.

Billie A. Nicholson, PPA Certified
This award-winning couple will share
the techniques they have used to create
the compelling images that have earned
them numerous awards. They will teach
you methods that employ both
Photoshop and manual techniques that
will make clients and print judges rave.
No questions will go unanswered.

Register by
October 13th

for only $(~CA

CLASS LEVEL: Beginner

| | 1 Intermediate

MICHIGAN

Bay City b--mmeee- —
Course ft MI 10 I
Weddings...Still in Love

Mary Ellen Miller

Sherry Holley

Come experience the energy Mar)’ Ellen
and Sherry bring to their photography,
and see why their clients love the way
they capture weddings. From the first
consultation to final delivery, these
instructors will take you through
booking, sales and marketing.
Traditional and photojournalistic styles
will be discussed, film and digital.

twee
nday
2004 Dates:

> April 5, 2004
> November 1, 2004

Advanced



Grand Rapids
Course # MI 20 H E
Progressive Sales Techniques in
a High End Market

David Dejonge

Learn the formula for breaking into the
high end market with the same strate-
gies, planning and strategic placement
that have gained David national recogni-
tion as the official photographer for
Newt Gingrich, Supreme Court Justice
Scalia and more. Please note that this
program will he held on Monday, November
17, 2003.

Kalamazoo

Course # MI 30

Posing and Lighting
Anthony Bass, PPA Certified,
Cr.Photog.

Jim Tisby

Posing and lighting of families, large
groups and couples can be intimidating.
Anthony and Jim cover the fundamen-
tals of successful group portraiture, and
explain how to create a proper theme for
the portrait. Attending this hands-class
will give you the confidence to photo-
graph any type of group situation. Please
note that this program will be held on
Sunday, November 2, 2003.

Spring Lake i
Course # MI 40 H b I a

High School Seniors from A to Z
Jack Adams

This is a dynamic class on high school
senior photography. All of the tips and
secrets of the trade that Jack has learned
in the past 20 years will be combined
into 8 hours of intense training. Posing,
lighting, indoor and outdoor, black and
white and marketing will all be covered.

Register by
October §3th
for only $J(

CLASS TYPE: Commercial

Wedding

Traverse City H B E H tl
Course # MI 50 LJ I "J-—1
Duet with the Duo

Michael Cole, PPA Certified

Loretta Young, PPA Certified,
Cr.Photog.

Michael will share five successful seasonal
specials that generate instant cash flow
and bring new clients into the studio.
Loretta will discuss all of the paperwork
used in her studio, including a studio
policy, payment terms, clothing and
portrait options, appointment times and
copyright. You will learn why they are all
necessary for retaining clients for life.

Williamston pjl"T a
Course # MI 60 —
Digital from Two Perspectives
Shannon Poynter

Rick Gleason

Rick and Shannon will demonstrate how
two studios make digital work, and how
you can too, whether starting with film
or digital capture, working with a Mac
or a PC. Time-saving Photoshop tech-
niques and other digital workflow issues
will also be discussed.

MINNESOTA

Anoka

Course # MN 10 H E
Marketing and Promotions: A
Wake-up Call to Success

Steven L Larson, PPA Certified,
M.Photog.Cr., ABI, API

Craig Schmidt, PPA Certified,
M.Photog.Cr., ABI

This is the fifth module in the core
requirements for the Certificate of
Business Management program. Steve
and Craig will discuss developing a
successful marketing plan that will drive
a studios financial success. Included is
an in-depth discussion on creating
promotional campaigns, selecting appro-
priate advertising, and devisinga
marketing strategy.

Portrait §2 Digital

Anoka H E
Course #M N 20 —
Photographic Sales Skills and
Outrageous Customer Service
Steven L Larson, PPA Certified,
M.Photog.Cr., ABI, API

Aletha Speakar, Cr.Photog., ABI

This is the third module in the core
requirements for the Certificate of
Business Management program. It deals
with vitally important sales presentations
and customer service issues including:
consumer buying motives and character-
istics, telephone techniques, pre-sale
presentations, wedding consultations,
portrait planning sessions and projection
appointments. The course will also look
at a variety of preview and sales
methods. Please note that this program will
be held on Tuesday, November 4, 2003.

Kimball
Course # MN 30
Creating Your Own Canvas and
Muslin Backgrounds

Lisa A. Crayford, PPA Certified,
Cr.Photog.

Students will learn step by step how' to
dye their owm muslins and paint their
own 6 x8’ canvases. Plan on getting
your clothes wet and dirty, and plan on
having lots of fun!

S E

Moorhead | £]
Course # MN 40

From Pixels to Proshots: An
Easy Approach to Digital
Workflow

Paul Hanson, PPA Certified,
M.Photog.Cr.

Mary Hanson

Got questions about digital? Paul and
Mary Hanson have discovered the chal-
lenges of a digital and proofless system
and will share with you how it will work
in your area. They will show how they
handle a typical portrait session and
demonstrate their system, from image
capture to closing the sale.

Sports Business/Marketing



pymoutn  BDBCEIML
Course # MN 50

Creating Digital Albums

Gregory Gittsovich

Explore digital album design and sales
presentations using Photoshop, ProShots
and PictuiesToExe. Gregory will provide
an in depth look at designing the
layouts, the digital workflow process and
how to effectively market and sell digi-
tally designed albums.

Rochester EJdD 1 1M

Course # MN 60

Mother and Child Portraits

Curt Sanders, PPA Certified,
M.Photog.Cr., API

Andie Sanders, PPA Certified,
M.Photog.M.Artist.Cr., API

Join Curt and Andie and see how they
capture the beauty and innocence of the
mother/child relationship. Take part in
a hands-on demonstration with live
models, showing posing, lighting (studio
and window), props and selling. Expect
to be very' involved in this session.

fitn-ru

Kansas City

Course # MO 10

Why Not Go Digital?

Steven R Attig, PPA Certified,
Cr.Photog.

This class will help answer all your
questions from cameras to digital work-
flow. So if youVve been considering
going digital and want to know what to
expect, or if you've thought you should
shoot with several different cameras
before you buy, dont miss this program.

MONTANA

Bozeman oE

Course # M T 10 ]

For Love...or Money?

Steven Winslow, PPA Certified,
M.Photog.Cr.

Learn to photograph weddings because
you make great money AND love the
work! Steven will discuss equipment
needs, how to capture candid and
photojournalistic images, how to convert
inquiries into bookings and more. Most
importantly, discover how you can help
clients relax and enjoy their day.

NEBRASKA

Ogallala

Course #NE 10 m
Special Digital Effects

Katie Arndt

Dave Fowler, PPA Certified,
M.Photog.Cr.

Katie and Dave will show you how to
make real money with special digital
effects. You'll learn how to produce eye-
catching, artistic images that will add to
your bottom line. Take their ideas home
and turn them into profit—guaranteed.

NEW HAMPSHIRE

Bedford

Course # Nil 10
Photoshop 101

Barry Hayes, PPA Certified,
M.Photog.Cr.

Louise Supple

Bariyrand Louises program will give you
a thorough introduction to the world of
Photoshop. They will cover setup,
retouching, opening closed eyes, color
adjustment, layers, diffusion and more.
They will even discuss how to organize
your digital workflow. Please note that
this program will he held on Monday,
November 10, 2003, from 10AM - 6PM.

NEW JERSEY

Marlboro | a
Course #NJ 10

The Ins and Outs of a Jewish
Wedding

Norman Kushner, PPA Certified

Be prepared to capture all the nuances of
aJewish wedding. Norman will guide
you through a thorough discussion of
the terms, timing, customs, expectations
of aJewish wedding, including some
insight into the Chassidic (very reli-
gious) orthodox weddings.

Palisades Park

Course # NJ 20

Create the Ultimate
Studio/Make More $--Add
Digital

Neal H Clipper, PPA Certified,
M.Photog.Cr.

The morning portion of this two-part
program will be spent outlining how to
set up and run a highly successful high-
end wedding and portrait studio. Later
Neal will demonstrate how he has added
additional profit to every contract by
adding digital services to the coverage
Event imaging, digital thank you cards
and more will be shown.

Spring Lake

Course # NJ 30

The Ins & Outs of Painter

Keith Mills, M.Photog.Cr.

Turn your photography into fine art with
the help of Painter. Keith will reveal
some artful tips and some shortcuts that
will help you find your way in this
complex program



NEW MEXICO

Santa Fe

Course # NM 10

Home-Based Studio

Randall West, PPA Certified

Learn to light, pose, display and market
fine wall portraits in your home based
studio in a way that will have qualified
prospects calling your home-based studio.

NEW YORK

Buffalo

Course # NY 10 ®

Digital Photography for the
Portrait Studio—Start to Finish
Bogdan Fundalinski, PPA Certified,
M.Photog.Cr.

Janice Fundalinski, PPA Certified,
Cr.Photog.

This class will demonstrate the use of
digital photography in the portrait
studio, from capture to print. Included
will be importing images, using
Photoshop to adjust, retouch and
enhance, and in-house pnnting.
Students should have a basic working
knowledge of their digital camera,
computer and Photoshop.

Cold Spring Harbor E I]
Course # NY 20

Digital Workflow Made Easy
Owen Kassimir, PPA Certified,
M.Photog.

Len Marks

This program will start with digital
capture and work through the process of
manipulating files and getting them
ready for output This program will
benefit anyone who is already working

in digital and needs help, as well as
anyone just starting out with digital.

How to Design and Build an
Outdoor Studio

Bart Stevens, PPA Certified,
M.Photog. MEI,Cr., API

See how Bart created over 25 individual
sets on only a half acre of land. Learn
how to use shrubbery' and sets to divide
the sections and to utilize light to its
best advantage

CLASS TYPE: Commercial

Wedding

Hopewell Junction

Course # NY 40

Digital Workflow: Tips & Tricks
Eli Sloves, Cr.Photog.

Make sure you're using digital workflow
capabilities to maximize your time. Eli
will go through the most efficient methods
for each step, from image capture to
finished order. Along the way, hell even
present some of the hottest Photoshop
tips and tricks for image enhancement.

Lindenhurst

Course # NY 50

My Bride Would Never Do That
Doug Gordon, Cr.Photog.

Discover the latest trends in wedding
photography with Doug. Learn his 20
poses in five minutes, find ways to
incorporate digital into your workflow,
and unlock the secret to getting brides
on the ground.

NORTH CAROLINA

Raleigh

Course # NC 10 DQ
Flush-Mounted Digital Wedding
Albums

Ted Booker

Wow your brides and grooms by albums
that have been given special treatment in
Photoshop. Ted will teach you to design
pages that have no mats. A background
image is faded and textured, filling the
page, with smaller photographs artisti-
cally placed in the foreground. Then
learn how to burn them to CD, how to
print and where to order your flush-
mounted albums.

Wake Forest

Course # NC 20

Pastels and Portraits

Kittie Rue Deemer

This program will introduce students to
the art of turning a portrait into a pastel
painting. Sample portraits will be
provided, and pastels wall be available
for use. Selection of media, papers,
protective finishes, matting and
mounting of prints will be covered.

Portrait §2 Digital

OHIO

Brook Park

Course # OH 10

Aerial Photography

Karen Neldon

Robert Neldon, PPA Certified

Looking for something new and exciting
to do with your photographic talent?
Here is your chance to explore aerial
photography. Time in the classroom will
educate you about the best equipment,
film, technique, etc. Then, weather
permitting, the group will fly out of
Cleveland, and each student will get an
opportunity to do some actual aerial
photography. The class will lunch at an
airport. Please note that this program will
be held on Sunday, November 2, 2003.

Hilliard

Course # OH 20

Basic Studio Lighting

Trisha Crites, PPA Certified

This program was designed for begin-
ners, explaining and demonstrating the
basics of studio lighting, with an
emphasis on lighting ratios, multiple
light setups, what each light accom-
plishes, composition and more. Posing
and accessories will also be demon-
strated using live models.

OKLAHOMA

Ardmore

Course # OK 10 b e
Using PicturesToExe for Profit
Bobby Groomer

Bobby will demonstrate how the use of
inexpensive PicturesToExe software, in
the sales room, can increase the size of
your sales with little expense or training.
Fairview BELL]
Course # OK 20

Digital Domain

Kent Shirley

Students of this program will learn a
digital workflow from capture to output.
One focus will be learning proper expo-
sure and color balancing for digital. A
Photoshop demonstration will also be
given to show' image enhancement and
appropriate preparation for output to a
lab or ink-jet printer.

Sports Business/Marketing



Oklahoma City
Course # OK 30
Figuring Out Digital
Glenn M. Cope, PPA Certified,
Cr.Photog., API

This class will cover the basics of digital
photography, workflow, output and
archiving for anyone interested in or
having trouble with digital.
Representatives from the lab will cover
ProShots and workflow from the labs
point of view. Bring your cameras for
the opportunity to practice as you learn.

[PENNSYLVANIA

Doylestown S It I I i

Course # PA 10
Print Competition: Life After 79
Eric Stoner, PPA Certified, M.Photog.
There are few things as artistically satis-
fying to a photographer as creating a
merit print. This program will cover the
crucial steps involved in doing just that.
Master the process from composition in
your camera to both traditional and
digital mounting techniques. After one
day, you will possess the knowledge
necessary for creating award-winning
images. Please note that this program will
be held on Monday, November 10, 2003.
Glen Mills

Course # PA 20 HIE Isa

Creating a Studio Identity and
Marketing for 2004

Robert Wood, PPA Certified,
M.Photog.

Understand why your studio identity is
vital to growing your business. Learn
what it takes to create a successful iden-
tity and market it to your greatest
advantage.

EES]

Philadelphia

Course # PA 30

The ABC's of the In Home Studio
Harry R Carter, PPA Certified

This program will focus on getting
started as an in-home studio. Harry will
cover the setup of the physical studio, in
addition to the business setup. He will
discuss marketing basics that will help
you get off the ground and flourish, as
well as time management techniques
that will keep you focused and orga-
nized. If time permits, the class will be
free to do some shooting.

Pittsburgh SE"H
Course # PA 40 .
Digital Capture

Michael Good, PPA Certified,
M.Photog.

Examine digital workflow, from capture
to output, as Michael explains color
balance and correction, color workspace,
monitor calibration and more. Save time
and money with Michaels Photoshop
tips to optimize your lab output.

Waynesboro (fI\w [T]
Course # PA 50 A% LLSY
So You've Got a Digital
Camera...Now What?

Rodney Clark, PPA Certified

Glen Gray, PPA Certified, Cr.Photog.,
ABI

Join Rodney and Glen as they examine
digital issues. Rodney’ presentation
focuses on a working studio3 digital
workflow—one that highly automated.
Glen will discuss digital concepts
relating to printing digital files and using
software to present your images and
prepare them for digital printing. They
will touch on Photoshop, but the main
thrust of the program will be the other
digital issues and software that you will
use on a daily basis, when you enter the
digital world.

West Grove

Course # PA 60 —
Infrared: No Fear

John L Shipman, PPA Certified,
M.Photog.Cr.

John J. Costello, PPA Certified

Get a totally hands-on experience in
infrared. John Shipman and John
Costello will help you enter this high-
end niche by showing you proper
handling, exposure techniques and
processing tips. This class will be held
in John Shipmans residential studio and
the internationally acclaimed Longwood
Gardens. Please note that this program will
be heldfrom 8:30AM - 5:30PM.

PUERTO RICO

Caguas

Course # PR 10 B
Using Photoshop for Self-
Promotion

Angel Diaz, PPA Certified, Cr.Photog.
You can use Photoshop for more than
just creating great images for your
standing clients—use it to recruit new
ones, too! Angel will teach you how to
use Photoshop to manage your
marketing campaign by creating flyers,
business cards, stationery and proposals
that all portray an effective message
Please note that this program will be held
on Sunday, November 2, 2003

E

TENNESSEE

Chuckey

Course # TN 10 H U
High School Senior Portraits
Kendall L Mathes, PPA Certified
Examine all aspects of senior photog-
raphy from posing and lighting to
marketing and sales. See how digital
layouts and Photoshop retouching can
save you money and increase your sales.

Would you like to share your talent and experience with others? Become a Super
Monday Instructor. ContactJoanne Topps atjtopps@ppa.com or visit www.ppa.com.

Art/Technical General

CLASS LEVEL:

Beginner | | |Intermediate

Advanced


mailto:jtopps@ppa.com
http://www.ppa.com

Morristown

Course # TN 20 EETE
Digital Workflow

Michael D. Laughlin, PPA Certified,
Cr.Photog. !

Optimize your digital workflow process
from image capture, to retouching,
output and file archiving. Whether you
are just getting started or looking to
improve, Michael5 program can help
you get the most out the digital process.

Houston

Course # TX 10

Creating Your Business Mission
Statement

Teri Quance

Throughout history, companies with
carefully designed mission statements
have surpassed those that have none.
With Teri, you will go through the step-
by-step process of creating your own
mission statement in a matter of hours,
rather than months or years.

TOT
tTJLJJ

Kingwood

Course #T X 20

It's All About Marketing!
Pat Guard, PPA Certified
Ray Guard

How many marketing opportunities
have you overlooked? Pat and Ray will
examine cross-marketing, community
involvement, newsletters, local media
and the Internet, and show you how to
make them work for your studio.

Lubbock

Course # TX 30

Take Control of Your Website
Mark McCall, PPA Certified

Cory Sinklier, PPA Certified

Mark McCall demonstrates how easy it
is to create, edit and maintain your site
using Microsoft FrontPage 2002 Mark
will cover everything from basics to
creating instant online proof galleries of
your customers’ images. Additional
topics include: Meta-tags, domain
names, web hosting and finding free
professional design templates.

CLASS TYPE: Commercial

Wedding

Pasadena E
Course # TX 40 [
Weddings To Warm Your Heart
Belinda Higqins, PPA Certified,
M.Photog.

Randall Stanford, PPA Certified,
M.Photog.

Belinda and Randall will share their
approach of blending contemporary and
traditional wedding photography.
Topics include marketing. B&'W photo-
journalism and integrating traditional
images with contemporary photojour-
nalism. "Back to basics" posing will be
addressed, as well as treatments for
advanced posing. On-location, "hands-
on" demonstrations in formal, romantic
posing and B&W photojournalism
complete this course.

UTAH

Salt Lake City

Course # UT 10

Digital Photojournalistic
Weddings

Miyo Strong

Photojournalistic wedding coverage is
very popular, and digital methods are
here to stay. Combine the two and
youVe got the hottest style of wedding
coverage around. Come discover tips
and trends in creating the intimate,
spontaneous look that sells so well!

Alexandria

Course # VA 10 E
Taking It To the Bankl
Joe Tessmer, PPA Certified, Cr.Photog.
George Singleton, PPA Certified

Turn your studio into a money-making
machine! In this class, you will learn
how to sell based on your customers’
wants and needs. Joe and George will
teach you how to create custom pack-
ages, avoid costly mistakes and ensure
that your studio has a sound financial
foundation.

-1 M

Portrait Digital

Burke

Course # VA 20

Stop Guessing...Learn How to
Price Your Photography

Fred Sergio, PPA Certified

After 35 years in the photography busi-
ness, Fred has amassed a wealth of
knowledge about how to appropriately
price photography. You'll uncover all
the cost elements that go into producing
a quality print and profitable aloum—
and learn the effect of these costs on
your pricing formula. At the end of the
day, you will have a complete under-
standing of the methods used by accom-
plished people in the photography
business to increase business profit
margins. Please note that this program will
be heldfrom 10AM - 6PM.

WASHINGTON

S S tS BEES ]

The Art of Composition

Samuel Gardner, PPA Certified
Placement of the subjects in an image
can either maximize or nullify the
desired effect. Come and practice the
an of on-location posing and placement.
Also learn selection of backgrounds,
enhancing existing lighting and best
choice of depth of field for ponraits. An
effective mix of classroom and hands-on
time will enhance your skill and confi-
dence, preparing you to provide more
memorable, saleable ponraits to your
clientele.

Class Sizes
Are
Limited

Sports Business/Marketing



Mukilteo

Course # WA 20

Plan to Get More Profitable in
2004!

Marc McConnell

Nancy Treder, PPA Certified

Create a one-page business planning
system with Marc that wont sit on a
shelf unused. Next, examine Marc’
"IRS-safe" tax saving tips and learn
about cash-flow and other financial
planning that will save you big money.
After lunch, Nancy teaches you to bring
in more business than you ever expected
from the Internet; while spending less
money on advertising!

Seattle

Course # WA 30

Painting With Photoshop

Judy Horn

Use the history and an history brushes
in Photoshop to replicate the'techniques
of the old masters. Polaroid style
manipulations will also be created using
traditional photographs, no special
camera or film necessary.

Tacoma

Course # WA 40

Capturing Weddings the Candid
Way

Teri Harris

Greg Harris

Weddings don't have to be stressful.
Teri and Greg will take you step-by-step
through a wedding day their way. The
Harrises put the fun back into wedding
photography with their storytelling,
photojournalistic coverage and innova-
tive, one-of-a-kind storybook albums.

WISCONSIN

Clintonville

Course # WI 10

The Whole Enchilada: Digital
Demo for Small Studios

The Wacker Family

Join the Wacker family for a preview of
how they have mastered the entire
digital workflow; including capture,
image processing, marketing and sales,
retouching and enhancement, and
special effects.

Art/Technical General

Columbus E M
Course # WI 20

Getting Up To Speed with H

John Walcott, PPA Certified,
M.Photog.Cr.

Suzanne Walcott, Cr.Photog.

John and Suzanne will get you up to
speed with digital workflow solutions, a
simple way to guarantee great color even
if you forgot your grey card, and using
actions to increase productivity They
will also discuss heirloom photo restora-
tion. Please note that this program will be
held on Tuesday, November 4, 2003.

Fall Creek

Course # W1 30

Glamour with Class

Chris Nelson

This program will explore glamour
photography with an individualized
approach for women ages 14-50. Chris
will discuss a range of lighting tech-
niques from classic Hollywood to high
fashion, as well as posing to flatter faces
and figures. He will touch on details
from digital image capture to the sales
presentation.

MEXICO

Colima

Course # MX 10

Marketing in Different Markets
Mercadotecnia en Provincia

Lie. Octavio Beas, PPA Certified

This program can be in Spanish or
English The topics that | will cover are
correct price, market, products, and how
to sell more with options in different
markets.

Este programa se puede dar en Espanol
o0 en Ingles. Los temas a tartar son
establecer precios competitivos,
Mercado, productos. Como vender mas
con productos diferentes en mercados
diferentes.

CLASS LEVEL Beginner

Women in Photography Retreat
celebration...discovery...inspiration
September 19-21, 2003
Wyndham Buttes Resort
Tempe, Arizona

DIGITAL
CONFERENCE

for photographers, graphic
designers, art directors and other
imaging professionals

February 8-10, 2004
Doubletree Hotel
(soon lo lw the Hl|t0n HOtel)
at Lincoln Centre
Dallas, Texas

IMAGING JSA
2004

July 25-27, 2004
Las Vegas Convention Center
LasVegas, Nevada

for more information about

these or other PPA events go

to www.ppa.com or give us a
call at 800.786.6277

Intermediate Advanced
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Professional Photographers of A merica

100h STECIAIry Chw«REMCE

January 18-22, 2004 « Beau Rivage Resort & Casino * biloxi, Mississippi

Exactly one year after announcing changes to its specialty educational conferences, PPA debuts the Marketing & Management, Seniors,
Family & Children and Wedding Conferences together as a totally restructured event. Beginning inJanuary of 2004, PPA will hold these
four specialty conferences on a staggered schedule, grouped around a single trade show This new format will still allow you to attend
your favonte specialty conference, but now you will also be able to attend programming at the other specialty conferences, simply by
purchasing an affordable "All Pass." As pan of this change, the trade show will be designed to handle more conference attendees, and
PPA will be updating the specialty conferences themselves by adding fun and excitement while still providing top-notch education in an
intimate environment Such changes will improve not only the quality and excitement of these popular PPA events, but also the value
and affordability for all involved!

ft ARKAMD OkKKUKStOIyE-Wr

The ultimate photographic business conference, PPAs Marketing and Management Conference returns for 2004, featuring some of
todays leading experts who know the industry inside and out. Whether you need financial advice, tips for running your business, or
information about making the transition to digital, an outstanding speaker line-up will address your most pressing questions and
concerns. Experts will share the knowledge and expenence they have gained to help you prepare for a profitable future.

A<ANVZ)OR4, 6CINOOI & EOEMTG

Get back to school with PPA, and jump-start your high school senior and school photography marketing for 2004! PPAs Seniors, School

6 Events Conference continues to meet the needs of photographers involved in this highly competitive segment of the profession. Youll

discover new approaches to photographing activities, dances, sports and high school seniors. Open the doors to your future success by
attending some of the most high-powered programs offered in this exciting specialty.

C-HOi !>R£W AWL ?AQIO0Itt
Learn how to make the most success for yourself in the family and childrens portraiture business, whether your interests are film or
digital, business or an, PPAs Family & Children Portrait Conference will cover the issues most important to you. This event was devel-
oped to deliver you a wealth of top-notch programs by some of the most sought-after leaders in the portrait industry, so come see some
of today’ most talented and expenenced family photographers reveal their secrets. While you're at it, network with your peers and learn
how to take your business to the next level!

43chl)Iws

PPAs Wedding Conference wall explore a variety of hot topics affecting today$ competitive wedding photography industry YouILlearn

from nationally-ranked experts, discovering tips and techniques for how to coyer weddings most effectively and produce images your

clients wall fall in love wath Programs wall address traditional and photojoumalistic wedding photography, wedding album design and

motivational and creative techniques. Whether you use film or have already made the transition to digital, this conference will sharpen
your skills and drive more money to your bottom line.

For more information on these and other PPA conferences, call 800-786-6277 or visit WWAv.ppa.com.
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1PPA Membership Facts:

1 Serving Size 14,000 members

1Amount per Serving % DV+1
1 Protection from predatory client lawsuits oo%
1Professional photographic education 100%
1Specialized business education programs bo%
1Consulting services 100%

[Professional credential programs

i
7 DoilVVoluei |DV) are b,™d on 1y ~"

You can be part of PPA for only $12.67 per month (PPA’s Aspiring Membership
category and installment plan). Find out more about PPA and judge the value for yourself by calling
800-786-6277, emailing csc@ppa.com or visiting www.ppa.com. Join by September 30th and we will
send you a current PPA Showcase Book FREE ($59.95 value). Use promotional code PPSH to take
advantage of this special offer.


mailto:csc@ppa.com
http://www.ppa.com
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Eileen Adams Jack Adams
W
Steven R. Attig
Glenn W. Campbell Marry R. Carter Neal H. Clipper Michael Cole
Loretta Young
Jane Conner-xiser Glenn M. Cope John J. Costello Lisa Crayford Trisha Crites David H. Davis Angel Diaz

Paul foreman Sara Frances Bogdan Fundalinski
Janice Fundalinski

SUPER MONDAY NOVEMBER 2003 PROGRAM INSTRUCTORS



Marcia Mauskopf Mark MccCall Marc McConnell Mary Ellen Miller Keith Mills Karen Neldon Robert Neldon

PPA would like to thank our
Super Monday Instructorsfor
their generosity and continued support



S T R A T 1 O N

To register for Super Monday, complete this registration
form and mail to: PPA, 229 Peachtree Street NE, Suite
2200 International Tower, Atlanta, GA 30303.

You may also register on-line at www.ppa.com, or you may fax your registration to 301-604-0158. The
pre-registration deadline is October 13, 2003 for the discounted price of $99. You will receive a confirmation letter
approximately seven days after we receive your registration. This will include information you need for the course. Contact the course
instructor for directions to the class. All courses are $99, if you register by October 13, 2003. After October 13, 2003, registration is
$120 and must be done on-site. Contact PPA Service Center at 800.786.6277 to find out how to register on-site. Go to www.ppa.com
for any course cancellations, additions and changes. For cancellations made by October 13, 2003, you will receive a refund minus a $25
administration fee There are no refunds after October 13, 2003. There is a $20 service fee for all returned checks.
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Art and portraits,

PORTRAITS AND ART

Jill Lynne says they're often
one and the same

ontemporary professional photog-
Craphy is often rife with dissension
about what separates fine art from the
more practical and commercially viable
portrait, wedding, advertising and
corporate photography. But there are
photographers who are combining fine art
photography with more commercial
disciplines, and finding that the line
between art and profitability is not so well
defined as you'd think.

It's a fascinating viewpoint from an artistic
perspective, but it can have significant
ramifications for the bottom line as well.
Time and again, "art" photographers who
have ventured into more salable areas of
photography have encountered remarkable
success. This is particularly true for portrait
photographers, whose clients want to be
immortalized in a piece of art, and are
willing to pay top dollar for it.

New York-based photographer Jill Lynne,
who's both art photographer and renowned
portraitist, has the kind of clientele you
see on B Network red carpet specials. She
vaulted into the high-profile portraiture
back in the '70s, building a reputation with
her photographs of the club scene at New
York's Studio 54 that would help her land
such big-name clients as Tina Turner,
Divine and Andy Warhol. These days,
Lynne travels among the jet set of New
York and West Palm Beach, photo-
graphing the likes of the Clintons and
Mikhail Gorbachev along the way.

Lynne credits much of her success to an
unstructured approach that comprises an
equal measure of artistic and technical
sensibilities. "I started out studying art,
then taught myself a lot of photography,”
she says. "This pattern of development
freed me from the conventions of
photography that can sometimes restrict a
photographer's work."

Lynne feels it's essential for photographers
to act from a point of integrity, to be true
to themselves and to what's unique and
beautiful in their subjects. "A good
portrait photographer needs to recognize
what's important about their subject
matter and go with that," she explains.

"Don't be afraid to experiment. Go with
your intuition. When I'm doing a portrait, |
feel like it's my duty to bring out the

@©Jill Lynne 1975

The Blue Dress (with Hunt Slonem painting)

individual's beauty. | want to show people
the beauty within them. | want to mirror it
back to them. And | always, always work
with the utmost respect for my subject. |
will never allow a negative image of
someone to go out in the world. That's a
matter of integrity."

Good photographers can greatly enrich
their art by enriching their lives, says
Lynne. "Live life fully. One can only bring
to art the life experience that one is willing
to have. Up the ante on your learning
curve. Your visual art is the smaller part of
the larger whole of life. Look at art,
different kinds, and learn from it. Diversify
your perspective. Sometimes | think it's
best if photographers [don't dwell] on
photography, especially of their own
period, because it can limit rather than
heighten their experience."

—Jeff Kent, contributing editor

Technical problems?

From location lighting to contract writing, what’s got you stumped? Our panel
of experts will answer your questions in the pages of "Contact Sheet.” Just
make yourself comfy and tell us all about it in an e-mail to: cbishopp@ppa.com.
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New Fujichrome Velvia 100F and
Astia 100F show changes in color,
improvement in granularity

s this a new golden age for those of us
who still shoot color transparency film?
Long rumored but officially announced just
last March, Fujichrome Astia iOOF Professional

(RAP 100F) and Fujichrome Velvia 100F
Professional (RVP 100F) from Fujifilm should
be reaching dealers' shelves about now.

Architectural and portrait photographers
have loved the original Astia (RAP) since
its release, for its smooth tonality, neutral
yet distinct color palette, good grain
structure and moderate contrast. | have
used it with great success to photograph
people, buildings, products, and artwork
for several years now.

The new Astial OOF is an improvement in
some interesting ways. The first thing |
noticed was the improved grain structure,
thanks to what Fujifilm calls MSSC (Multi-
Structured Sigma Crystal) technology. It's
the finest grained color transparency film |
have ever worked with. The RMS granularity
for Astia 100F is 7, as opposed to the former
film's 10, an improvement of about 25 to
30 percent. Even under a high quality
loupe, my 35mm test frames are virtually
grainless. By comparison, Fujichrome
Provia 100F (and Kodak Professional

Ektachrome E100G, E100GX and
Fujichrome Velvia 100F) have an RMS
granularity rating of 8. (RMS granularity is
the industry-wide standard for measuring
and expressing the "graininess" of a film,
as published by Eastman Kodak in 1973
and again in 1987.)

AstialOOF also shows an improvement in
the rendition of skin tones and textures, a
big consideration for fashion, editorial and
portrait photographers. The final layer of icing
on the cake is the incorporation of Multi-
Color-Correction Layer Technology
(MCCL), which, according to Fuijifilm,
"operates like the human eye to adjust repro-
duction of green hues...and assure more
faithful reproduction of reds." These addi-
tional layers, plus a third layer, also are
present in the other revision of an existing
film from Fujifilm: Fujichrome VelvialOOF.

Photographers either hate Velvia for its
"funny book colors" or they love it. I've
been in the latter camp, especially when |
photograph landscapes or industrial
settings. In fact, just about the only time |
want a film that is absolutely neutral is
when | photograph artwork, products and
architecture in cases when anything but an
accurate rendition is unacceptable. For
these images, my first choice is Kodak
EPN or Astia, depending on the flavor of
neutral I'm looking for. Without these
constraints, | look for ways to use color the

way a painter does, choosing a film for the
emotional resonance of its palette.

As in black-and-white photography (or
any of the visual arts), color photography
is an abstraction of reality; the image has a
reality of its own, separate from the scene
in front of the camera. So, in the sense
that Velvia's very lush, saturated palette is
a unique signature that slightly exaggerates
colors and the contrast between them, |
like it. But it isn't for every subject. So far,
Fuijifilm Provia 100F Professional (RDPIII) fills
that niche, but Kodak Professional Ektachrome
E100G is a solid contender as well.

The biggest difference between Velvia
(RVP 50) and Velvia 100F (RVP100F) is
right there in the name. RVP is an ISO 50
film while RVP100F is an ISO 100 film.
Velvia RVP100F is a bit finer grained than
the original, but still not as fine as
RAP100F. Like the new Astia 100F as well,
Velvia 100F has the additional color layers
mentioned above, plus a sixth, a blue
correction layer. In both films, the additional
color layers are photosensitive filters that
adjust the color response frame by frame
on-the-fly, then become colorless and
transparent during processing.

Both RVP 50 and RVP100F have the
same resolving power, but the red, green
and blue spectral sensitivity in RVP100F is
way up, while the yellow, magenta and
cyan spectral dye density curves show a bit
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Top: Astia 100F Professional (RAP 100F). Above:
Velvia 100F Professional (RVP 100F).

All photos captured with a 35mm Nikon F5. Window
captured with an 80-200mm /2.8 AFD Nikkor lens,
children and man on dock captured using 105mm /1.8
Al-S Nikkor lens. No filters were used. All film processed
normally in Kodak E-6 chemistry.

more selectivity. Fujifilm claims that the
MCCL technology, along with new cyan,
yellow and magenta dyes, gives Velvia
100F both "ultra-high-saturated color
reproduction” and "world-class color fidelity."

Color reproduction of skin tones is also
much improved, as is Velvia 100F's ability
to handle very contrasty, backlit scenes.
Color contrast and saturation can help
create the appearance of sharpness in a
film, and this is one sharp film.

Could this be a new golden age for trans-
parency film? Given that we now have six
new extremely high quality E-6 processed
ISO 1(30 films—E100G, E100GX and E100VS
from Kodak and Astia 100F, Provia 100F
and Velvia 100F from Fujifilm—all with
extremely fine grain and excellent but
distinct ways of rendering color, |think so.
As they say in France: "Vive la difference!” J

— Ellis Vener

llum inating the Galaxy

Beehold the powerful ana portable

Emitting 160,320, or 640 true wattseconds,
the Bees are internally fan cooled, voltage regulated,
and continuously variable over a 5 f-stop range (from
Full down to 1/32 power). Housed in indestructible
lightweight Lexan, with a quick release for our full line
of accessories, the bees are ideal for travel and location
work as well as studio set-ups. For the utmost flexibility,
the Alien Bees can now be portably powered with
our new Vagabond Battery System, powering your
complete setup, recharging anywhere in world!
With full remote capability, space age speed recycle
(as short as 500 milliseconds!), and built-in slave
trippers, they’ll make your multi-light shoot a breeze.
Logical, consistent, and versatile, the Alienbees will
compliment your craft and match your creative courage.

160 true ws 320 true ws 640 true ws portable battery
.5 second recycle  1second recycle 2 second recycle system for global

2.5 pounds 3 pounds 4 pounds flash unit power

$224.95 $279.95 $35995 $349-95

530 East Iris Drive Melrose, Tennessee 37204
local (615) 383-4118 fax (615) 383-9569

More info? Circle 31
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product roundup

B&W Film

BY STAN SHOLIK

Committed to B&W

Film makers continue to improve the recipe

Black-and-white negative film may lack the novelty of a

new digital camera, yet it remains the mainstay of many

professional portrait, wedding and fine art photographers.

I hats why film manufacturers are constantly-
improving and introducing emulsions.
These companies have to be careful,
though, not to make too many changes.
When it comes to black-and-white film,
professional photographers look for
predictability, reliability and consistency.
Eastman Kodaks commitment to black-
and white film is evidenced by its recent
move to a new coating facility in Rochester,
N Y the state-of-the-art plant where all
Kodak roll film gets its coating. "Kodak is

continuing to improve and develop its
black-and-white products,” says Bob
Shanebrooke, Kodaks worldwide product line
manager for negative films. "While we don't
see this market changing or growing appre-
ciably, the photographers involved in it are
increasingly concerned with quality, and
Kodak is committed to meeting their needs."
Such film characteristics as contrast and
grain are unchanged, but the processing time
for some films has changed. New product
names and redesigned packaging differentiate

New York society and wedding photographer Andy
Marcus specializes in photojournalistic wedding coverage.
For high speed and minimum grain, he chooses Kodak
Professional 400 T-Max and P3200 T-Max.

these latest products from the earlier ones.

Joining Neopan 400 and Neopan 1600,
FujIFiLMs recently introduced Neopan
Professional 100 Acros in 35mm and 120
formats is the finest-grained black-and-white
film available from a major manufacturer.

Agra has a long history of excellence
in black-and-white films. Although their
lowest-speed films have disappeared like
those of other major manufacturers,
Agfapan APX 100 and APX 400 deliver
the smooth gradations and high sharpness
that have traditionally characterized Agfa's
black-and-white products.

With no color film products to divert its
attention, iLForp continues to offer the widest
range of black-and-white film available,
including the slowest-speed film from a
major manufacturer, llford Pan F Plus (1SO
50) and one of the two fastest, Ilford Delta
3200. These and other llford films have been
on the market for many years, confirming
Ilford's commitment to black and white.

There are numerous black-and-white
specialty emulsions available, from infrared
to direct positive, that are popular with
photographers working in different segments
of the profession.

Photojournalist and commercial adver-
tising photographer Doug Menuez loaded
Kodak Professional Tri-X into the Argus C-3
he was given in the 1970s and has been
shooting it ever since. "I went through a
Plus-X phase, he says, and |experimented
with the T-Max films. But the essence of
black-and-white shooting is to simplify, to
look for the essential, and I've always come
back to Tri-X, developed in D-76 1:1,
because I know it so well."

Too busy with his commercial shoots to
do his own processing, Menuez still makes



his own pnnts. But in a bow to the digital age,
Menuez scans the negatives, adjusts them
in Photoshop and outputs the final prints
on an Epson Stylus Pro 9000 inkjet printer.
His latest book, Tequila, Journey to the
Heart of Mexico (to be published next
fall), documents the culture of the state of
Jalisco, Mexico, home of tequila production,-
many of those images are black and white.

New York society and wedding photog-
rapher and Andy Marcus, M.Photog.Cr.,
author of "Wedding Photojournalism
(Amherst Media) has been shooting
Kodak Professional P3200 T-Max for at
least eight years, and 400 T-Max even
longer. "Wedding photojournalism
coverage means working in available light
with little or no flash. This requires high-
speed film, but at the same time clients
expect sharp, relatively fine-grain prints.

To satisfy these conflicting requirements,
Marcus sends his film out to only one lab
for processing and contact proofing. "In
black and white, the processing makes the
difference. Ive seen golf-ball size grain with
the same film from other labs." |he finished
photographs are printed traditionally by
one of two labs in Manhattan. Marcus has
tested other films of equivalent speed, but
has not been happy with the results.

Joe Buissink (a member of PPA), still shoots
at least 95 percent of his wedding, celebrity,
portrait, and fine art assignments with film
—the vast majority in 35mm black and white.

I bring a look of 1940s and '50s lifestyle to
my wedding photography by shooting all
available light. That means | need speed and
fine grain, so Ive settled on Kodak TMY [400
T-Max] and TMZ [P32(X) T-Max] exclusively

Buissink's processing is done by a lab in
Los Angeles that processes the P3200 T-Max
by inspection. The results | get are fantastic.
I don't think there are better films on the
market for what | do than TMY and TMZ.
If processed properly, T-Max has the best
contrast and grain, and lve tested other
films to prove this." He's seen no changes
m the versions of these film, he adds.

With black-and-white films' continued
importance to many professional photog-
raphers, the film manufacturers remain
committed to meeting their needs. J

Doug Menuez has used Tri-X film for over 30 years because it gives him predictable results

in all kinds of lighting situations.

To recreate the glamour look of the 1940s and 1950s, Joe Buissink uses Kodak Professional 400 T-Max and

P3200 T-Max films as standards for wedding coverage.
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Photoshop tips

You pause to study a classic
black-and-white print on a
gallery wall. The tonal range,
rich contrast, smooth transitions
and subject matter pull you closer.

As you inspect its beauty, you think to your-
self, This must be a fiber-based silver print
made from a black-and-white film negative.”

Not necessarily. It could very well have
started out as a color negative, color trans-
parency or digital color photograph As a
photographer, instructor and retoucher,
I've been doing conversions from color to
black and white for many years. I've
stumbled on a few techniques that I've used
with great success.

Whatever your intended use for the
image you're converting— newspaper
reproduction, commercial print job or
fine art print—the following steps will
help you make convincing color to black-
and -white conversions in impeccable
shades of gray.

You could make a simple Adobe
Photoshop conversion to grayscale with
Image >M ode >Grayscale, but if you spend
a few minutes preparing the images before
the conversion, you'll be rewarded with
deep rich digital files and prints that
exhibit the full grayscale tonal range.

Its important to examine the digital
photograph or scan and consider how
it will be used Let's say we want to
make a fine-art inkjet print for a print
competition Wed optimize the detail
and contrast and save the adjusted file in
RGB color, because most inkjet printers
do better with RGB files. For this tutorial,
Ive chosen a landscape of Florence, Italy.
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BY ANDREW DARLOW

Uncolor the world

A step-by-step conversion from color to B&W

Study the image you want to convert to black and white, and note the major colors in the frame, in this

example it’s oranges, greens and blues.

The range of colors it exhibits will
benefit greatly from these techniques.

First, we need to choose our color
settings (Edit>Color Settings, or in Mac
OS X Photoshop>Color Settings),
Figure 1. A good starting point is U S.
Prepress Defaults, from the Settings pull-
down menu at the top of the screen The
most-used RGB working spaces are
Adobe RGB, sRGB and Colormatch RGB,
the one 1 generally use.

Color Settings

Settings U'S Prepress Defaults
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Figure 1

Any of these spaces are fine if you're
operating in a color-managed environment
or, at the least, you're using some kind of
monitor hardware calibration tool. Using
custom profiles or those supplied with your
inkjet printer becomes important with
any RGB working space, but especially
Adobe RGB (1998).

In general, it is better to begin with 16-bit
color files, whether scans or digital camera
files, because high-bit files will exhibit the
greatest range of gray tones. Optimize the
contrast in the 16-bit file by applying
Levels and Curves adjustments.

In some cases, 16-bit files can be used
throughout the procedure, including printing,
but there are some adjustment layer con-
straints at 16 bits. As a rule, | convert the
optimized 16-bit file to 8-bit color (Imago
Mode>gBits/Channel).

Open the image you want to convert
and select Window>Documents>New
Window. This will create a duplicate of



the image in a second window, where we
can see the adjustments as we make them.
Make the new window much smaller and
drag it to the top left corner of the screen
or onto your second monitor. (I highly
recommend using a second monitor to
display your tool palettes and other
screcn-hoggers.)

Make the larger window active. Select
View>Proof Colors and make sure the box
to the left of the words Proof Colors is
checked (active), so you'll see the soft-proof
adjustments in the active window. Now go
to View>Proof Setup>Custom and select
Profile>Working Gray—Dot Gain 20%;
Intent”Relative Colorimetric,- and turn on
Black Point Compensation (Figure 2).

Figure 2

Although the image now appears to be
in grayscale, the image in the larger window
is actually still in color. It's just been soft-
proofed to look like it was converted with
the Image>Mode>Grayscale command.
The name of the custom soft proof is now
indicated in the image window with a slash
RGBVWorking Gray—D ot Gain 20%).

Examine the soft-proofed image. It
looks OK, but as with most direct con-
versions, it's somewhat Hat and in need of
fine-tuning. No two captures are just
alike, but most images can be improved
with adjustment layers and various color
tools, or with other methods, like Replace
Color. In our example, there are a few
specific areas of interest: Arnolfo's 14th
century palace and tower (center-right),-
the orange-hued Duomo of Florence with
Giotto's bell tower (center-left),- and the
trees, sky and mountains. All of these
areas can be enhanced or subdued by
varying the color and contrast prior to

converting the image to black and white.

With the Layers and Info palettes
visible iWindow >Layers and Window>
Info), click on the black-and-white circle
on the bottom of the Layers palette to
create an adjustment layer, and select
Hue/Saturation (Figure 3, seep 21). Hue
Saturation is a powerful tool because it
allows you to make specific color

American Color Imaging

EB Ordering

adjustments much like Replace Color.

Use the small color image in the corner
as your guide to make precise adjustments.
In this case, the largest areas of color in
this image are the green trees and the blue
sky. To slightly increase the contrast and
detail in the trees, we'll go to the
Hue/Saturation dropdown menu and
choose Edit>Greens, then click
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on any area of the green trees to pinpoint a
range of color. Make sure Preview is cheeked
Tlie word Greens might change to Yellows 2,
depending on the area we've pinpointed.
We set Saturation +19 and Lightness=
+e8 for a romantic, almiKt infrared look.

Now, well pinpoint the architecture. Here
we can use one adjustment to darken or
lighten the tones in both Arnolfos tower and
the IXiomo In the Hue/Saturation dropdown
menu we switch to Edit>Reds, and with
Preview checked, sample the dome's orange
area. We set Hue= +17 and Saturation +5
for a more dramatic look and click OK

For heightened drama, we select the
sky and feather it (Select>Feather) by a
pixel or two for a smooth transition. Now
create a new adjustment layer as before,
but this time select Curves. We set the
curve as in Figure 4 (shadows right,
highlights left), then hit OK, and keep the
selection. You can see that the mountains
are a hit hazy, which I actually like against
the buildings. Hut now there's extra grain
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Figure 4
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Figure 5
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Figure 6

Figure 7c

If your image editor doesn't allow for soft
proofing, you can achieve the same effect by
setting your monitor (in your operating
system's Display Control Panel) to black and
white so that you are not influenced by the
color as you make adjustments. It is not as
elegant as the soft proof technique, but it
works well. There are also many tutorials
available online and in books that use the
Channel Mixer and other techniques for
conversions to black and white from color.

( Options...

717771

S? Preview

Figure 7a



in the sky. To reduce the noise, go to
Filter>Noise>Dust & Scratches, and set
Radius” 1, Threshold=5.

Finally, we need to make the con-
version to black and white. (The funky
looking color image in Figure 5 is how
the file looks prior to the conversion.)
There are a few ways to do this. In this
case, first save your file with its layers as a
PSD file, select Image>Mode>Lab Color,
and flatten the image. In the Channels
menu, select Lightness.

Now choose Select>All, Edit>Copy, File>
New, and name the file yourchoiceRGB_BW.
Make sure Mode is set to RGB, and choose
Edit>Paste. Make your small contrast adjust-
ments to the RGB and/or specific channels in
Image>Adjustmcnts>Levels or Imago
Adjustments>Curves. The Lab procedure
creates nice shadow detail, but the midtones
usually need some enhancement, as you
can see in the Levels adjustment in Figure 6.

If you use custom profiles with your
printer, RGB files generally print in more
neutral tones than grayscale image files. Also,
when small color tints are desirable, you
can easily create sepia, blue-tones, hand-
colored black and white, and other effects
with Imago Adjustments;* Huc/Saturation
(with the colorize button on), Levels,
Curves or Color Balance. For comparison,
Figure 7a is a straight grayscale conversion
from RGB color, Figure 7b is our custom
conversion, and Figure 7c is a sepia tone
made with 7b and Fdue/Saturation.

Color Balance (Image>Adjust>Color
Balance) is another good editing tool for
adjusting RGB files prior to converting them
to black and white. Adjust the midtones first,
moving the sliders back and forth within
all three. Often, this tool alone will quickly
improve a color file before the conversion.

With a little practice, your color images
will think they were always destined to be
fine-art, black-and-white prints! O

PPA member Andrew Diirlow is a photographer and
digital output consultant. He conducts workshops
privately, in conjunction with photo groups, and at the
International Center of Photography in New York
Harlow authors the newsletter"Inkjet Tip of the Alonth
(dub, available free when you send a blank e-mail to
bikjettips-subscribe@yaboogroups.com. You can write to
him at ad@andrewdarlow.com
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Giottos ballheads.
The price and performance to turn your head.

M ake head-to-head comparisons. You'llfind Giottos is heads above in
value. Features and benefits found in far more costly ballheads are standard
in Giottos. O four 5 heads, 3 have tension control, ball and pan locks; 1 has
ball and pan controls; and Thas a single lock.

Giottos ballheads have the professional quality to handle cameras up to
26.5 pounds. Most come in drawstring « mmm
storage sacks - bag afew atyour Giottos P~
dealer Each is packed with greater
performance per dollar.
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= KXingCorp 110 new name in value-
16 Chapin Rd Pine Brook, NJ 07058, 973/808-9010
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In Canada Kindermann. Inc. Markham, Ontario L3P3V8
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weddings

BY JEFF KENT

From her studio in Brookfield,
Conn., Laurie Klein has built a
national reputation for her
distinctive photography in
black-and-white and infrared, a
style she calls "Life Journey."

A former student of Ansel Adams, Klein has
taken the lessons of the legendary landscape
photographer and applied them to her wed-
ding and portrait work, creating a distinc-
tive style that draws energy from people, their

Black and white and infrared

Relationships, nature and the artistry of Laurie Klein

relationships, and the nature around them.

Her work has appeared in magazines
such as Neio Yorker, Unites Home Journal,
Modem Bride and Elegant Bride, on numerous
greeting cards and posters, the cover of
the coffee table book Bridal Style," and in
her own book, Hand Coloring Black and
White Photography: An Introduction and
Step-by-Step Guide" (Corey Books, 1999).
She has taught at the university level for
many years, and lectured at professional
events and seminars as well.

Professional Photographer recently asked
Klein to share her perspective on black-and-
white portrait and wedding photography,
and the role of infrared film in her work.

Professional Photographer: How
would you describe your style?
Laurie Klein: One of my key talents is
bringing out what is significant in
relationships. | love documenting a
pregnant woman's relationship with her
body and her baby, or the relationship
between parent and child. What I capture
is an essence. Its an energy between
people and sometimes between those
people and the nature around them. When
you have a relationship, it has a life of its
own. | just show up and record it.

| often incorporate bodies of water
into my work | love photographing
anyone in water. A lot of my brides



Often hand-colored, Laurie Klein's "Life Journey"
photography in black and white and infrared is
romantic, timeless. "I want to get the viewer
involved, and have an element in the image that
when they walk away, they think about it and go
back to it," says Klein.

and pregnant women go into the lake or into
the water. There is something very sensuous
about that relationship with water.

PP: Why have you chosen to do so much
of your work in infrared?

LK: My work is very passionate. | think
thats why the infrared works so well for me.
The mood is inherent to that film. Years
ago, I studied under Ansel Adams, and |
was basically a landscape photographer.
Then | started photographing people, so
my work is now a combination of the
two— landscape and portrait. Infrared
works well for that combination.

PP: What appeals to you so much about
infrared film?

LK: Its very organic. And | think its the most
romantic film ever created, which makes
it great for weddings and a lot of the
relationship portraits | do. Its a very mood-
provoking film. A lot of my work is hand-
colored, and infrared lends itself to that
because there are so many highlights to
hand-color.

Klein speaking at Women's Retreat

This fall, Laurie Klein will be a featured
speaker at PPA's first annual Women in
Photography retreat being held at the
Wyndham Buttes Resort in Tempe, Arizona
September 19-21,2003. The title of her
program is “Female Focus on Weddings."

The Women in Photography retreat is a
three-day program that focuses on issues
unique to women in the photographic

industry. The stress-free weekend promises
to help women forge new friendships,
cultivate strengths and shape their
development as individuals, professionals
and leaders.

Visit www.ppa.com for complete program
and hotel information. To register, visit the
site or call 800-786-6277. Space is limited to
the first 200 people so don't delay!
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There is also a mystique to infrared.
I don't do a lot of large-format work
that shows every pore on my subjects.
| prefer the subtleties that are not overtly
expressed. | want to get the viewer
involved, and have an element in the
image that when they walk away, they
think about it and go back to it

Infrared can be very powerful...
and very haunting. Many clients don't
want haunting pictures of themselves.
But it's a very forgiving film, so it
provides a level of fantasy. It smoothes
wrinkles, blends freckles and helps people
look younger. Overall, there are a lot of
quirks to it that can be very difficult, but
if you can get it down, it provides
wonderful results. J

To set more of Laurie Kleins u'ork. pis t
u’H'U’ Liuneklein.com

11 Tips from
Laurie Klein on
shooting infrared film

1. Absolute darkness is required for
changing film.

2. If you leave the loaded camera
outside in the heat, the infrared film will
fog.

3. With the plastic bodies of newer
cameras, infrared light can come right
through camera and fog the film. | use
several old Nikon cameras with metal
bodies that I've totally dedicated to infrared
shooting.

4. Some of the newer cameras have
infrared sensors that read the DX coding to
set the ISO. Those sensors will often fog
infrared film.

5. An autowind will sometimes put
static marks on infrared film because it
rewinds the film too quickly. It's more of a
problem in winter.

6. The 1SO will change with the time of
year and the time of day, as well as with
the kind of light. When framing an image
with a lot of northern sky, there’s usually a
great deal of ultraviolet light, and that can
affect the ISO. Stone in the setting can also
affect the 1SO, because stone is cold and
absorbs heat.

7. Clothing is important, as are many
personal features in human subjects. For
example, the ghost stripe that goes down
a tuxedo pant leg will reproduce as a
stripe in infrared. A lot of paisley patterns
will come off like clown suits. Men need
to shave very closely because any stubble
will show up. Processed red hair looks
blonde. Freckles disappear. Veins that are
very close to the skin surface will come
out dark. This should be a special concern
with brides and pregnant women.

8. Infrared shooting is a pretty slow
and meticulous process. You can do
candids, but you have to be careful to
employ filters, different focusing techniques
and to work methodically.

9. Infrared film shooters usually use
a red filter. Digital infrared requires a
black filter.

10.1almost exclusively use wide-angle
lenses for greater depth of field. It's more
forgiving if you're a little off.

11, You need a lot of light. When I'm
in a church or reception, | do more
limited infrared shooting, and usually
on atripod.



Capturing infrared digitally

Why spend hours on the computer
when you can capture the drama of
infrared as you shoot?

iim-based infrared photography has been
Fused for global remote sensing satellites,
military reconnaissance, agricultural and forestry
crop assessments and numerous other scientific
applications. But professional photographers
have also been using infrared capture for creative
expression. The look of an infrared image is
artistic, yet has a wonderful traditional feel.

My good friend James Kim Han of Hawaii
showed me how to capture stunning infrared
images like Figure 1 with my Fujifilm FinePix S2
Pro digital camera— or any digital camera that
can record light in infrared wavelengths— and
an 87 IR filter

Not all digital cameras will allow infrared to pass
through to the CCD sensor or CMOS chip. To
find out if yours does, point your television remote
control at the lens of the camera. While looking
through the camera, push any button on the
remote. If you see a red light, you're good to go.

There is so much misinformation on digital
photography: you need special lights with digital,
you can't use soft focus filters with digital, you
can't do this, you can’t do that. Shooting digitally
is no different than using my Mamiya 645AFD
with a film back. | can get realistic infrared
shots with my Fujifilm FinePix S1 and S2 Pro,
or a Leaf digital back on my Mamiya 645AFD.

You can base exposures for infrared
photography on a meter reading, but it's not
possible to predict how much infrared the

Figure 1. Infrared capture can add drama and
mystique to an everyday scene.

Figure 2. Snake River Overlook, Jackson, Wyo.,
which many people know from the photographs of
Ansel Adams. He photographed the Tetons on
Panchromatic film. | opted for digital infrared.

subjects will reflect or emit. With film capture,
getting it right takes knowledgeable estimating
or test shooting under specific conditions. And
then you don’t know the results until you process
the film, which must be done in total darkness,
without so much as a safe light. What makes
digital infrared photography so great is that you
can preview your image on the camera’s LCD
screen, then check the histogram to verify the
exposure. Wow! Could it get any easier?

| generally start with an exposure for 1 or 2
seconds, then check the histogram. Objects in a
scene with equivalent amounts of white light may
not emit equal amounts of infrared. Keep in mind
that the shadow areas in a scene will have very
little infrared light, even in the daytime. Open the
aperture by one stop to avoid underexposure.

Infrared radiation does not focus in the same
plane as visible radiation, so you have to IR

Figure 3. The Old Mission in Santa Barbara,
captured with a Fujifilm FinePix S2 Pro and 20mm
Nikkor lens in color mode (1/125 second at f/8).

Figure 4. Captured with a Fujifilm FinePix S2 Pro in
black-and-white mode (1/125 second at f/8).

Figure 5. Captured with a FinePix S2 ProFuji S2, IR
focus-adjusted, with a Rattan No. 87 filter, exposed
for about 1 second at /8.

BY DON EMMERICH. PPA CERTIFIED. M.PHOTOG.. M.ARTIST.MEIL.CR.

focus your camera. The IR focal point is farther
from the camera lens, so the lens must be
moved slightly farther from the film or sensor to
focus an infrared image. This focus difference is
most critical when using filters to block all
visible radiation. Most camera lenses have an
auxiliary infrared focusing mark. Generally this
mark is a red "R” with a red line. Focus the
subject as usual and then shift the lens distance
scale to the “R" mark. Some lenses, particularly
apochromatic (APO) designs, may not need
focal correction. Consult your camera manual
for the appropriate use.

For the best definition, use small apertures
like f/11 orf/16 if conditions permit. For people
photography, | tend to work at f/8 with faster shutter
speeds. With scenics it doesn't really matter
much. If you must use large apertures, and the
lens has no auxiliary infrared focusing, you just
have to establish focus settings by trial and error.

My FinePix S2 and my Leaf digital back allow
me to capture in black-and-white mode, but if
your camera shoots in color only, you can still
use the IR filter, as shown in Figure 6. Open
your IR-filtered color image in Adobe Photoshop
and go to Image>Mode>Grayscale to change the
RGB image to grayscale. Go to Image>Adjustments>
Levels (or >Curves) and move the black point
and white point values until it looks good
enough to brag about (Figure 7).

Now you know that with the right digital
camera and an infrared filter, you don't have to
jump through a lot of computer hoops to reap
the brilliant rewards of infrared light, j

Don Emmerich is one of the pioneers of applied
photographic digital imaging. Hes been using
Adobe Photoshop since its first release. He is a
PPA affiliate printjudge and has served on a
variety of advisory panels, specialty committees
and professional boards.

Figure 6. An IR-filtered image captured in color
mode. Once | opened the image in Photoshop
(Figure 7), all I needed to do was to convert it to
grayscale and adjust Levels and Curves to make
the tonal values pop.
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portraits

BY JEFF KENT

Capture the essence of 1
relationships with B&W 1

Tim Walden's loose, emotionally charged style satisfies
his artistic yearnings—and his bank account

"l want you to realize something," Tim Walden, M.Photog.Cr., F-ASP,

often says to the photographers crowding his lectures. "Right now

I'm creating some of the worst photographs of my life.

Amidst that, I'm creating some of the best images I've ever done."

And he's never felt better about his
art—or his business.

for over 20 years, this well known
instructor has been running the bustling

Waldens House of Photography in Lexington,
Ky., but it's only recently that he's developed
a style that not only strokes his artistic
heartstrings but pads his pockets as well.

Walden’ success and national promi- |
nence are largely based on an approach to
black-and-white portraiture that surrenders
security for vulnerability, technical con- j
sistency for creativity. He feels his work
has evolved into something spontaneous |
and true, something that reveals the heart
of a relationship in black-and-white, some-
thing that portrait clients arc looking for.

"1 grew up watching my father produce
fine black-and-white portraiture by hand,”
says Walden "He was a very passionate
image-maker, and | caught his passion. It's
been a big inspiration for my black-and-
white relationship portraits.

Walden describes his style as emotionally
based, reality-style portraiture. He uses a lot
of film, produces a lot of junk, and ultimately
creates something special. Eschewing photo-
graphic props, he captures his subjects inter-
acting with each other. The shots are not
tightly defined, but loose and spontaneous.

"This is really different from my
training, which was very structured,” he
points out. |was trained to control every ¢
situation. This style goes against that, but j
it takes me back to what | love about
photography, which is emotion and passion
and I've never been able to truly create
those within too tight of a structure.

"I've let some things fall by the wayside in|
order to capture the emotion of the moment!
rather than following some rule. I'm putting
the emotional element ahead of the technical
aspect of photography—but, when you
marry the technical and the emotional
together, you get something powerful.”

"Often | ask my subjects to ignore the camera and
to interact with each other. This can lead to
wonderful and fun images."



"With Relationship Portraiture you often have one primary subject, but the involvement of a secondary subject in an obscure fashion can add the passion and

emotion you want in your portrait."

Of course, many portrait photographers
arc reluctant to work this way, to let
instinct and emotion supersede their
classical foundation. There's security in
structure, granted, but in abandoning it
Walden finds far greater potential.

Im vulnerable to failure,” he admits.
When you become vulnerable, when you
take a portion of that structure away, you
have to deal with people differently. You
Have to deal with people on an emotional
level. A lot of photographers aren't com-

fortable with that. 1 wasn't at first either."
Walden urges photographers to put as
much emphasis on creativity, on seeing
things differently, as they do on the tools
and technology of the trade. "You go to
school and learn lighting, posing and
composition, and then you execute those
elements. Hut it takes more than executing
a technique to be a good photographer
Often we leave a seminar better
understanding our cameras, our meters,
our Photoshop. That's important, but are

we more creative, more challenged, more
inspired? You will excel at the things you
place importance on. For me, its the way |
see things, emphasizing creativity more
than anything else 1do."

Walden's customers are seeing things
his way. His black and-white relationship
portraits account for 70 percent to HO
percent of his bookings, which translates
into about 90 percent of the studio's
revenues.

As photographers, we finally get it
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Let there ke light

3 great tips from Tim Walden

1. Lighting and style must be a perfect
marriage. As ayoung image-maker, | studied
lighting from some of the industry's best in
order to choose my favorite kind of lighting.
Now, with years of experience behind me, | feel
as if my lighting chose me. | know that sounds
odd, but when | was younger, | had not developed
a style, or as you might say, | had not found my
look. Once | did find that look and defined my
style, it became easier to make lighting decisions.

As Beverly (Walden, PPA Certified, M.Photog.)
and | developed our “Relationship” style of
black-and-white portraiture, we realized our
imagery was heading toward a realistic look, a
loose style of portraiture that required spon-
taneity and a fast trigger finger. In this less
controlled style of photography, you need the
lighting to be forgiving. That's why we began
eliminating parabolic reflectors and small soft
boxes in favor of large light modifiers that we
could place close to our subjects.

For us, this was a Larson 4x6-foot Soft
Box. It gives us the forgiveness we need from
our main light, and if we want to sculpt the
edges of the subjects with a harder edge, we
simply bring up the power of that light and pull
the Soft Box away from the subject. Distance
reduces size; light “acts" smaller as it is pulled
farther away, making the light more hard-
edged. The sun is a perfect example of this.
Ask a 4-year-old how big the sun is. and he'll
pull his fingers apart a couple of inches and
say. “This big.” Well, we know that the sun is
much bigger, but at such a distance from
Earth, it becomes a small, pointed light source.
That's why, on a sunny afternoon, it casts
distinct, often harsh shadows.

Our best Relationship portraits can happen
in the blink of an eye. | love to use the large
Soft Box with a white reflector, to provide the
additional shadow fill I need.

2. Think of lighting from the subject
forward, then from the subject back. The
main light and fill light or reflector, from the
subject forward, are the meat and potatoes of
your studio lighting. These are the foundation
of the portrait creation. With these lights, | can
sculpt my subject's face. | can put the sparkle
in their eyes, and | can direct the viewer's eyes
and show the subject in an attractive fashion.

The lights behind my subject, however,
bring the subject to life, whether they're
positioned to light the subject or the
background. This is the light that adds the
punch I'm looking for. One of these lights is
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the separator light, or hair light. Beyond
lighting the hair, it separates the planes
in the image to help define the edges and
create depth.

An accent, or kicker light can skim the
highlight side of the face. | rarely use this
light on the side for style reasons, but | add
another highlight on top of it, or a specular
highlight. This can add luminance and power
to your image.

The background light can add various tones
in the background, building on your efforts to
create depth and dimension. We should all
concentrate on doing this with our lighting. As
you can see. the lights behind your subject are
critical to the outcome of your final image.

3. Lighting needs 3 flow. Like the waves
of the sea, lighting should have direction and
flow. As image-makers, we need to direct the
viewer. It helps the viewer follow the story.
This is partially done with lighting. Lighting is
not simply for illumination, it also gives
direction and purpose, and helps tell the story
of the image. | create an image when | push
the button. What | do after that point is
complete the creation, whether in the
darkroom or on a computer. The lighting,
posing, and emotion should be in place when |
push that button. It cannot be added later.

A photographer will never reach his or her
potential by simply illuminating the subjects
and expecting to create the image post-
capture. not without creating direction and flow
with the lighting. When you do. you'll excite
the viewer. Capture the creativity, masterfully
enhance the image, and you will make a great
photographic piece.

Walden's House of Photography is in
Lexington, Ky.

what people have wanted all along," he
says. "As | have balanced my technical
abilities with my heart, my business has
grown. That’ because I'm now capturing
things that move people, that touch them
Its more than recording their faces."

The technique

Walden chooses black and white for a
number of reasons. Its not as distracting
as color. It makes a point and makes it
quickly. It's a simpler approach. "When
you marry that to simple clothing and a
simple background, black and white only
lets you see your subject and what's going
on there," says Walden.

"You have to be a person who sees
things that other people miss, and in
greater depth, he says. "You have to be
really fast, and good at getting people to
relax, at bringing down the walls. You
have to be genuine, approachable and
vulnerable. You have to shoot a heck
of a lot of exposures. For me, a lot of
what | want in an image happens in a
fleeting moment. You have to be fast
and you have to shoot. Theres a lot of
trash to throw out, but you get those
gems in there."

It happens in three steps, says Walden.
First, and most important, he captures the
moment when it happens. Second, if the
emotion of the moment remains, he’ll
adjust for obvious compositional or
technical problems. Last, he refines.
Working from different angles, he effects
the little things that make a photograph
technically commendable. Getting to this
third stage is a matter of chance.

All of Waldens relationship portraiture
takes place in the studio. Forgiving
lighting is critical, but he keeps it basic,
requiring very little light management and
maneuvering. R usually keeps it low-key,
choosing dark, "unopinionated ”
backgrounds. The one he had made at
Denny Corp. is called, appropriately
enough. The Walden lwant my
background to be mottled with subtle
tonal variation, but all over, with no
requirement to work in any particular
place on the background he says.



The subjects' clothing is always simple
—dark slacks, and dark, pattern-free tops.
Walden always has about 25 turtleneck
tops in of all sizes on hand. Most are
black, some steel gray, some burgundy.
No gaudy or costume jewelry is allowed.

The business

Artistic reasons aside, Walden sticks to
black and white as a way to brand his
studio. In the name of good customer
service, a lot of photographers offer prints
in color, sepia, black and white, hand-
tinted, whatever. That's great for
diversifying your products, but it doesn't
help you establish a niche that potential
clients will always associate with you,"
says Walden.

'We've established ourselves as artists
who hand-make prints in an archival
format the way my father used to do it
he says. 'That carries some worth in our
marketplace."

Every two years, Walden redesigns
his marketing campaign. He changes
the theme, but the emotionally evocative
style remains the same. The studio's
current promotion is "Images that
Speak—everyone has a story—let us
tell yours.”

We take in the subjects' stories, listen
for what's important in their lives. It
influences the decisions we make in the
camera room," he says. "l can't tell you
how it changes me, but it definitely
affects my thinking

Consistency is key to Walden's mar-
keting strategy. "Define how the
campaign looks and execute it con-
sistently over time until people get it.
You have to tightly brand yourself and
dumb things down when you market.
Just because you understand it, doesn't
mean your target clients are going to
understand it. People have to see it
again and again and again until they
associate you with a certain look.

Once you get that association, things
start to happen.” O

To view more of Tim Walden s work, visit

www.waldensphotography.com.
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advertisement

OLYMPUS PUSHES

OF DIGITAL PHOTOGRAPHY TO
THE HIGHEST LEVEL YET.

ow do you create a digital
H camera that gives profes-
sional photographers everything
they want? A digital camera that
brings sharp, beautiful images to
life, just the way photographers
see them, with no compromises?

That was the assignment
given to engineers at Olympus
nearly four yearsago. To do what -
ever was nece.ssary to achieve the
highest quality digital images.

One thing Olympus engi-
neers knew from past experience
with earlier digital SLR models:
in order to accomplish their
ambitious goal, they must devel-
op a complete, fully integrated
digital system. With camera, lens
and flash all designed specifically

for digital SLR photography.

Prototypes were created,
rejected and created once again.
Professional photographers
were brought in to judge the
design, fitand feel of the camera
and the quality of the images.
Engineers and factory techni-
cians worked hand-in-hand
to invent entirely new precision
manufacturing methods.

And finally, all the pieces
fell into place. Theories became
practice. Images that would
please the most demanding
professional photographer were
reproducible time after time.
After years of development, the
new Olympus E-l and digital
SLR system became reality.

"The size and weight...
the placement ofcontrols...
the way itfits in my hand...
the attention to detail...
simply by picking it up, Icould
tell this is an exceptional

digitalcamera”

mProfessional photographer,

INTRODUCING THE WORLD'S FIRST PROFESSIONAL SLIR CAMERA Douglas Dubler
SYSTEM DESIGNED FROM THE GROUND UP TO BE DIGITAL

More info? Circle 35



IMAGE QUALITY BUILT ON A NEW STANDARD FOR DIGITAL CAMERAS.

Throughout the process of redefining digital photography,
Olympus engineers disregarded the old rules to find new solutions for
existing problems. This included the lack of astandard for digital cameras.

When digital SLR cameras were introduced, they had many differing
sensor sizes, to meet differing demands. Furthermore, by using the old
35mm film standard for camera bodies, digital camera manufacturers
were able to use their existing interchangeable 35mm lenses. While this
was convenient, the results have been far from perfect.

Since image sensors need to receive light differently from film, com-
bined digital/film systems sacrifice the most important element of creating

a perfect photograph—the ability to correcdy capture and direct light.

That’s why Olympus set out to create a new standard, one that
would achieve optimal balance in image quality, camera and lens size,
durability, speed and expandability. After a long and rigorous search,
the standard that brought everything together became known as the

Four Thirds System.” At its core is a 4/3-type image sensor with four
times the surface area ofa typical 2/3-type sensor. And that can result in
clearer, more beautiful images.

With this standard in place, Olympus engineers were free to
concentrate on the development of lenses that are specifically designed
for digital photography. Lenses that focus light directly to all pixels of
the CCD, giving the best exposure for every photograph.



ZUIKO DIGITAL SPECIFIC LENSES™ BRING YOU NEW FREEDOM IN MASTERING LIGHT.

Zuiko. In Japanese, it means light of the gods, and it’s
a name Olympus has used since 1935- Today, with the creation
of an all-new digital specific lens, Zuiko has a new meaning
to professional photographers over the world. It means
whenever you shoot, you can now get digital image quality
to match your highest artistic expectations.

Here’s why. With a Zuiko digital specific lens, there’s a
perfect match with the camera's image sensor. More impor-
tantly, light is directed straight to all of the photo diodes for
clear, accurate color, sharp contrasts and bright images, even
at the extremities of the sensor.

But when a 95mm lens is used on a digital camera, it can
result in insufficient light at the periphery of the image sensor,
causing a dim image with inaccurate color reproduction. The
problem is worse with wide-angle lenses. And the wider the
lens, the greater the problem.

lhe combination of image sensor and Zuiko digital lens
virtually eliminates shading and distortion. And dramatically
increased resolution assures you Zuiko digital lenses will
continue to provide superior performance with future cameras
and technical advancements.

BRIGHTER COLORS AND GREATER PICTURE QUALITY
BEGIN INSIDE, WITH AN ALL-NEW IMAGE SENSOR.

Once the E 1s digital specific lens does itsjob of directing
light to the camera s CCD, the image sensor itself must perform
to the highest standards ofexcellence.

That's why Olympus engineers chose a new Full-Frame
Transfer CCD (FI -CCD) image sensor. Unlike other CCDs,
the FT-CCD gives you an increased dynamic range for more
gradation from the bright areas of your photographs to deep
shadows or black areas.

With a Zuiko digital lens and the new CCD, images pro-
duced with the E-I can provide the realism, color accuracy and
beauty often associated with professional photography—image
quality that becomes especially clear when images are enlarged.

FROM AIMING AND SHOOTING TO TRANSFERRING
DATA,THE OLYMPUS E-l IS BUILT FOR SPEED.

So you can react quickly and instinctively, all of the buttons
and controls of the E-I are placed exactly where you’d expect
them to be. And autofocus speed, shutter release time-lag and
image processing time are all up to professional standards.

To make it faster and easier for you to manage your
photographs after you take them, the Olympus E-I features
Firewire |1EEE 1394- USB 2.0 and USB 1.1 for high-speed,
high-volume data transfer.

Speed is further enhanced by dramatically improved
handling due to the E-I's compact size and weight of the lenses.
With the Four Thirds System, a 300mm f2.8 telephoto lens
offers performance equivalent toa6o0Omm telephoto lens, and
at a stop faster. This means that the total weight of camera and
lens together can be reduced by almost half. WTich can mean
you’ll be able to adjust faster to any shooting situation.



Comparablefilm lens

fuiko digital lens

The all-digital design of the
Olympus Digital SLR System allows
for downsizing of camera bodies
and lenses. For example, an Olympus
digital 300mmf2.8 telephoto lens
offers performance equivalent to
a 600mm telephotofilm lens.

Olympus digital specific
lensesfocus light more directf
to each pixel for better
edge-to-edge sharpness.

Instead offocusing light directly,
film lenses are designed to
spread light evenly over the

surface ofthe film.

Finally, the E-I's solid, durable,
magnesium-alloy body and ergonomi-
cally shaped grip are designed for fatigue-
free shooting. However and wherever you
need to use your camera, it’sasif Olympus
has read your mind.

OLYMPUS ENGINEERING EVEN
PROTECTS YOU FROM DUST.

Dust in the air and microparticles
from the shutter can settle on the imager
of other digital SLR cameras, damaging
the captured images. To reduce the
problem, Olympus has developed the
Supersonic Wave Filter to protect the
imager in a way that was never possible
before. When dust settles on the filter,
this ultrasonic technolog)' causes the
particles to simply fall away. You don't
have to give it a thought.

Additionally, exterior seams, battery-
doors, grip planes, the connector and
switch panels have gaskets and rubber
seals, making the camera and lenses
splash proofand more dust resistant. And
everything, including the shutter unit, has
undergone extensive testing to confirm
design integrity and make s uit the F | with
stands heavy usage and harsh conditions.

WITH ALL OF THE IMAGE QUALITY

AND PERFORMANCE, THERE'S ONE

OTHER PROFESSIONAL STANDARD
OLYMPUS TOOK TO HEART.

How does the camera look and how
does it feel in your hand? As much as
anything else, this was an important con-
sideration to the engineers at Olympus.

And not just because they knew
they were designing a product for people
who live and breathe detail and the
appreciation of beauty.

Throughout the entire developmental
process, the sense of creating something
classic was a driving force. 1ike traditional
Japanese artisanship, the line points are
easy to discern. From the weight—not
too heavy, not too light—to the contours
of the camera’s metal body and location
of controls, this is a camera you 1l enjoy
owning, as well as using.

A professional system that introduces
a new standard for digital SLR photogra-
phy deserves no less.

OLYMPUS

To help keep you working
regardless of weather,
Olympus provides a splash-proof
design with gaskets and rubber
seals at seams and openings
to keep out moisture and dust.

Vie E-1sall-metal,
magnesium-alloy body is lightweight
and durable for heavy daily use
by the most demanding
professional photographers.

The Olympus Digital SLR System
with its Full-Frame Transfer CCD.
delivers greater picture quality
and high-speed performance,
shortening the time it takes to
capture an image and transfer
data to the memory card.

olympusamerica.com/e-i

More info? Circle 36



portraits

BY TIM MEYER, PPA CERTIFIED, M.PHOTOG.CR.

Revisiting the B&W classics

Celebrate the past but shoot for the present

Seems like everyone's living
in the here-and-now and

keeping one eye on the futur]

Who takes the time to recognize the impor-I
tance of looking to the past? The past
reveals not only where we came from, but
often shows us where we re headed as well

Art history reveals much that is significant
to portrait photographers today. Leonardo
da Vinci's work illustrates, among other
things, the use of soft, diffused lighting.
Many other traditions in formal portraiture!
used by modern photographers also have |
origins in the Renaissance era, such as the |
understanding of perspective, the
illumination of all five planes of the face, |
the use of selective focus or controlled use
of detail to direct the viewer's attention, j
and the conventional rules of composition.
These artistic principles are the very
foundation of what we consider classical, |
formal portraiture. We use them as guides
to produce our own work and standards
by which we judge others' work.

History also teaches us that there's
always been great Variety in style and
approach to any given subject. Vincent
Van Gogh, Picasso, Monet and Rockwell,'!
among others, have challenged the classical '
approach to portraiture and broadened our
view of the human experience. Our
photographic history didn't really begin
with the invention of the camera, but with
this rich artistic heritage.

Today, the use of black and white in por- |
traiture is a matter of style and interpretation

"The use of black and white in portraiture is a matter
of style and interpretation that can dramatically
convey timelessness and elegance,"” says Meyer.



that can dramatically convey timelessness and
elegance. The black-and-white photographic
image, by its very nature, is a more abstract
form of portraiture than its modern color

counterpart, yet still benefits from the pho-
tographer's use of long-standing traditions.

A classical approach will always be valid,
but history shows us as well that a non-
traditional approach can also excel in the
black-and white-arena. Photo-Secessionists
such as Steichen, Stieglitz, and Kasebier
challenged the classical approach and
experimented with interpretive points of
view. Later, George Hurrell's dynamic use
of exaggerated shadows, unusual lighting,
and nontraditional camera angles would
usher in the Hollywood glamour style.
Arnold Newman's strong and aggressive
use of the frame and his total control of
the environment and the subject's
relationship to it redefined the stylistic
limits of the environmental portrait.

Black and white portrait artists today are
not restrained by classicism,- were free to apply
our own interpretive approaches. Consider
the following variations from the norm:

« Lighting the body, the face and the
environment individually

* Not illuminating all five planes of
the face

* Use of deep blacks with no shadow detail

 Using shadows as part of the
composition itself

* Moving away from soft lighting
sources and using strong, hard-edged,
highly specular lighting sources

» Aggressive use of unusual camera
angle, tilts and cropping to add impact
These deviations—hardly new to this
generation—lend themselves well to
today's black-and-white images.

The classical portrait will always have a
home in our industry, but cinematographers,
magazine and fashion photographers and
photojournalists are exposing our clients
to more progressive styles. They are moving
away from a static look toward a looser,
edgier style. As portrait artists, there is a
place in our work for both approaches. O

Tim Meyer has worked as a professional photographer since
1979 With a Master of Arts degree and numerous one-man
exhibitions of hisfine art work, Meyer brings a tongue per
spective to the portrait and wedding world He recently com-
pleted a lecture senes on the history of portrait lighting around
California, including San Diego's Museum of Art, San
Francisco's Legion of Honor and Museum of Modem Art
and the Los Angeles./. Paul Getty Museum



lack-and-white

Alive and well and
hanging in the
very best of galleries

By Richard Pitnick

We bring you five uniquely talented
photographers, each with a distinctive
style and aesthetic approach to fine art
photography. Although their techniques
and subject matter range from the
traditional to the wildly experimental,
like a majority of contemporary art
photographers, they share a commitment
and passion for the limitless creative
and expressive potential of black-and-
white photography.
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an Francisco-based photographer
S Mona Kunhn brings a fresh approach
to fine art black-and-white portraiture. Her
haunting, ephemeral images convey the
relationship between the spiritual and
corporeal with elegant simplicity.

Working with a medium-format camera
and fine-grain T-Max film, Kuhn shoots
with extremely shallow depth of focus. She
prints within a narrow tonal range,
imbuing her nudes and portraits with
subtle emotional and graphic intimacy.

"In a sense...as I'm working, I'm trying
to do something more unique, or continue
the language of the nude," says Kuhn, who
is represented by galleries in San Francisco,
Atlanta and New Orleans. "One way to do
that is to try to abstract from the clinical
nude by playing with depth of field. My
use of shallow depth of focus evolved
gradually, and allows for the imagination to
focus on the essence of the human in front
of me instead of the surface of the body.

Kuhn prefers working with natural light
and printing for a rich gradation of middle
tones over deep blacks and sharp whites.

"l seek out softer light and in the dark-
room, | bring down the contrast if the light
is too harsh. I like creamy skin rendering
and try to work with that."

Kuhn will be showing new work this
fall in Munich, Germany, and at the Scott
Nichols gallery in San Francisco. A
catalogue of her work is available
through PhotoEye.com.

keach Mona Kuhn by e-mail, monahuhn.com, and visit
her Web site, ivivtv.monakulm.com.

rawing wide praise from museums,
Dgalleries, and collectors are original
landscapes, portraits and abstract images by
M ichael A. SMITH. A combination of mod-
ernist art sensibility and traditional photo-
graphic techniques, Smiths photography is
noted for rich detail and wondrous tonality.
A successful fine art photographer for three
decades, Smith and his wife and creative
partner Pauta Chamuee have published three
monographs, and exhibited extensively
throughout the United States and Europe.
Their newest book on Tuscany is due to be
published this year, and the couple will show
a selection of their Tuscany photographs in
Atlanta in October at the Fembank Museum
of Natural History to accompany an
exhibition of Etruscan artifacts.

Shooting with a range of large-format cam-
eras that include an ¢x10, an 18x22, and an
8x20, Smith and Chamlee make black-and-
white contact prints exclusively, on Azo silver

chloride contact paper. Their decision to
work m large format with traditional dark-
room techniques reflects an aesthetic adher-
ence to the innate beauty and expres-
siveness of the black-and-white print.

"I'm interested in the fine line between
absolute reality, clear description and abstrac-
tion," explains Smith. "Black and white gives
a level of abstraction that allows the viewer
to participate more, which is a desirable
thing. Even in the commercial realm, certain
work in black and white, when done right,
allows a more universal connotation to
adhere to what is being shown.

"The main thing for me is the beauty of the
print as an object," adds Smith. "In terms of
tonal scale and rendering and image fidelity,
there is nothing quite so beautiful as a contact
print. It is sharper, clearer and conveys more
information. It is the essence photography.”

You can e-mail Chamlee and Smith through their Web

site, wuw.michaelandpaula.com



ecognized as a master printer and
Raccomplished line art landscape
photographer, 1o nhn SEXTON Sees growing
challenges to the future of black and white
printmaking in the face of continued refine-
ments m digital imaging techniques. Never-
theless he believes the qualities and unique
beauty of the silver gelatin print will ensure
that traditional darkroom practices endure

I he selection of available materials
may become more limited, iust as in the
beginning of the 20th century commercial
platinum paper was no longer available,
but people by choice will still be enamored
with the aesthetics of black-and-white
printing and will find the tools to continue
with the process comments Sexton, once
a full-time assistant to Ansel Adams
Sexton has published two monographs on
landscapes and one on man-made
technologies, and serves as a technical
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consultant for Eastman Kodak Co.

Despite the growing presence of digital
imaging in all photographic fields, Sexton
says digital has yet to capture the beauty
and tonal qualities of the silver print.

I like the physical characteristics and
beauty of a smooth, air-dried glossy silver
print, says Sexton. Silver printing and
darkroom work expresses a different quality
than is currently available in the digital
arena. I've seen some handsome digital
prints but they all resemble platinum,
prints in terms of physical characteristics.
The results | like best in digital are where it
expresses something that couldn't be
expressed in conventional media

According to Sexton, mastery of tradi-
tional darkroom techniques is indispensable
in helping photographers expand their
creative capabilities, even in the digital arena.

There arc things 1 will try and photo-

graph today | would have walked away from
10 years ago. Now | have a bigger tool box
of processing and printing techniques,"
explains Sexton. "l can do more challenging
and newer subjects. Black-and-white photog-
raphy isa holistic process,- as you successfully
add to your set of technical tools, they
become creative tools. A particular
technique gives new ways to see and adds
to your bank account of creative possibilities.
Those people doing the best work in
digital are those with the tools and set of
skills in conventional darkroom work."

Sexton will be conducting his annual
two-week workshop in August at Anderson
Ranch, now in its 17th year, in Snowmass,
Colo. His work will be exhibited this fall at
the Ansel Adams Gallery in Yosemite and
Monterey, Calif.

You can e-mail John Sexton through his Web site, at
www joknsexton com



longtime proponent of traditional fine
A art black-and-white photography,
Huntington W itheril1 has embraced
digital image-making for its limitless
creative capabilities. These days Witherill
both shoots and prints digitally. His latest
series of highly manipulated botanicals,
which are represented by the Ansel Adams
Gallery, are an elegant testimony to the
aesthetic potential of digital imaging.

Unlike ardent traditionalists, Witherill
delights in the creative and technical
controls made available in the digital realm.

"One of the greatest things about
working digitally is it opens a completely
new world of photographic visualization,"
says Witherill, who has published two
books of black-and-white landscapes and
botanicals through Lenstvork, and teaches
numerous workshops in traditional and
digital imaging techniques.

"Digital has the added advantage of
considerably greater control and image
management. The photographer can look
for different things knowing the controls
can resolve what you're looking at There
are also more imaginative ways you can use
acamera digitally than conventionally.”

He's wary of the exaggerated claims about
certain aspects of the digital process and
concerned about the accelerating obsoles-
cence of many digital programs, equipment
and techniques, yet Witherill believes that
digital will ultimately yield images that
fully measure up to the aesthetic qualities
of traditional black-and-white prints.

Image fidelity, sharpness and maintaining
tonal qualities are the most important
factors, says Witherill. "The key to get a
digital print to look like a conventional print
is making whatever technique you use trans-
parent and maintaining the integrity of the
image throughout the process. The second
most important is the archival nature of the
digital print. The biggest problem with
digital is that by the time you learn the
process, it's gone and a new process is out
there. It takes a huge commitment of time
and money to go digital O

You catt e-mail Huntington Witherill at
hwpboto@sbcglobal.net

All images ©Huntington Witherill
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technology

There is an entire subculture of

photographers doing super-high

quality digital black-and-white
imaging and printing.

I stumbled upon this world recently, and
after questioning several of the leading
practitioners of their black and white art,

I've come back to share their secrets with you.

What are you afraid of?

Quality, permanence, and unfamiliarity
are probably the three biggest fears or
concerns real or imagined—preventing

BY HARALD JOHNSON

Your guide to

digital B&W

The secrets behind high-quality imaging and printing

photographers from heading down the
digital black-and-white path.

Looking at quality first, Florida pro and
master printer Steven Katzman describes
his own recent conversion experience:
"After spending 30 years in the darkroom,"
he explains, "l was reluctant to try
something new. Early on, | had seen some
digital black-and-white prints, but was not
impressed. Then, lattended a scanner
seminar and brought along one of my
black-and-white negatives with a
selenium-toned darkroom print. They
scanned in and inkjet-printed the image
for me on the spot, and | realized in that
moment that the digital age had caught up

with traditional black-and-white printing.
The comparison of the digital print with
my silver print that had taken hours to
pull can only he described as profound,
the quality was that good.”

Regarding permanence or longevity,
photographer and digital black-and-white
printing expert Paul Roark admits that
"until recently, digital black-and-white
prints have not been as durable as silver
prints," and fiber-based silver or platinum
prints arc the standard for longevity
against which all else is compared
"Unfortunately,” he continues, "the black-
and-white materials were not as good as
originally represented, and as such, some
people saw their allegedly archival’
materials turn brown or fade.

However, things are definitely
improving. "My tests indicate that the
latest, 'second generation' pigment inks
do not warm up like the old inks and are
extremely stable, says Roark. "So, in my
view, digital black-and-white printing has
come of age.

And finally, "Familiarity with
darkroom ways and unfamiliarity with the
computer tools necessary for a digital
workflow is another fear," says fine art
photographer and consultant Robert
Morrison. A different set of skills is
definitely required, and this creates
resistance to change. Or, as photographer
and 3D digital illustrator Peter Neumann
explains it, "Fear is not the issue here,
knowledge and experience are."

Steven Katzman turned heads at last October's
PhotoPlusExpo in New York City when he exhibited
his large-format digital B&W prints including "Young
Joe Louis" (left), which is in the Eastman Kodak
corporate collection. "People said that they had never
seen digital prints with such a neutral color and
smooth transition of tonal values,” says Katzman.



How to get great results in digital B&W

Here arc some workflow tips and tricks
from the pros to get you on the road to
great digital black and white.

image capture

While you could certainly use a high-
end digital camera or scanning hack, many
digital black-and-white pros shoot film
and then scan it.

"Start with a well-cared-for black-and-
white negative that is carefully scanned,”
says Los Angeles photographer and print-
maker Antonis Ricos, who, with fine art
photographer Martin Wesley, runs one of
the most important e-mail discussion lists
for digital black-and-white pros: DigitalBW,
The Print (see Resources). "For large prints
and 8x 10 negs, a drum scanner is the way
to go. It is also able to keep any film
flatter and therefore sharper than scanners
that don't involve drum mounting. For
formats up to 4x5, you can get very
decent results with the Imacon scanners,
especially the latest models that offer
autofocus and a cooled CCD.

The Imacon Flextight 848 film (and print) scanner, a
favorite among certain digital black-and-white pros.
Inset: Imacons use a virtual drum technology that

bends the original through a glass-free optical path.

Image editing

There are numerous of ways of converting
scanned or digitally captured color images
to grayscale, and Adobe Photoshop is the
preferred software to do it. "Photoshop is
the industry standard for image editing
and with good reason, says New York
black-and-white fine-art photographer
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Amadou Diallo. "Rarely a week goes by
that 1don't stop and say 'Wow' at the level
of precision and control it affords. Because
of its widespread use, Photoshop also
provides a common language among
imagers. | can talk about shadow values,
gamma densities, and ink percentages with
another photographer, and we re actually
talking about the same numbers.

Photoshop's Channel Mixer with the Monochrome
option checked helps change the relationship of
the color values.

Using specialized inks

A recent improvement in the digital
printing of black-and-white images is the
development of multi-toned, monochromatic
inks that replace the color inks in inkjet
printers. This is also called quadtone or
hextone printing, the printer thinks its
printing in color, but the inks that come
out are all shades of black Popular inksets
include: Piezo Tone (Inkjet Mall) and Full
Spectrum Quadtoncs (MIS). Then, there
are variable-toned or tinted inks, such as
Ultra-Tone B&W (MIS), Small Gamut
(Lyson), and Sundance Septone
(Sundance), that offer a range of subtle
color effects by either making adjustments
to the image or in the printer driver.

"Depending on a photographer's
needs," says C. David Tobie, contributing
technical editor to Professional Photographer
and also to my book, "a quadtonc/hextone
gray ink system, or a tinted version of one
may be an excellent choice, though unless
it is purchased at a significantly increased
price as a proprietary matched system, it
will require special knowledge and a fair
amount of work to get ideal results. A
small-gamut color ink system that uses
CMYK-tinted gray inks requires a far less
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The same Paul Roark image (*Oceano Dunes") printed
with MIS Ultra-Tone B&W inks with two different
adjustment curves applied (top: warm, bottom: cool).

specialized process and offers a broader
range of user-determined tint choices (warm,
cool, sepia, platinum/paladmm etc ).

Using specialized printer drivers or software
Another secret ingredient of the digital
black-and-white pros is special RIPs (raster
image processors) that instruct the printer
exactly how and where to (Hit the ink droplets
Popular examples include ImagePrint

A recent StudioPrint ink assignment printing from
heads 1,2,3, and 6 to Amadou Diallo's Epson Stylus
Pro 7500 wide-format printer.
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(ColorByte), StudioPrint (ErgoSoft), Pixel-
Pixasso (R9), and InkJet Control (BowHaus).

Robert Morrison currently uses
BowHaus' OpenPrintMaker (OPM) driver
"using profiles that I've made using their
InkJet Control (1JC) software ~nd a
densitometer. OPM/IJC offers unpar-
alleled flexibility with the ability to put
any ink in the printer, in any combination
of channels, and make your own profiles.
This allows me to use warm and cool
toners, split tone, load a printer with
both a matte and photo black, etc.”

Using specialized printers

Is inkjet the only way to print digital
black and white? No, but its currently the
method of choice. "With lightjets,
Lambdas, Frontiers and other such digital
imaging devices, explains Tobie, "the trick
for black and white is to get a really
accurate color profile for the device made
and edit that profile yourself, if necessary,
to nail the black and white or near-black-
and-white tones you want. And then apply
that profile to your images before sending
them out tor printing on the machine you
have built the profile for.

I pson really raised some eyebrows with
the introduction of its new inkjet printer
line last summer. The Epson Stylus Photo
2200 and Stylus Pro 7600/9600 with the
new UltraChrome pigment inks were
groundbreaking in several ways, including
the Inst use of seven ink colors (in separate
tanks) with two different blacks-—ene full-
strength, one diluted. Many experienced
black-and-white pros, however, opt for all-
black-and-white, third-party systems.

lor the best image quality, you need to
use a dedicated black-and-white inkset,'
says Roark As much as you try, the color
mksets always end up with color cross-
overs and tints Even if they look great at
fust printer instability and differential fading
cause the problems to surface with time.

(.olor mksets also suffer from metamerism

shifting colors under different types of
lights] With a neutral black and white,
the eye is extremely sensitive to slight
color shifts No color inkset has been able
to solve this problem whereas it is not a
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significant issue with the black-and-white
pigment inksets. Most of us who print
with black-and-white ‘quad' inksets tried
color first and just gave up on that
approach."”

Tobie adds, 'The basic problem with
specialty black-and-white ink systems is
that they require you to devote a device to
them alone. Not too unreasonable with
desktop inkjets, but the price of wide-format
machines makes this prohibitive for many."

Control, complexity and workflow efficiency

Besides no longer having to mix caustic
chemicals or inhale acid, fixer and toners,
Steven Katzman says, |am in complete
control of my vision, my work. If my
interpretation changes, I have the digital
file to return to, not the darkroom. I get
immediate feedback, which leads to
greater creative risks and rewards."

This is not to say that digital black-
and-white imaging doesn't take work; it
certainly does. "Contrary to marketing
hype, says Diallo, "making a fine print
digitally requires every bit of the skill and
experience as producing a print in the
darkroom '

Martin Wesley agrees. "The time and
efficiency issue is identical to making a
fine print in the darkroom. There is some
illusion that digital is a shortcut in this
regard, but it is not if you are trying to
squeeze the last bit of quality out of your
shots,” he says.

Tom O'Connell, another photographer
with a background of more than 30 years
experience, adds, Digital printing isn't
any easier than wet printing, but it offers
more control and a quicker platform to
see the result of an experiment or trial
adjustment.

So, is digital B&W for you?

Katzman sums it up like this: “As a
photographer, Istill remember the first
time | developed my first image—the
magic, the excitement of seeing a latent
image appear from a blank sheet of paper.
Now |am embraced by this same
excitement and passion every time
I see the fruits of my labor output to my

Tom O'Connell sorts prints for the regular print
exchange he runs on the Digital BW, The Print
discussion list.

digital printer. For those photographers
reluctant about getting into the digital
light, remember that childhood
naivete. The training wheels don't stay
on for long." O

Author of the best-selling book "Mastering Digital
Printing: The Photographer's and Artists Guide to
High-Quality Digital Output" (A'tuska k Lipman),
Harald Johnson has been immersed in the world of
commercial and fine-art imaging and printing for more
than 25 years. A lifelong photographer and now
consultant, he is the creator of DPttl.com
(www.dpandi.com), the digital printing and imaging

resource for photographers and digital/traditional artists.

Artide Resauross
BowHaus, www.bowhaus.com

ColorByte Software.
www.colorbytesoftware.com

Digital BW, The Print.
http://groups.yahoo.com/group/
DigitalBlackandWhiteThePrint

ErgoSoft, www.ergosoftus.com
Imacon, www.imacon.dk

Inkjet Mall, www.inkjetmall.com
MIS Associates, www.inksupply.com

R9 Corporation and
Sundance Image Technology,
www.bwguys.com

Lyson, www.lyson.com


http://www.dpandi.com
http://www.bowhaus.com
http://www.colorbytesoftware.com
http://groups.yahoo.com/group/
http://www.ergosoftus.com
http://www.imacon.dk
http://www.inkjetmall.com
http://www.inksupply.com
http://www.bwguys.com
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on line
Superstore
IS open

When In 24-hours
FHOOMIESFROAIIO o York for your

) convenience.
420 Ninth Ave. Be Sure To
Between 33rd & 34th Streets,

New York, N.Y. 10001 Visit Our

For Information & Orders Call:

800-947-9964 Superstore!
212-444-6664

or Fax (24 Hours):

800-947-7008
212-239-7770

WE WILL BE CLOSED ON:
August 7th, 2003
WE WILL BE OPEN ON:
Labor Day September 1st, 2003

From 10am to 6pm
Store & Mail Order Hours: Sunday 10-5; Monday - Thursday 9-7; Friday 9-2; Saturday Closed
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I BY BERNARD J. SUESS

Sensuous pleasure an appreciation of B&W photography

s a photographer whose career has evolved
A into working mainly with Web pages and
digital photography, | find myself cherishing the
limited time | can spend in the darkroom. |
appreciate the speed of working with digital
photographs, but that appreciation does not
encompass the production of black-and-white
photos on the computer.

For many years | made my living as a profes-
sional photographer, chiefly in publishing. The
magazines and stock agencies | dealt with preferred
color photographs, and | shot transparency film
for most of those clients. But when | was traveling
to shoot stock photography, | loaded at least
one camera with black-and-white film. | shot
these photographs for myself, not to please a
client. Black-and-white photography became so
important to me that | studied photo-chemistry
and learned to mix my own developers, for both
film and paper. In those long hours in the
darkroom, | was perfecting my techniques as
well as the formulas for my developers.

My passion for black-and-white photography
soon became a vocation as | began to teach and
write about it. | never found myself tiring of
black-and-white photography.

As a photo instructor, | found myself
dabbling in digital photography early on. | have
even taught courses in digital photography and
Web graphics. Much as | enjoy digital
photography, it's my black-and-white darkroom
that still holds the strongest allure.

What is it about black-and-white photography
that makes it so enduring (and endearing, in my
case) in the face of all these digital assaults?

The first thing that strikes me about the
darkroom is the sensuality of producing black-
and-white photographs. As soon as | enter the
darkroom and start mixing the developer, there's
a distinct smell that | associate with making
photographs. Experienced darkroom workers
know that different developers have different
odors. Each triggers its own memories. The
stop bath and fixer each have their own odor,
too. When | smell the combination of chemicals
I'll be using. | know I'm ready to start printing.

"The act of printing
and developing is
hands-on in a way
digital imaging will
never be."
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The act of printing and developing is hands-
on in away digital imaging will never be. Though |
can work on images at the pixel level, I still
cannot physically dodge and burn on the
computer the way | can when I'm printing in the
darkroom. | can adjust the feathering (the
gradation of the change) by the height of my
hands over the paper, and the way | hold them
or a dodging tool. Unless some sort of three-
dimensional feedback hardware is available, it's
unlikely I'll be able to duplicate my darkroom
results on the computer. For this reason, even
when a black-and-white photo is going to be
used on the Web or scanned for publication, |
digitize a print rather than the negative.

This touches upon the tactile nature of working
in a darkroom. | know my darkroom by touch.
In complete darkness | can find any of my tools or
equipment. Years ago, | went into a publication's
very modern darkroom. It had a very bright safe-
light, so it was nearly like working in a normal, well-
lighted room. But when | had to dodge and burn,
I couldn't see the edges of the image well enough
to perform those relatively simple tasks, tried to
explain to the staff photographers that there’s a
reason it’s called a darkroom. That day | learned
that the newest is not always the best. | never
longed for a bright “working” darkroom after that.

Similarly, | don’'t wish to make black-and-
white photos on the computer. | do scan black-
and-white photos. | use digital files for the Web
and for photos that will be published in print,
but not for black-and-white prints. Since | don’t
do color work in my darkroom. | have had color
prints made from digital files. In that case. | feel
| have more control over the end product. While
| am pleased with the results, the thought of
having my black-and-white photos produced on
color paper sends a chill down my spine. Of
course, I've never had a lab print my black-and-
white photographs conventionally, either. I've
always felt that no one could print my negatives
the way that | do. Perhaps it’s a little ego and a
little over-protectiveness. No matter. My black-
and-white photos are always made by me— not
even by an assistant— and always by hand.

Perhaps it's the sense of doing it myself, the
pride that comes with working with my hands,
albeit in an artistic manner, that makes me feel
this way. | have no qualms about writing on the
computer. It is probably telling, however, that
most of my writing starts as a handwritten
outline first. There doesn't seem to be a better
way to ensure that my thoughts are organized
before | begin crafting the piece. My black-and-
white printing is that way, too. | usually make
test prints, and | live with them for a while—

A dose-up of a weathered root on a living tree in
Olympic National Park, in Washington.

even make perfunctory notes to myself about
where to consider dodging and burning— before
deciding which to print as my final version.

In the end, the art of photography has never
been about process, though that's always been a
big part of it. As with artists in any medium, it has
always been about vision. | worry that
photographers won't have the choices that |
have when everything is digital. They won't
enjoy the way it feels to go into a darkroom.
They won't have the flutter of excitement when a
great print begins to appear in the developer, the
thought that “1 did this” will not enter into it.
There may perhaps be a little less of the
photographer in that final equation.

Bernhard J. Suess, of Bethleham. Pa,, is a
professional photographer and instructor whose
work has been published in more than 40
publications in seven countries. He teaches at
Northampton Community College.



"The Professional's Source"
420 Ninth Ave. NYC 10001

Store & Mail Order Hours:
Sunday 10-5 « Monday - Thursday 9-7
Friday 9-2 « Saturday Closed

PENTAX

Telephone Orders:
TTTETNW EzT :7 1§

212-444-6664 + Fax:212-239-7770

PHOTO-VIDEO-PRO AUDIO

MEDIUM FORMAT

CONTAX

n

FUJIFILM

GA-645 Zi
645N Il 645 AF J .
Autofocus Body Only w/Fujinon
Body Only £030m 55.-90mm G X-617 Body Only 2799.00
*
1889$ M S AF Kit Zoom Lens
) G X-680 Il Body Only 2999.00
645N Body with 80/2.8 Planar Lens, S1449%
% )
149938 B“ks'g'"sge"g&gEgder GX-680 1l S Bodyonly ~ 1499.00
645 SMCP-A AF LENSES 6x7 LENSES Carl Zeiss T* AF Lenses for 645 AF GX-617 LENSES 125/3.2 GXMD 1711 (KA
35/35 . 979.95 4528 809.95  45/4 929.95 55/4 959.95 353 5 Distagon 2395.00 457 8 Distagon 2249 00 90/5.6 2609.95 105/8 2500.00 135/5 6 GXM 1144 00
7512 8........419.95 150/2.8 If  1049.95  75/45 609.9575/28 Al. 749 95 NEW! 55/3 5 Distagon . 1475.00 180/6.7  2359.95 300/8 . 2839.95 150/4 5 GXM 1228 00
120/4.0 IF Macro................. ... 1149.95 90/2.8 629.95 100 4 Macro 1199.95 80/2.0 Planar.... 1565 00 GX-660 LENSES 180/5.6 GXM 1301 00
200/4.0 IF . . 849.95 300/5.6 in if 1377.95  105/2 4 469.95 135/4 Macro  689.95 120/4,0 AP0 Macro Planar (Manual Focus) 2395.00 65/5.6 GXM 2204 00 50/56 GXM 2834.00  180/3.2 GXML) 1784 00
300/4 IF 3399.95 400/5.6 IF 2199.95  165/2 8 769.95 165/4 1S 849.95 140/2 8 Sonnar ~ 2255.00 210/4 OSonnar 2255 00 80/56 GXM 1742 00 100/4 GXM 1207.00  210/5.6 GXM 1280 00
33-554.5 AL1295.00 45-85/45 1659.95  200/4 829.95 300/4 1319 95 350/4.0 APOTessar... 5795.00 1153.2 GXMD 1625.00  250/5.6 GXM 1333 00
55-110/56  895.00 80-160/4 5 1549.95  55-100/4.5 1669.95 90-180/56  1199.95 NEWI 45-90/4 5 Distagon 2900 00 125/5.6 GXM (820) 1112.00  300/6 3 GXM 1868 00 ,
503-Cw J*
203-FE
Only Body Only
s2131°° *3270M
- i 503-CW Kit w/80/28CFE with Zeiss Biogon 38mm lens
'531 AC’C“FEIKZ;BWLBO’Z';“;‘;O 00 Lens 8 Al2 Back 1790.00 NEW! Rebates on 501 CM Kit, 503 CW Outfit, 555 ELD Body, N o oo
ens ac : : 203 FE Body with E-Magazine & 60-120 FE Zoom Lens 5704
E CFI/ICFE LENSES w/Caae 250/5.6 CR... 3362 00  14XE Teteconverter 1164 00 riLM BACKS VFIWFIMOCRS
303 5 CFi 6524 00 50 IFU CR 2946 00 250/5.6 Super Achromatic CFE 5649 00  2XE Teteconverter 1410 00  E-1? Magazine 1054 00 Waist Ifv*| RIMfef (Bteck Of Cfttomt) m no
160/35CFi 2335 00 803.8 CFE..... 1878 00  350/5.6 CFE Super Achtomal 7345 00 FE LENSES E-24 Magazine 1092 00 PMC 45 46* Metet Prism Fmotef 1932 00
11003 5 CFi 2705 00 500/8 w/Hood 6258 00  50/2 8 4250 00 1HV2 403500 A 12 Magazine 781 00 A-16 Magazine 895 00  PM 90 90* Ptum funte» 718 00
| 120/4 Macro CFE 3090 00 14XE Tele Converter APO 1280 00  350/4 8525 00  A-24 Manazmil 895 00  HM-? Magnifying Mood #72524 nt
It50/4.0CFi 301100 180/40CFE 3303 00 14X PC Mular Shrft Converter . 3299 00  60-120/4.8 FE Zoom 401? 00 Hass PolaPlus Polaroid Rack 39500  V*w MAgiwitei t/PM-45 PMC-45 259 00
SQ-Al . 645 Rangefinder
1255 B R O N IC A TAkan Bogy Jn6514.0
Body Only *1649" New!
- - *1
SQ-Ai Kit ETRSi GS-1 Kits Loss saso Rabattt -y,
with PS 802 8 Lens, 120 or 220 Body Only with 80/3 5 Lens. Final 1199 o 7wes
y 1 Film8ack A Folding *1105°° Prism Viewimdet 4 45mm f/4.0 wiviewfinder (580)
Waist Level Viewfinder. 2499.00 1?0or 220FiimBack 1999.95 Lena *50 Rabat*!
SO Basic Body Only 823.00 W/7§/;—8RP: Le:sl\tlvaist wrth 80/3 5 Lens 100mmf/4.5 (580)
SQ Basic Kit w/PS 80/2 8 Lens. 120 or 220 Level Finder 4 Ei 1'20 Back AE Pnsm Viewfinder 4 ten $50 Rabat*!
film Back 4 Folding Wats! Level Viewlinder 1999.00 1699.00 1200r 220 FHmBack 2199.95 RF 20 Flash 4ftor $30 Rabat*!
1LENSES 105/4 5 PE Macro (67¢) 1392.50 SQ-Ai 6*6 SYSTEM LENSES 110/4 5 PS Mean (72ol, 1619 00 08-1 6*7 SYSTEM LENSES
1599 00 135/4 PE (67%).... 1286 00 353 5PS fish eye (32 50 Hear) ... 1699 0 135/4 PS (670) 1643 00 50/4 5(950! 192500
1490 00 150/3 5 PE (62€) 1358 50 40/4 PS (950) 2038 50 150/4 0 PS (67 0).covrcrrrcenres 1779 00 1716 50
1358 50  200/4 5 PE (62€) 1376 50 503.5 PS (/l.., oo 1779 00 200/4 5 PS (670) 1898 00 799 DO
1358 50  45-90/4 0-5.6 PE Aspherical (950) 1544 00 65/4 PS (670) 1626 00 250/5.6 PS (67a) 2028 00 100/3 5 (720] 130206
860 00  100-220/4 8 IF (950) 2059 00  803.8 PS (670) 1245 00 50-100/4-5 6 PS (95«) 2149 00 150/40(720]| 171600
645 AFD M iy RZ67 PRO Il MAMIYA 711
645 EKil w803 84 Inset ~ 699. 00
845 ERapid Pro Value Pack RZ67 Pro Il Value Pack Mamiya 7 Il Black Kit
w/80/2 8.120 Insert 4 w/llOmm f/2 8 Lens, w/80mm 1/4 Lens,
Rapid Wind Grip 799.00 645 Pro TL Kit Foldind Waist Level Lens Hood,
645 SVX Il Value Pack w/80/2 8 Lens. 120 Back. SV Power Drive . Finder & Strap and
2399.00 Grip 4 AE Pnsm lirtler 2999.00 " Hood Hot Available 120 Back 2999.00 Battery 2499.00
645 AF LENSES w/Hood +50/4 Shift (770) 1439 00 MAMIYA 7 SYSTEM KL LENSES +754 5 Shill (1050) 3258 (xA
3535 V1379 00 453,8(6/.. 1099 00 553 8 i>8§ 665 00 553 81S (6/) 1659 00 434 5 wiOptical Viewlinder (67or 2599 00  65/4 (770) 1999 00 753 5 (770) 1979 00 903 5(77i). 1449 00
553 8(580) 989 00 8038 <Me). 29900 3019 679 00 1949 00 903 5(770) 1599 00 1273 5(770) 1499 00  110/2 8(770) 1469 00
120'4.0 MF Macro Portrait (670) 1949 00 120/4 0 APO Macro (670) 1589 00 654 (580) 1599 00 80/4 (580) 980 00 140/4 5 Macro (770) 1989 00 1454 5 LA (770) 1999 00
1503 5 (670) 1189 00 1503 5 (670| 659 00 15004 5 (67e) 1799 00 150/35(770 1599 00 18Q'4if/70- 1549 00
210/4 0 ULD 1599.00 300/4 5APO 3239 00 1503 8(670).... 1559 00 2103 0(580j 1999 00 250/4.5 (770).. 1999 00 180/4 5 Short Barrel (770) 1249 00
55-110/4.5(670).. 1999 00 2003.8 APO (770) 2599 00 RB LENSES w/Hood RZ LENSES w/Hood 180/4 0 Sod focus (7/0) 1669 00
105-2(0/4 5(580) 1999 00  210/4C 5to 749 00 3003 6 A 1399 00  37/4.5 (w/4 Fillers, no hood) (40 5Soi 2869 00 +37/4.5(40 50).cererrrrre 2859 00  210/4 5 APO (770) 3559 00
645 PRO LENSES w/Hood 500/5 6 itosoi. 2499.00 Mamiya 2* 779 00 50/4 5 (770) 1749 00 50'4 5 ULD (770) 1839 00  250/4 5 (770) 2059 00
2414 C 2199.00 *35/3 5C t2r0>.. 1069 00  55-110 (670).... 1829 00 500/8 (1050) |, eovvrrrnee 4599 00 654 LA(77el 1999 00 100-200 5 2 <77%}.cccceviccrcn 3739 00
v452 8S (670) 879 00  105-210 (58e) 1699 00  150/4 Soft Focus (770) 1749 00 1899 00 929 00

Minimum shipping USX (Except AK ft HI) $7 95 up to 1 Ib Add 95c lor each additional Ib. For ins. add 50c per $100 Prices valid thru August 9th 2003. subject to supplier prices. © 2003 Photo-Video

-Mk*

MW

More info? Circle 37



calendar

Submit your organization's convention,
workshop, seminar, or exhibition dates to
Professional Photographer at least six months
in advance. Professional Photographer editors
reserve the right to select events to 6e
announced on these pages, and to determine
when announcements will appear. Editors are
not responsible for conflicting or incorrect
dates. For readers' convenience, each event
is identified by a code preceding its name:
C-Convention, W*=Workshop, S=School,
C/E*=Approved PPA Continuing Education
Seminar, E=Exhibit. Send all Calendar of
Events additions or corrections to: Paula Saje,
Professional Photographer, 229 Peachtree
Street, NE, Suite 2200, Atlanta, GA 30303;
FAX: 404-614-6404; Psaje@ppa.com.

PPA Certification Exam

The following are exam dates and locations
for the PPA Certified Professional Photographer
Exam. For Certification information or an appli-
cation packet, call 800-786-6277. Your state
Certification liaison may know of additional
exam dates in your area. (For a directory of
liaisons, go to www.ppa.com.) Candidates must
contact PPA headquarters at least five business
days before the exam to reserve a place (800-
339-5451, ext.228). Picture identification will
be required upon arrival at the testing site.

August 25: Florida PPA Convention, contact
Ed Robinson, 305-836-6797

Current Events

August 23-27

C: Florida PP, Sheraton World Resort, Orlando,
Florida; Teri Crownover, 352-243-1135;
tc2u@worldnet.att.net

August 24-27

S: Carolina Photographic Art School, Sheraton

Imperial Hotel, Research Triangle Park, NC; Bob
Henderson, 1310 Westridge Road, Greensboro, NC
27410; 336-299-9411; bhphoto47@ earthlink.net

August 31-September 3

C: PP of Louisiana , New Orleans French
Quarter; Don Daigrepont, Convention Chair,
985-646 1233; dondaigr@aol.com

September 7-8

C/E: Indianapolis PPG, Brown County State Park,
Nashville, Indiana; Terry D. Bateman, P.O. Box
55167, Indianapolis, IN 46205; 317-253-6245;
batemanphoto@ msn.com; www.ippgonline.com

September 13-16

C: PPA of New England, Sturbridge Host Hotel,
Sturbridge, Massachusetts; Roland L. Laramie,
ppanerl@aol.com
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PPA

September 19-21

Women in Photography Retreat,
Wyndham Buttes Resort,
Tempe, Arizona

November 3
Super Monday

January 17-23, 2004

Marketing & Management, Seniors, Family &
Children, Wedding, Specialty Conference &

Trade Show, Beau Rivage, Biloxi, Mississippi

February 8-10, 2004
PEI Digital Conference, Dallas, Texas

September 27-29

C: PP of Ohio conference and trade show,
Hilton-Easton, Columbus, Ohio;

carol@ ppofohio.org; www.ppofohio.org

October 12
S: Memphis PPG, St Francis Hospital Longinotti
Auditorium, Memphis, Tennessee, 901-761-3266

October 25-27

C: PP of Nebraska, Midtown Holiday Inn,
Grand Island, Nebraska; Eric Brun, Conference
Chairman, P.O Box 24438, Omaha, NE 68124;
402-397-9899; ciperic@aol.com; www.ppofn.org

November 9-10

S: Tennessee PPA Fall Seminar, Comfort Suites
Hotel, Lebanon, Tennessee, Dwight A. Jewell,
615-374-9412; e-mail 4togra4@ bellsouth.net

Future Events

January 13-15, 2004

C/E: 5th Annual A Week in Heaven, St. Lucia,
West Indies, Charles Vandersluys, P.O. Box
2332, Niagara Falls, NY 14302; 800-393-7270;
905-354-8692; bvphoto@ on.aibn.com;
photo_workshops.homestead.com

January 20-25, 2004

C: PPC Western States Trade Show, Pasadena
Convention Center, Pasadena, California; Bill
Thomas. 909-780-2627; rivphoto@ pe.net

January 21-25, 2004
C: PPC Western States Trade Show, Pasadena,
California

["v
January 24-27, 2004
S: PP of lowa, Holiday Inn Airport Hotel, Des
Moines, lowa; Christy Brinkopf, Exec. Sec., P.O.
Box 108, Sumner, IA 50674; 563-578-1126; FAX
563-578-0926; ppichris@iowatelecom.net;
www.ppiowa.com

January 30 - February 2, 2004

C: Kentucky PPA, Northern Kentucky Conven-
tion Center, Covington, Kentucky; Nancy W.
Drury, President, 859-744-4903; Kim McDaniel,
Exec. Secretary, 1806 Antler Ave., Owensboro,
KY 42303; 270-926-8275; www.kyppa.com

Events

July 25-27, 2004
Imaging USA, Las Vegas Convention Center,
Las Vegas

January 16-18, 2005
Imaging USA, New Orleans, Louisiana

July 2005

Marketing & Management, Seniors, Family &
Children, Wedding Conference & Trade
Show, Biloxi, Mississippi

For information on PPA Events,
call 800-786-6277

February 27-29, 2004

C: Wisconsin PPA, Marriott Hotel, Madison,
Wisconsin; Jon Allyn, Conv. Chair,
jonallyn@aol.com; Mary Mortensen, Reg. Chair,
mary@ mortensenphoto.com; 262-549-0009

March 3-8, 2004

C: Mid-East States Regional/ PP of Ohio, Dayton
Convention Center/Crowne Plaza, Dayton,
Ohio; carol@ ppofohio.org; www.ppofohio.org

March 13-16, 2004

C: PPSNY, Rye Town Hilton, New York;

Ken Bovat, 76 Old Lane, Claverack, NY 12513;
518-851-6600; bovat@aol.com

March 13-17, 2004

C: PP of Nebraska, Midtown Holiday Inn, Grand
Island, Nebraska; Monte Evans, Con. Chairman,
3801 Lexington Ave., Bellevue, NE 68123; 402-
292-6426; montephoto@ aol.com; www.ppofn.org

March 20-24, 2004

C: PP of lowa, Marriott Downtown Hotel, Des
Moines, fowa; Christy Brinkopf, Exec. Sec., P.O.
Box 108, Sumner, IA 50674, 563-578-1126; FAX
563-578-0926; ppichris@iowatelecom.net;
www.ppiowa.com J

Professional Continuing Education
PPA-Affiliated Schools

PPA members receive both merits and
the best-published prices.

August 11-15

Long Island Photo Workshop

St. John's University, Oakdale, Long Island;
Jerry Small, Director; 516-221-4058;
jerry@jsmallphoto.com;
www.liphotoworkshop.com

August 24-27

Carolina Photographic Art School
Sheraton Imperial Hotel, Research Triangle
Park, North Carolina; Bob Henderson; 336-
299-9411; bhphoto47@ earthlink.net;
www.ppofnc.com/caps.html
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DIGITAL CAMERAS, PRINTERS & SCANNERS

fCation

PowerShot S230

CALL
Digital Elph

* 3 Megapixels

« 1/2.7* CCD

+ 2048 x 1536 Resolution

+ 3.2x Digital Zoom

+ 2x Optical Viewfinder & 1.5" LCD Monitor « Program.
Exp Comp. « CompactFlash card (16 MB included)

+ 2 5 fps. Burst Mode + Movie w/Sound « Auto Focus

+54-10.8mm f/2.8-4.0 (35 Equiv. 35-70mm) Zoom Lens

« Direct Printing to Canon Printers « Evaluative or Spot

Metering * Landscape/Macro Mode * USB Port
Dimensions 3.4 x 2.2 x 1" + Weight 6.4 oz

OLYMPUS

C-5050 Zoom
CALL

5 Megapixels

1/1.8" CCD

2560x1920

Resolution
« 3x Optical Viewfinder 8 1.8 Tilting LCD Monitor
*7.1-21.3mm f/1.8-2.6 (35 Equiv 35-105mm)

Zoom Lens « 3.3x Digital Zoom « Hot Shoe

Compact | & Il. Smartmedia or xD Cards (32 xD MB
included) < ISO 100-400 -« 3.3 fps Burst Mode

Dimensions 4.5 x 3.1 x 2.7* « Weight 13.4 oz.

HFUJIFILM m i

FinePix S2 Pro

* Interchangeable Lens
SLR type Dtglial Camera
6.1 Megapixels
+23 x 15 5mm Super CCO
+3024 x 2016 Resolution
m18" LCD Monitor
+ Dual slot SmartMedia 8
Compact Flash II. Microdrive memory cards
*SLR Type, TTL Eyelevel Viewfinder « Single. Continuous.
Multiple Shooting + 3-D Maiiix. Spot Center weighted
+ Auto oi Manual Focus with Nikon AF or Al-P Lenses
+1S0 100-1600 + Hot Shoe/PC tor Ext Flash *8uilt-in Flash
+ Dimensions 5.6 x 5.2 x 3 1" « Weight 27 oz. Body Only

2727 r

STC anon MAC
S-9000

1BubbleJet. Ink-on-Demand

tecnology + 6 color printing

wi/8 Individual ink tanks -

reduces waste "Approx  k

25 years Lightfast images |

1Up to 2400 x 1200 dpi e
resolution/3072 ink nozzles ™

for exceptional speed and quality

14" x 6' borderless print in 37 seconds/

8' x 10" borderless print in approx 1mm
IMax Cut Sheet paper Size -13" x 19'
lncludes PhotoRecord. ZoomBrowser*
ImageBrowser, and PhotoStitch Software
Dimensions 22.5 x 7 7 x 13 1"« Weight 17 4 Ibs

[C ation m
CanoScan FS4000US WIN

35mm/APs Scanner

3-line CCDcolor

image sensor

4000-dpi optical

resolution at 42-bits

Dynamic range of 3.4

Top scanning

speed of 48 sec.

Film Automatic

Retouching and

Enhancement, Photoshop LE
and FilmGet FS driver Software
USB/SCSI 2 Interface
Dimensions 3.7 x 5.75 x 14 7" + Weight 5 3 Ibs

OLYMPUS

C-4000
CALL

14 Megapixels

«1/1.8" CCD

2288x1712

Resolution

13.3x Digital Zoom

Burst Mode

3x Optical Viewfinder & 1.8" LCO Monitor

6 5-19.5 mm /2.8 (35 Equiv 32-96mm) Zoom Lens
SmartMedia memory card (16 MB included)
Compatible to 128 MB « Optional dedicated Flashes
Dimensions 4.3 x 3 x 2.6" « Weight 10,2 oz.

Canon mm

PowerShot G3
CALL

* 4 Megapixels

*2272x1704
Resolution

*4x Optical
Viewfinder & 1.8"
Vari-Angle Monitor'

*7.2-28.8mm f/2.0-3.0 (35 Equiv. 35-140mm) Zoom
Lens « 3.6x Digital Zoom « Hot Shoe

« CompactFlash Type | & Il memory card (32 MB
included) « Supports Exif 2.2 « 50-400 ISO

* Dimensions 4.8 x 3 x 2.5" « Weight 14.5 oz.

Canon

EOS-1D

« Interchangeable Lens
SLRtype Digital Camera

*4,16 Megapixels

m2496x 1662 Res

« TTL optical viewfinder

«2" LCD Monitor

mCompactFlash Type | or II memory cards

« firewire Port « Uses Canon EF Lenses 1 3x factor

« Built-in flash, Hot Shoe 8 PC Flash Sync + ISO 200-1600

+30 to 1/16.000 sec Shutter Speeds 1/500 Sync
Speed w/Ex Speedlite « Burst rate 8 fps for 21
frames « Dim 6 1x6.2 x3 1" « Wt 44 10z body

Stylus Photo 2200 MAC

* Max. Resolution: 2880 x
dots per inch (dpi) WIN
« 7-color (CcMmYKk)
UltraChrome Inks 8
individual ink cartridges
« Interchangeable Photo
and Matte Black inks
*Max, pnntarea: 13x44"
+ Speed Photos: 8 x t0*
2 min 6sec on Matte 3 min.
51 sec. on Semi Gloss + Roll paper holder 8 Auto
Cutter « USB 1.1 8 2, or Firewire. Parallel interface
« Dimensions 13 x 8.2 x 24.3" « Weight 25.7 Ibs

1280 Silver..... After Rebate *369.95

CALL -

N ik on
Coolscan IV ED (LS-40)

win mac

*35mm/APs5canner
+2.900 dpi Optical Resolution
with fast 42 sec scan times
« Nikkor ED high-resoiution lens
« Dynamic range of 3.6
« LED light source
« Digital ICE 3 Image
+48-bit images at tile
sizes up to 69 M8
Enhancement technology
*Dim 37x66x 124" «+Weight6 6 Ibs

SONY

CyberShot DSC-P10
CALL

+ 5 Megapixels
«1/1.8" CCD
+2592x 1944
Resolution new
« Optical ViewImder
& 1.5" LCD Monitor + USB Port woo —*

+ Memory Stick Storage Media (32 MB included)
+7.9-23 7mm f/2.8-5.2 (35 Equiv 38-114mm) Zoom
Lens « 3.2x Digital Zoom « Program. Exp Comp

« Autofocus or Manual Preset * Movie with Sound
+Auto 100-400 ISO « 3 Shot 8urst Mode « Supports
Exif 2.2 + Oim. 41 x 2 x 1.4" « Weight 7 3 oz

N ik on
Coolpix 5700

+ 5 Megapixels
*2/3" Image
Sensing CCD
*2560x 1920
Resolution
« 8x Electronic Viewfinder & 15" LCD Monitor
*9-72mm f/2.8-4 2 (35 Equiv 35-280mm) Zoom Lens
*Hot Shoe 3 or 1.5 fps Burst w/Best Shot Selector
* Up to 4x Digital Zoom « CompactFlash memory
card Type | & Il. Microdrive (Card included)
*Dimensions 4 3 x 3 x4“ *Weight 18.1 oz.

Nikon

tot*! IMAGING SYSTIM MS'"-1*

*3899*

* Interchangeable Lens
SLR type Digital Camera
+5 47 Megapixels
+23.7x 15 6mm RGB CCD
+3008 x 1960 Resolution
+2" ICO Monitor
*SLRType TTL
Eyelevel Viewfinder
» CompactFlash Type | 8 Il and Mkirodrive memory cards
« Uses Nikon AF-D AF | or AF-S Lenses (1 5x local length in
35mm) « SO 200-1600 « Hot Shoe/PC for fxt Flash
« Single. Continuous (3 | p s) oi Manual Focus

EPSON

Stylus Pro 7600 24" Wide Fomrel Printer

Available with Archival ink or Photographic Dye mt Technology
+ 7-color EPSON UltraChrome? *
mill exclusive ligtri brack
+ Professional levet B8W
photographic printing
+ EI" mirky wide color gamut
* 2880 x 1440 dpi lesoiulion
+ Unswpassed media flexibility
* Variable droplet Micro Piezo* 0X3"*
printhead 96nozzlesX7
rue Borderfree™printing "High-
performance print engine s
* Maljmum Pont Speed iSFPH:
USB | 1& 2. ParrUlel Epson « F=Ve—v [ —e
Expansion, Optional 10/100 Base-T 8 Enewire
Dimensions w.'Optionai Stand 43 3 x49 2x22.5 Wt 96

AStylus Pro 9600 44" Wid«-Format CALt

Polaroid

SprintScan 120 Pro
WN MAC

*+6x4.5,6x6. 6x7, 6x9 and 35rnm

* Single pass RGB 30K pixel CCD

+ 4000-dpi optical lesoiufioti + PolaColor insight Pro
Software + Dynamic range up to 3 9 (4 2 DMax)

+ Data Conversion 14-bit A/O per channel 8-tet 8 16-brt out

+ Scan Time | ess than 2 ""nutes lor 6 x bcm at 4000 dpi

mDynamic Range 0 +390 D (4 2 OMax)  Automatic unt-
torrmr,  true dark calibration * SCSI 2 !Ef1394 (Firewire)

V Interface + Dim 10.7 x55x 192' « Wt 14 me

A

ALL ITEMS ARE COMPLETE WITH ALL ACCESSORIES AS SUPPLIED BY MANUFACTURER

i" m More info? Citcle 37

.Super Coolscan 8000 ED

Canon

PowerShot S45
CALL

%L \rnm

* 4 Megapixels 1
2272 x 1704 m 1
Reolution
Optical Viewfinder
8 1.8" LCD Monitor « 3 6x Digital Zoom
7.1-21 3mm f/2.8-4 9 (35 Equiv. 35-105mm) Zoom Lens
CompactFlash Type | & Il memory card (32 MB
included) « Direct Printing to Canon Printers
3 fps Burst Mode « Supports Exif 2 2
Dimensions 44 x 2.3 x 1 7* « Weight 9.2 oz

Nikon @Y/

r°T*I IMAGING SYSTIM OtAV**  Q QQ

1699s

* Interchangeable lens
SLR type Digital Camera

* 6 1 Megapixels

+23 7x 15 6mm RGB CCD

+ 3008 x 2000 Resolution

+ 18" LCD Monitor

« CompactFlash Type i 8 II.
Microdnve memory cards « Single, Continuous Shooting

*SLR Type TIL Eyelevel Viewfinder + Auto or Manual
Focus with Nikon AF or Al-P Lenses, image coverage (ac-
tor 15* + Hot Shoe/Sync tor Ext. Flash +Built in Flash

+ISO 200-1600 *Dim. 5.7x4 6x3.2" « Weight 14 7 oz.
Body Only ¢ Nikon Inc limited warranty included

znr
Canon

EOS-1DS Air
CALL

« Interchangeable Lens
SIR type Digital Camera \

+ 11.1 million Pitelt

« Full frame 36t24mm
CMOS sensor

+ 2" LCD Monitor « Firewire |

* 4064 * 2704 Resolution « TTL optical viewtindei

« Uses Canon EF Lenses + Hot Shoe 8 PC Flash Sync

« CompactFlash Type | or Il memory cards ¢ Single.
Continuous, or Manual Focus « 30 to 1/8,000 sec
Shutter Speed'. +1S0'00-1250 'Burst late 3 fps
lor 10 frames *6 1x6.2 x3 1" « Wt 44 6 oz body

HIFUJIFILM
Plctrography 3500

« Silver halide photographic process
+ 400. 320 or 267 dpi resolution

+256 density levels [YC M ea | tK
16 7 million color shades

« Ideal for photo labs are) digital imaging
users + No chemicals or toners

+ Auto-color calibrator =

+ Choice of 8x10 or 5x7 prints . All

« Print rile A4 ietfei special Z .-V "**" r

« Printing time 2 mm ffirst print
70 sec /subsequent prints in continuous operation

* Glossy matte oi Overhead ttansparency

* Interlace SCSI-2. Transfer speed 2 7M6/S

f iron ont26x22*24 «Weight 156 Ib»

N ik on
Super Coolscan 4000 ED

135mm/APs Scanner

w000 dpi Optical Resolution
with last 38 sec scan times

*Scanning Area 25 1x 38mm

1INikkor ED rugfi resolution lens

1Dynamic range ot 4 2

1LED light source

* 48-bit images at tile sizesupto ] \] *200 =
130 MB « IEEE 1394 Interface ¥ Rebate!
Optional Roll FMm adapter
8 Aide Slide Feeder
Dimensions 37 *66 * 124" « Weight 6 6 Ibs

CALL



Approved Business Instructors and PPA-Approved Photo/lmaging Instructors.

These sessions are packed with information to help you make more money and
create more personal time— through improved studio management.

SEPTEMBER 28 - 29, 2003

Doubletree Hotel Irvine Spectrum
90 Pacifica Ave.

Irvine. CA 92618

Reservations: 800.222.8733

Onsite registration and check in begins at 8:00 am
Program Hours are 9:00 am - 5:00 pm
Register online at www.ppa.com or call 800-786-6277

Registration fee: $49.00 for PPA Members/ $149 for non-PPA members
Studio Management Services clients receive complimentary registration

To reply, cut here and FAX or mail the card below.

KfQIl 1ST IOR INFORM VIIOfS Simply dale the numbers corresponding to die advertised products, new product listings, editorial features, and die Professional
Photographers of America services in this issue and mail this card today at the address below. For fast reply, FAX die completed card to 847-729-2199. Your
request for information will be forwarded to the appropriate party who will send full information to you - quickly, free and without obligation.

NEED TO KNOW MORE ABOUT i tion on the items circled below rofessignal ugus
THE SERVICES OFFERED BY PPA? e memomateren e PHGtographer A%,

Wo re here to help you. Justda le ON THE 18 35 52 69 86 103 120 137 154 171 188 205 222 239 What type of ecjtiipment do you plan to purchase or upgrade
19 36 53 70 87 104 121 138 155 172 189 206 223 240

20 37 54 71 88 105 122 139 156 173 190 207 224 241

CARD the same number shown against in die next 3 months?

1
2
our lisl of services below: 8 A Medium format camera/lens ). Studio lighting
4 21 38 55 72 89 106 123 140 157 174 191 208 225 242
1. Membership 5 22 39 56 73 90 107 124 141 158 175 192 209 226 243 B. 35 mm camera/lens K Computer/Software
2 PPA Group Insurance 6 23 40 57 74 91 108 125 142 159 176 193 210 227 244 G large format camera/lens F. Studio accessories
3. Imaging | SAConvention 7 24 4 58 75 92 109 126 143 160 177 194 211 228 245
I. Niche Conferences 8 25 42 59 76 93 110 127 144 161 178 195 212 229 246 In the past 12 months, have you purchased or researched a
5. Merit and Degree Program 9 26 43 60 77 94 111 128 145 162 179 196 213 230 247 product alter seeing it in Professional Photographer?
6. Certification 10 27 44 61 78 95 112 129 146 163 180 197 214 231 248 1 Yes 2.No
7. Magazine Advertising 1 28 45 62 79 96 113 130 147 164 181 198 215 232 249
8. Direct Response (aid Advertising 12 29 46 63 80 97 114 131 148 165 182 199 216 233 250 What are your purchasing needs?
9. Print Exhibition Competition 13 30 47 64 8 98 115 132 149 166 183 200 217 234 251 (i. Immediate
10. PPA Inlrmational Sclhxil of PP 14 31 48 65 82 99 16 133 150 167 184 201 218 235 252 Il. Within six months
11. Super Monday 15 32 49 66 83 100 117 134 151 168 185 202 219 236 2ST I. Information only
12. Studio Management Services 16 33 so 67 84 101 118 135 152 169 186 203 220 237 254
17 34 51 68 85 102 119 136 153 170 187 204 22! 238 255 How much did you or your organization spend on lab services
hist month?
Mail the completed card to: Professional Photographer, 180" Glenview Road, Suite 100, Glenview, II. J. $5,000 + M. $2,000 - $2,999
60025-9976. For faster reply. FAX to 8t"-"’29-2199. K. $4,000 - $4.999 N. $1.000 - $1.999
Name L $3,000 - $3,999 0. $500 - $999
Title What is your title?
P. Studio Owner/Manager S. Marketing. Sales. Advertising
Company Q. Stalf Photographer T. Other
vddress R. Freelance Photographer
City State ZIP

Phone ( ) F x\
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President's Message

It is time for a new beginning. Every year at PPAs international convention, a new
President is elected to begin the leadership year on September 1 My friend and col-
league Bob Lloyd is preparing to assume that position for the 2003-2004 term. For the
upcoming year, as Bylaws dictate, | will fill the role of Chairman of the Board. |want
everyone to know that my efforts as Chairman and my dedication to this association

will be as strong as ever.

This past year has been such a great experience. Visiting with fellow members at affiliate meetings
and conventions was extremely important to me; it brought a great deal of insight and fulfillment to my
year as President. So many of you showed me respect and hospitality that will never be forgotten |
have a new appreciation for the close "family" of PPA members, all of whom share the special goal of

improving our profession
PPAwiIll continue to evolve as we strive to perpetually improve membership benefits. Through these changes,
the professional staff continues to be the rock that brings stability and strength to the organization It has
been wonderful working with them, as well as with the rest of PPAs Board of Directors | look forward to
future undertakings with these groups, and also with Council, as my individual relationships with councilors
will be an exciting continuation in my year as Chairman of the Board

Thank you for this opportunity,

Stephen C Best
2002-2003 PPA President

7 feel that the greatest reward for doing is the opportunity to do more. Jonas Salk

PPATODAY  Augutt 2003 P |
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[ PPA

2003 AN-NE AWARDS

Exhibit your marketing prowess in the largest, most distin-
guished competition of photography promotions: the 2003
AN-NE Awards. A competition that grows in prestige every
year, the AN-NEs are held by PPA to honor professional
photographers for excellence in marketing their services.
The first place entrants from last year's competition were
recently honored at PPA's Awards Ceremony at the Imaging
USA convention in Las Vegas, as well as at the celebration
party that followed. Throughout the three days, convention
attendees had the opportunity to familiarize themselves
with last year's winning and finalist entries, which were on

display in the trade show area.

This is a competition for PPA members. Members may
enter promotions in any or all of the ten categories, but no

more than one entry per category The categories are:

Broadcast Advertising
» Campaign
Charitable Marketing

Direct Promotion

Internet Promotion

Portfolio

Print Advertising

Specialty ltems

Studio Newsletter
* Video/CD-ROM Brochure

Register today and see how your marketing efforts fare on
a national level. Please address all entries to PPA; AN-NE
Awards; 229 Peachtree Street NE, Suite 2200; Atlanta, GA
30303. All entries must be postmarked no later than
October 31. 2003 and must include the $35 entry fee.
Critiques are available upon request for an additional $10
per entry  An official copy of the rules and a more detailed
description of each category can be found in the July issue

of PPA Todayor at www.ppa.com.

P2 PPATODAY :Auguu 2003
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THE 2003 AN-NE AWARDS: ENTRY FROM

Name:

Business/Studio:

Mailing Address:

City:

State: Zip:

E-mail Address:

Phone: () Fax: ()

CATEGORY
J Broadcast Advertising O Critique?
Title of Entry:

J Campaign O Critique?
Title of Entry:

J Charitable Marketing O Critique?
Title of Entry:

3 Direct Promotion O Critique?
Title of Entry:

J Internet Promotion O Critique?
Title of Entry:

J Portfolio O Critique?
Title of Entry:

J Print Advertising 3 Critique?
Title of Entry:

J Specialty Items 3 Critique?
Title of Entry:

J Studio Newsletter 3 Critique?
Title of Entry:

J Video/CD-ROM Brochure J Critique?
Title of Entry:

Entries xS35+ Critiaues x S10 = Total

J If you feel that the marketing piece(s) you have entered do(es) an outstanding job of promoting the
benefits of PPA Certified status to consumers, check this box to be considered for the prestigious
Certified Award. (If you have submitted more than one entry, please specify which one(s) you would
like to be considered for this award.)

Payment Options:

J Check Enclosed JVisa J MaterCard _JAmerican Express
Card Number: Expiration Date:

Name on Card.

Important! All entries must be postmarked no later than October 31, 2003. All entries and payments
should be sent to: PPA, Atten. AN-NE Awards, 229 Peachtree St. NE, Suite 2200, Atlanta, GA 30303. If
you have questions about this form or the competition, please call

800-339-5451, ext 250, or send e-mail to hbest@ppa.com.
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GOUNCIL NOMINATIONS DEADLINE SHPTHVBER 1, 03

August is your last chance to submit Council nominations for the upcoming Fall election. All nomina-
tions must be made in writing, and they must be received at PPA Headquarters by September 1, 2003

Council plays an important governing role in PPA Among other tasks, this group elects members to
PPAs board of directors. Councilors meet annually at PPAs convention and have other responsibilities
throughout the year, such as attending state and local association meetings, reporting to the state
membership on PPA activities and encouraging membership in PPA. Council is PPAs legislative body,
which guides the organization from its roots, directing the association's programs and policies.

A nominee must be a current member of a PPA Affiliate and must be an Active, Retired or Life member
of PPA An eligible party may be nominated by an Affiliate group or by the petition of five Active,
Retired or Life PPA members from the same state/province.

For more information about making a Council nomination, contact June Youngren at 800-339-5451, ext. 236.

SUPER MONDAY NOVHVEER 3,2003

Clear your calendar for PPA's semi-annual educational extravaganza— Super
Monday. Your copy of the November 3, 2003 Super Monday catalog is included
in this issue of Professional Photographer.

Hosted by experienced professional photographers around the world, these one-day
seminars cover the entire spread of imaging topics for a variety of skill levels.

With more than 100 class offerings from marketing and digital to portrait and
wedding, you'll find programming tuned to your interests in a location that suits you. Whether you
choose to explore a new subject or re-examine a familiar one, the intimate setting of most seminars
will allow you to get the most out of your educational experience. PPA members receive a merit for
their attendance at one of the programs.

Pre-register for only $99 by October 13, 2003. (On-site registration is $120.) For more information on
courses in your area or to register, call 800-786-6277.

'"ANVARD AND DEGREE RECIPIENTS

PPA would like to congratulate all the deserving individuals who were honored at the association's
Awards Ceremony at the Imaging USA convention in Las Vegas on July 29, 2003.

The ceremony, which was open to the public, provided formal recognition for a number of substantial
achievements and contributions. Some of the awards presented have been established in the industry
throughout the history of PPA and some of them were presented for the first time this year.

The night included a Leadership Training presentation, AN-NE Awards, Imaging Excellence Awards,
Director's Awards, the Harold Bovee Juror Meritorious Service Award, the Ross Sanddal International
Award, the Gerhard Bakker Award, the Lifetime Achievement Award and presentation of PPA degrees.

All of these awards and degrees were earned by individuals who put forth tremendous time and effort
to advance the profession, the industry and themselves. PPA thanks them for their continued efforts!

03-'04 IMPORTANT
m
PPACOUNCL  peadline: September 1,2003
NOMINATIONS
WOMEN IN September 19-21,2003
PHOTOGRAPHY
RETREAT
PPAMEANS  geptember 28-29,2003
BUSINESS
6iwer November 3,2003
Monday More than 100 single-day
seminars held at studios
around the globe
MARKETINGAND  January 18-20,2004
MANAGEMENT &
SENIORS
CONFERENCE
FAMLY AND January 20-22,2004
CHILDREN &
WEDDING
PHOTOGRAPHERS
CONFERENCE
PE DIGTAL February 7, 2004
CONFERENCE v (precarierencs)
February 8-10,2004
IMAGIMG./SA  Imaging USA Convention
2004

July 25-27, 2004
Las Vegas Convention Center
Las Vegas, NV

TO REGISTER OR FOR MORE INFORMATION
VISIT WWW.PPA.COM OR CALL 800-786-6277

PPATODAY :August 2003 P3
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PPA

THANK YOU SPONSORS!

PPA would like to take this opportunity to thank the
generous sponsors of the completely restructured
Imaging USA, which took place last month, July 27-29,
2003. Their support has made it possible for PPA, yet
again, to bring overwhelming opportunity in the form

of this event to the entire photographic industry.

PREMIER SPONSORS:

EPSON~*

Kodak

CHAMPION SPONSOR:

MARSH

Affinity Group Services
a service of Seabury & Smith

DEDICATED SPONSOR:

P4 PPATODAY August 2003
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WOMEN IN PHOTOGRAPHY RETREAT

DISCOVERY...CELEBRATION...INSPIRATION

When:
September 19-21, 2003

Where:
Wyndham Buttes Resort -

Tempe, Arizona

Cost:
$249 until June 30th
$299 after June 30th

Space is limited to the first 200
people, so don't delay.

Register Today!
Online at: www.ppa.com

By phone at: (800) 786-6277

PPASs highly anticipated first annual Women in Photography
Retreat is rapidly approaching. September 19-21,2003,
200 photographic professionals will abandon their stress
and gather at the beautiful Wyndham Buttes Resort in
Tempe, AZ for three days of discovery, development

and rest.

Some of the top names in the industry will be on hand to
share insight and personal experiences pertaining to the
issues unique to women in photography today. The result
will be a relaxing celebration of past achievements, as

well as an inspirational look forward.

Programs will be led by the renowned Helen Yancy,
M.Photog.M.Artist.MEI.Cr.Hon.M.Photog., Carol
Andrews, M.Photog.Cr., Joyce Wilson, M.Photog.Cr.
and others, who will explore difficulties women face in
not only this industry, but in the business world at large.
Attendees will discuss barriers, solutions and new ideas

in a comfortable and supportive environment.

To register or learn more today, call 800-786-6277 or visit

www.ppa.com. Registration is limited to 200 attendees.
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SOMETHING HERE YOU NEED

Product Mall

P)
Improve your sales-

aD Clients buy all the proofs!

Cover- $3.60
= (w/image and name)!
@ Comb binding and vinyl back

cover included!
® Brian
S W
<L
CD 20-03 AS A

Michigan Photo Company
121 S. Jefferson, Saginaw M| 486071

More info? Circle 45
Glc
first edition books**:™

714.841.6900

More info? Circle 46

www.wghooks.com

On Beautiful Marbie

PhotoStonc.Com
r. 800.350.3003 P. 858.490.4255
info@ photostonc.com

More info? Circle 47

tRONAY GET

PRODUCTS TAP
PACKAGING
QUICKLY AND EASILY!
Call for your free 68 page catalog

1.800.827.0363

Visitour web site at
www.crown-usa.com

| t a p Art Employee Owned Chilcote Company

Your Source for

More info? Circle 48

Light Boxes...

“"Hall Light Boxes are the best! We've used
them for years with 100% satisfaction.”

John & Barbara Gerlach

www.hallpro.com i-800-366-6057

Hull Productions, P.0. Box 3505. San l.uis Obispo. C A 93403

More info? Circle 49

MORE BUCKS
FOR YOUR CLICKS!

The easy way to sell more prints.

Photo slip-in cards
from

Master®ount

make it simple

to add

BIG BUCKS

to your bottom line

Call now for your FREE catalog, wholesale
price list & special new customer offer.

800-424-1118

jjaster ffount
23-19 College Pt. Blvd. « College Point. NY 11356

More info? Circle 50

canvas
muslin
props
tracks
lift
systems

800-237-1883 FREE CATALOG
www.hackgrouiulsbyinalieu.coni

More info? Circle 51

Customizable,

Lightweight,

Durable,

Insulative,

Shitx'k Absorbent,

Airline Shippable

Cases for Cameras and Equipment.
Ilease call or write for our fnv (.atalog.
Lightware, Inc. 1329 W. Byers Place
Denver,CO80223 .303/7443)202

A UGHTWAR

More info? Circle 52

2003

CATALOGUEI
order yours\
today by

calling

The World's Largest
Manufacturer of Backgrounds,
Props & Reiated Accessories

www.dennymfg.com

More info? Circle 53
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Jones Flash Brackets

The Professional* Choice for
over 40 years -1.800.523.9944

More info? Circle 54

Mat UXntkUi UM il

EPRESOM
TAD - r

>
1800.621-6649

WWWMICHELCOMPANY.COM

More info? Circle 55

www.TheBackgrounders.com
New muslin Designs only on Web

Joseph M. Proscia
818-508-8908 fax 818-762-0624
Free catalog Favorite Classic Designs

More info? Circle 56

High School |

Mailing Lists %
for Graduation

Pictures >/
Contact us for a new view
e old probl

American Student list has berm providing high
school student mailing lists to hundreds of
satisfied portrait photographers since 1971
High school seniors and juniors ate available on
pressure sensitive labels for your marketing area

Contact a vtles representative or visit our website at
www.studentiist.com foi additional
information

New York loll free American Student List
888-462-5600 a Ssrvxi or Euaosue am

fax 516-248-6364
Honda to# Free 888-550-8548
Fax 561-988-5500

The Most Trusted Name In Youth Marketing

More info? Circle 57
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37007 S. Oak St.
Kennewick, WA
99337

Hot Foil Stamping Machines
GS 491 K Shown $279.00 - Use Logos or Type Sets
Orders or Info Call 1-800-523-9944

Fax 509 /586-7774 GoldRiter Pens
WWW.VeachCO.com Photo Button Machines

More info? Circle 58

PICTURF FRAMES, INC

Monufackxw & Distributor of G Nally Picture frames & Presentation
Specializing In High Quality:

Ready Made Frames
Custom Moulding
Graduation & Easel Back Frames

800-578-7252  Fax 877-949 1396  excelptclurefromes com

More info? Circle 59

We ship the same day
Order toll-free: 1-800-325-5179
FAX: (270) 527-0444

More info? Circle 60

foto white - 1805394

timeless clothing and accessories wwwfotowhite com

Adivision o f 37007 S. Oak
The leach <ompany Kennewick. WA

. W- 99337
fc&i# MH Fax 509 586.7774

More info? Circle 61

" U * now available on-line!

topflightaloums.com

More info? Circle 62

PLATINUM GICLEE™

THE FINEST IN BW PRINTMAKING

Jonathan Penney, Inc.
631-874-3409 wwv.jonathanpenney.com

Call for FREE SAMPLE

More info? Circle 63

em in i.
Moulding, Inc

Your

NEW

Source for:
Ready Made Frames
Photo-Mats
Framing Supplies
Color Catalog Available

Elgin,IL
Ph: 800-323-3575

More info? Circle 64
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RENAIS*NCE

It’s true! Your order receives same day,
hassle-free service from most of over 25
U.S. distributor locations.

For information, catalog, etc. contact:
AlbumX Corp. ¢ 21 Grace Church Street
Port Chester, NY 10573 « (914)939-6878 U.S.A.
Web site: www.renaissancealbums.com

More info? Circle 65

BACKDROP OUTLET

ITHI

ORDER ONI IN
wwv.backdropoutlet.com
Save 5% Web code #0302

BACKDROP OUTLET
2215 S Michigan avs
Chicago IL 60616
312-842*6550
312-842-6546(FAX)

More info? Circle 66

T PROFITABLE lists for "
PHOTOGRAPHERS!

GRADUATING SENIORS
FAMILIES WITH CHILDREN
Newborns « PetOwners « Brides to Be
ON PEEL & STICK LABELS OR DISKETTE
Our lists are the BEST..WE GUARANTEE IT!
NOW..NEW LOWER MINIMUM
Need advice? Ask us..we care!
CALL TODAY FOR COUNTS FOR YOUR AREA!

Se,rtH'c& $

PHONE AND FAX TOLL-FREE
Ph: 800-870-4358 Fax: 888-710-3956

www.ndmservices.com

National Direct Marketing Services
5107 280th St. NE ¢« lowa City. IA 52240

The #? Supplier of Marketing Lists
L to Photographers...Since 1982/

More info? Circle 67

CUSTOM DIGITAL
Book Binding & Printing

301.231.7050

piCT0222 pictobooks.com

More info? Circle 68

Introducing ..

Eloquence

A story unfolds in pictures ...

Create your own masterpiece with
our elesant, library bound album.

Kambara USAs

P.O. Box 747, Tualatin, OR 97062 U S A.
800-662-6650 + Fax: 503-692-7929
www.kambara.com skambara©kambara.com

More info? Circle 69

MUSEUM QUALITY

OIL PORTRA

Painted from your portrait images
High revenue product.
www.masterpieceoils.com

More info? Circle 70

FRAMES

Designed for the
Professional Photographer

¢ EasyClip Mounting < Non-Glare Acrylic
¢ Drop-In Mountin”®_*Clear Acrylic
« Backingjujangecrs

+ |-'oliu i tames
Order Online al .
\WiMAardaoodhinBiH<>n
Hardwood

Framt is MERCA

4285 Old Tasso Road * Gevdand, TN 37312
1-800-426-1933 « 1-423- i'2-9593 « hardtwxxltrantes.com

More info? Circle 71

More info? Circle 72

FREE SHIPPING
on orders over $150D (0] S t (0] f

anufoctuw sine*

The
Muslin
MOVGI’
% @V\Nﬁé ®
2 x GN- 139 00
‘C”Hiiﬁér‘iubockrounds
Hands-Free Studio r]/Iuinns
Pneumatic .
Posjng Sgool
ﬁg washable colors
VoV
Complete i* Numbers" }I—JnT :4
10x12'
2 light
Mover* J W Baby P
Rail System 0y Baby Poser
$74.
From $579
+ Intfoflt In vl any Ko or wi
*Mod~ in fo USA by (ve«si |
(800)627-0252 FREE Calalogl

| Fax (800)627-0267 _ _

700 Products

More info? Circle 73

Imaging Software
Headquarters

* Green Screen Software
Sports & Event Software
Studio Software

Package Printing Software
School Software

800+844*5616
www.dennyelectra.com

More info? Circle 74
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The Eloquence Library
Bound Collection Display Kits

Eloquence Studio Display Kits available in
Ebony on Ebony with Presentation Case.
8x10 Eloquence Display Kits $128.45
11x14 Eloquence Display Kits $187.00
Coll 1-800-662-1000 to order your Display Kit today!

everything after
the photography

714 120-PI PRO

More info? Circle 75

YOUR MOST VERSATILE PROP

Roger Cum Phicugruphv

Unique, Child-Size and Adult-Size
Antique Reproductions!

*Victorian *('hippendale
sLouis XV *Queen Anne
GhilJ*

Call | 8<X)-264-(X>'X) or write P.O. Box 240493
Dept. PPA. Montgomery, AL 36124

More info? Circle 76

More info? Circle 77

60 ¢ professional Photographer ¢ August 2003

Attention
All
Digital
Photographers!
Tallyn's offers

Digital Image Recovery

for all removable digital media
including Flash Cards & IBM Microdrives!

If you have accidentally reformatted, erased
your media or cannot see your data, simply
send your media card to Tallyn's for full data
recovery. This new in-house service is being
offered to give peace of mind to digital
professional photographers at a reasonable rate!

For details visit us on the web at:
www. tallyns. com/DataRecovery. htm
or Call 1-800433-8685

Tallyn’s Professional Photographic

More info? Circle 78

*
ﬂ
EyiufHHMt Division

ASKFORA FREE CATALOG

45-45 39th Street, Sunnyside, NY 11104
Tel: 718-349-2700 Fax: 718-482-9463
Toll Free: 866-639-2528
www aitximsweb.com

More info? Circle 79

WOODEN
NICKEL
ALBUMS, INC.

900 US Hwy 68
Benton, KY 42025

TAP FOLIOS
4x5 8-OPENING

BUY 6 GET 1 FREE
BUY 25  $8.75 EA.
BUY 50 $8.45 EA.
BUY 100 $8.25 EA.
SALE ENDS 7-4-03
Order toll-free: 1-800-325-5179
FAX: (270) 527-0444

More info? Circle 80

Digital Output made simple,
uncomplicated and profitable

whcc

Our rapidly growing client base
speaks for itself™
Ask Around!

8x10...$2.00 16x20.511-25
30x40 .S39.95 greeting cards $0.42

White House Custom Colour

(800)252-5234 «www.whcc.com
1185 Selby Avenue.Saint Paul, Minnesota 55104

More info? Circle 81

the MOTITIS CO.

Lighting and Accessories

1205 W Jackson Bivd

Chicago. Il 60607

312/421-5739

lax: 312/421-5079

our website www .themorriscompany.coni
: mail us info@themorriscompany.com

More info? Circle 82

5 colors
* 3 sizes

Available
with mirror
2 sizes

Maximize Profits with the largest
variety of photo novelties available

450 E. Bunker Ct. Vernon Hills, lllinois 60061 U.S.A.
Phone: 847-549-7627 « Toll Free: 800-621-5584
Fax: 847-549-0349 « Website: www.neilenterpnses.com
E-mail: info@neilenterprises.com

More info? Circle 83


http://www.aitximsweb.com
http://www.whcc.com
http://www.themorriscompany.coni
mailto:info@themorriscompany.com
http://www.neilenterpnses.com
mailto:info@neilenterprises.com

R enaissance
I0e doita llin -Aot/se..

Custom
Digital

From Design - To Print « To Bookbinding
Up to 15"x15" books(30" page spreads)
Call 212-274-8699 www.tbebookalbum.com

More info? Circle 84

OMNI-BOUNCE

Used by Professionals around the world, to achieve

soft natural lighting with most of the popular brand Hash

units. Ideal lor wide angle shots, macro work, portraits

and news coverage. Custom mounting with no Velcro

required. Specify your strobe when ordering

Only: $19.95 + $2.00 shipping. Visa & Mastercard
STO-FEN PRODUCTS « 800-538-0730

PO Box 7609, Santa Cruz. CA 95061. USA
vrww.stolen.com

More info? Circle 85

Location. Location. Location.

Bring the world's ureatest locations into your studio.

#

www.virtualbackgrounds.net
800.83 1.0474

%

photo k> Joseph iV Louise Simone

More info? Circle 86

(# Lindahl

Professional
Bracket System

For Your

Digital Camera

The Lindahl System starts with a Rotating Camera
Bracket that will accommodate many professional

digital cameras An optional Flash Bracket keeps
the strobe centered above the lens for vertical
and horizontal composition To complete the
system, a Lens Shade may be added to prevent
lens flare, and allow the use of many Lindahl
filters and vignettes.

Manufactured By:
Photo Control Corporation

4800 Quebec Avenue North, Minneapolis. MN 55428 USA

Telephone: 1-800 787-8078 or 763-537-3601
e-mail: pcc-info@photo-control.com

www.photo*control.com

More info? Circle 87

Copyright
STAMPER

Made With Your Custom Wording
INK DRIES IN 15 SECONDS

Developed www.superiorrubberstamp.com
Call, Fax or Send for Brochure

s J r  PUBBER STAMP & SEAL, Inc.

po Box 2258 « Wichita. KS 67201
* | 1(800) 227-0329 Non Fri 8 00am -500pm
“Since 1967" 24 Hr. Fax 1-800-242-9312

More info? Circle 88

n ft

FOAMWAY,COM

TREND SETTING PUZZLE -WAY® SYSTEM

Props Built To Go Your-Way

FREE SAMPLES AVAILABLE ON RECUEST

More info? Circle 89

(Joer (D years o cExcellence

AOY MADF f RAMfb

Custom | rami *

Graduation framfs
I AST | HAC K | RAML s
Weooing Albums
Proof Hooks
Pmotomounts

7In> L etun (ompany

THE PROFESSIONAL'S CHOICE SINCE 1920

manufacturers and Distributors

1111W.Walnut Street. Compton.CA 90220
800-345-4999 Fax:310-608-7418
WWW .LEVINFRAMES.COM

w2 UQ(temt
HaiBM i-J awi f*

More info? Circle 90

BACKDROPS
Backdrops that:

« Last longer

« Cost less

« Ship faster

« Give you

winning photos

FREE
CATALOG

STUDIO DYNAMICS
7703 Alondra Btvd., Paramount. CA 90723

1-800-595-4273
www.studiodynamics.com

More info? Circle 91
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CLASSIFIED ADVERTISING

Classified rates: « $1.20 per word; '$1.90 per word
words with all caps or bold face. « $10.00 per issue
- Confidential Reply Box Ads (Optional). Closing
date is 15th of the second month proceeding issue
date. Remittance must be received with order.
MO ADS ACCEPTED BY PHONE, Remittance to
Professional Photographer Classified Ads, 229 Peach-
tree NE, Ste 2200. Atlanta. GA 30303; 800-339-5451,
ext. 230; FAX 404-614-6406. !

ALBUMS

EVERYTHING AFTER THE PHOTOGRAPHY . .
WEDDING ALBUMS, FOLIOS. PLAQUES, PHOTO-
MOUNTS, FRAMES AND SUPPLIES ORDERS SHIPPED
SAME DAY RECEIVED to studios, wedding and portrait
photographers, and frame shops Name brands Pro-
Craft, Florentina. Topflight, Renaissance. TAP, Yankee
Plak, Crescent. Sureguard, 3M. Jorgensen, LAD. FREE
wholesale catalog. MasterCard/VISA/Discover/
American Express, ALBUMS INC., P.O. Box 361809, Dept
PRO-C. Cleveland OH 44181 TOLL FREE ORDERING
1-800-662-1000. interneVwww.albumsinc.com

BACKGROUNDS

HORIZON BACKGROUNDS: Muslin or Canvas,
many styles, great prices! Shop online www.horizon
backgrounds.com. Call 800-369-6904 for free brochure.

THE DENNY MFG. CO., INC. is the wor ds largest
manufacturer of backdrops, props and related studio
accessories. Call today for free catalogs with
information regarding hand painted backgrounds,
computer painted backgrounds, lift systems, and much
more' Write PO Box 7200. Mobile, AL 36670, Call 1-800-
844 5616 or visit our Web site at wwwdennymfgcom

BACKDROP FABRICS

) NEW!BLACK, 18% GRAY
AND SKY BLUE MUSLIN. Wide Seamless Canvas
12'. 10, 8\ 7.6" Fabrication available Fabric Dyes in Bulk,
b >r intit vsV mgrommets CURTAIN TRACK
& HARDWARE FOR MOVEABLE BACKDROPS-
FITS ANY AREA! CHICAGO
CANVAS & SUPPLY 3719 W Lawrence Ave , Chicago
Il 773-478-5700 www.chicagocanvas.com

STUDIO DYNAMICS' Volume 17 Catalog of handpainted
muslin and canvas backdrops is now available Discover
quality, value and service at outlet prices!! Call 1-800-595-
4273 ore-mail catalog@studiodynamics com for a free copy

BACKDROP OUTLET has the Highest Quality. Lowest
Prices and Best Selection Order Online!
www backdropouttet com Backgrounds from $69.00

$99 For a 10x21 Muslin (Great Selection) 2-Sided
Mu in Scemc.; Clearance and MORE! Quick
Turnaround! Order online or call toll free
www signaturebackgrounds com 877-346-5614

CAMERA REPAIR

MAMIYA RB-67 REPAIR ng in professional
cameras since 1970 Jack's Camera Repair, 324 E
North St. Ithaca. M| 48847. 1-800-896-9458

HASSELBLAD OWNERS: Factory trained technician with
27 years experience exclusively with the Hasselblad
system Previously with Victor Hasselblad Free estimates,
prompt service, reasonable lates and a 6 month guarantee
David S Odess. 28 South Main Street. #104. Randolph.
MA 02368, 781-963-1166 HBLAD10atthi.com

COMPUTER/SOFTWARE

Studio Software for the Digital Photographer.
DIGITAL SALES ROOM, ALBUM ARRANGER and
ABERFILE STUDIO MANAGER. Twenty years of
providing customized software for Professional
Photographers Web Site www.abersoft com; e-mail
abersoft&aol com. phone 707-933-8133
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SUCCESSW ARE*—Studio Management Software avail-
able for both Windows" and Macintosh* Recommended
by Ann Monteith, the nation's foremost studio management
consultant. Call today for a FREE SuccessWare* Tour 800-
593-3767 or visit our Web site www.SuccessWare.net.

FREE PHOTO STORAGE CATALOG-— Large
selection of Photo. CD. Slide, and Digital Image
storage solutions. Request your FREE Century
Business Solutions Catalog, call 800-767-0777 or visit
www CenturyBusinessSolutions.com

HOW SAFE ARE YOUR PHOTOS? Find out
download FREE White Paper at www.cdsteeves.com/
Tfatalmistakes.html.

DIGITAL

DIGITAL PHOTOGRAPHERS— Kessler Color produces
STUNNING images from digital files. Try our rapid FTP
site and get a FREE 16 x 20. New Service— E-Vents
from Kessler Color. Get 8x10 units for $1.00.
info@kesslercolor.com. 1-800-KES-LABS.

REAL TRADITIONAL fiber base paper black & white
prints from your digital files. Archival processing for
permanence. Prints to 40"x60". The Photo Factory 800-
479-4997 www.photofactory.com.

DIGITAL PRODUCTS: From film or digital cameras. Senior,
sports and wedding composites. Trading cards, mag.
covers, buttons, magnets. B&W restoration, senior retouch-
ing. Sunset Color Lab 1077 Gravois Rd., St. Louis MO
63026. 1-800-648-1855 or e-mail Irphotonlab@aol.com

ONLINE PROOFING AND FULFILLMENT SERVICES
High quality proofing site to increase sales and
expand marketing efforts. Deliver orders for your lab
or DigiProofs to fulfill. Sales@digiproofs.com.
DigiProofs. NASA Research Park. Moffett Field. CA
650-944-7528

WARNING! Before you spend another dime on digital
photography you must get your hands on our FREE
Special Report “Digital De-Mystified". The no-
nonsense report that reveals how you can skv-rocket
vour digital skills and profits using proven and time-
honored strategies that are amazingly simple vet powerful
E-mail your request to: westmount@bellnet.ca or
phone 705-566-0111

EQUIPMENT FOR SALE

NORMAN 200B AND 400B BATTERIES. New.
Hi-capacity Use your original Norman chargers.
Kirkham's Studio, 235 N. Getty, Uvalde, TX 78801; 800-
355-4417 ekirkham@ncc.net. VISA. MC. DISCOVER

REPAIR LONG ROLL and Studio Lighting: fast turnaround
time and reasonable prices PHOTO SERVICES INTERNA-
TIONAL INC., 1-800-346-3631 photoserv@photoserv.com

CAMERZ zIl Split View with Digital Proofing Several to
choose from. In stock, checked out and ready to ship.
Leasing available to qualified customers PHOTO
SERVICES INTERNATIONAL INC., 1-800-346-3631
photoserv@photoserv. com.

DIGITAL EVENTS EQUIPMENT PACKAGES: IN STOCK

ounted prices. PHOTO SERVICES INTERNA-
TIONAL INC., The Camera Store for the Professional*
Photographic- 1-800-346-3631 photoserv@photoserv.com

CAMERA ZIl, NEW & USED n stock At discounted
prices. Lowest Price, guaranteed FREE extra 1year war-
ranty on new ZIl PHOTO SERVICES INTERNATIONAL,
INC. 1-800-346-3631 photoserv@photoserv.com

FIRST ON THE SCENE with the GREEN: Turn your
Idle Assets into liquid cash For large quantities we will
come to you PHOTO SERVICES INTERNATIONAL
INC. 1-800-346-3631 discounted prices PHOTO
SERVICES INTERNATIONAL INC., The Camera Store
for the Professional Photographer. 1-800-346-
3631 photoserv@photoserv.com.

ESR DIGITAL GEAR SWEEPSTAKES
Enter To Win at www.estudioresources.com
e-Commerce for Digital Professionals

THE BEST prices on EPSON 10600.9600, 7600 printers,
inks, and media. FUJI S2, PG4500, and 3500 IN STOCK.
Financing available 1-888-459-1482 Pro Photo Gear,
www.prophotogear.com.

BRONICA ETR Equipment for sale all in EXCELLENT
condition. ETR Sl body in box $600,40mm PE in box $750,
75mm Ell $250,120 back $225. Call John at 256-541 -0542.

FOVEON DIGITAL CAMERA— Perfect for Commercial
or Portraits. Comes with many accessories and software.
Call 615-264-3281 or e-mail: fotogfrl@bellsouth.net

HELP WANTED

WEDDING PHOTOGRAPHERS!! Experienced wedding
photographers wanted in Orange/Los Angeles
County Must own professional DIGITAL CAMERA
equipment Call 562-404-7822.

WEDDING PHOTOGRAPHERS: Earn $1000/weekend!
Expanding quality studio seeks experienced medium format
photographers in Pennsylvania, New Jersey, and Delaware.
Work year round and earn what you're worth! Part-time
and full-time opportunities available, plus free seminars
and on going training provided. Significant advancement
potential! Call 800-274-3256, extension 115 for more info.

WEDDING PHOTOGRAPHERS WANTED! St. Louis studio
looking for experienced medium format wedding and
portrait photographers. Weekend, part, full time
opportunities available for exceptional people. Offer
benefit package including health & retirement. E-mail
resume/experience to weddingpro@earthlink.net.

You can't afford NOT to work for us! WEDDING
PHOTOGRAPHERS wanted Los Angeles. Orange County
Riverside #1 in Southern California. Great Company—
Work all year GUARANTEED. Professionals only. Great
Pay, Bonuses & Incentives. Contact Terry at 213-388-
1212 ext.204 or Terry@celebrationphotography.net

LARGE CENTRAL OHIO 20+ year old portrait/event
studio looking for a creative, highly motivated High
School senior portrait photographer. 2-3 years
experience with contemporary senior portrait styles.
Digital knowledge and experience a plus! We are 90%
digital with in-house state of the art DIGITAL LAB.
SUPER financial package with benefits, and will help
with relocation. Call Kerry at 614-402-0466 for more info
on this great opportunity. Resumes can be sent to:
Photo-Graphics, 4121 E Main St.. Columbus, OH 43213.

SENIOR PHOTOGRAPHER—Experienced with
digital and film. Wanted in Central Ohio area to join our
team of creative professionals. Please contact Monica
at Cubberly Studios 614-890-7458

WEDDING PHOTOGRAPHERS WANTED! St Louis
studio looking for experienced medium format wedding
and portrait photographers. Weekend, part, full time
opportunities available for exceptional people. Offer
benefits package including health and retirement. E-
mail resume/experience to weddingpro@earthtink.net

LAB SERVICES

BLACK & WHITE LAB SERVICES by Master Printmaker
Jonathan Penney - Custom Fiber and RC to 30x40;
sepia toning, proofing and more. Free sample of new
“Platinum Giclee" Call 631-874-3409 or visit us at
www.jonathanpenney.com

SPORTS PHOTOGRAPHERS See ¢ vwwsportsphoto.com
FTP. Digital Printing. Quality, Service, Value. The most
versatile program available.

THE BEST LAB FOR WEDDING AND PORTRAITS
offering real Black & White papers and chemistry for the
finest quality Black & White film processing, machine proofing,
hand printed resin & fiber enlargements up to 40"x60".
Serving professionals since 1971 Phone 800-479-4997 for
a pnce list and paper samples or www.photofactory.com.
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SCHOOL PICTURE PROCESSING: Complete
service available including format packages from
70mm or 46mm and 35mm film. Proms, Memory
Mates, Classroom Group Pictures, and Hand Lettered
Composites. Elementary and Junior High Memory
books and Church Directories. Fast service and higher
quality from Herff Jones/Camera Art. Box 100
Lewiston, MN 55952. 507-523-2101, WATS 800-533-
8030 HERFF JONES/PROFESSIONAL FINISHING

DIVISION, 12221 Riverwood Dr. Burnsville, MN
55337, 612-890-2200 WATS 800-328-2924 UNITED
PROMOTIONS INC.

DIGITAL PRINT SERVICES—GICLEE, FUJI PICTROG-
RAPHY 4000, CARBON BLACK INKJET PRINTS, 4"x 6"
B&W PROOFS. Giclee prints on watercolor paper or
canvas up to 44" x 90“—Fuji Pictrography 4000 prints up to
12“x 18“—Carbon Black Inkjet Prints on watercolor paper
up to 44“x 90" —4"x 6“ Black & White proofs on real black
& white paper CONNECTICUT PHOTOGRAPHICS 128
East Liberty Street, Danbury, CT 06810. Call or e-mail for
current service brochure. 1-800-CT-PHOTO (287-4686)
or visit our web site www.ctphoto.com

ACADEMY PRODUCTIONS INC.:

YOUR FULL SERVICE PACKAGE PRINTING LAB.
* Four day in-lab service
« Competitive prices
« Consistent quality
« Video editing for best choice and composition
* Day Care, Underclass, Fundraisers, Glamour, Church,
Store Promotions. ABC Packages, Wallet Proofs
« Packages available from 46mm, 1/2 70mm,
120-220 crop “D"
« A wide variety of packages to choose from,
11x14, 10x13, 8x10, 5x7 and wallets
« Complete Professional Department for proofing and
wedding candids
« Sport packages, Trader Cards, magazine covers
« CD Rom Products available, long roll automated
digital scans
For more information on our many professional
services. Call 1-800-421-3523 Or write Academy Produc-
tions Inc , 6100 ORR RD., Charlotte, NC 28213. Visit
our Web Site at www.AcademyProductionsinc.com

e FULL SERVICE LAB -
e NEW DIGITAL SERVICES s«

PACKAGE FINISHING, 5x7, 8x10, 10x13. 11x14,
16x20, and 20x24 packages from 35MM
perforated (short roll), 35MM unperforated (long
roll), 120/220, 46MM, Split-70MM, Ideal Format
(6x7cm) and Full 70MM film. Fund Raisers,
Family Photography, Store Promotions, Glamour,
Proofing, Day Cares, Schools with Service Items,
Photo CD Roms. Classmates. Composities.
Seniors, Proms-Dance.

SPORTS PACKAGES DIGITAL PRODUCTS,
DIGITAL, trading Cards (Image on both sides),
Magazine Covers, Sportsmate Composites, Title
Groups, Calendars and Digital Custom Designing,
STANDARD 3 1/2" Photo Buttons, Magnets or
Mirrors, Photo Cutout Magnets. Statuettes,
Groups-Posters (Up to 20"x30").

FULL WEDDING SERVICES, Gold Foil Stamping
and many more services for the professional
photograher TOP QUALITY, COMPETITIVE PRICES
AND FAST DELIVERY. Ask about our 4 Day In
Plant Delivery on year-round packages

UNITED PROMOTIONS, INC.
433 Lawton Road, Charlotte. NC 28216-3317
800-362-4441 or 704-391-2992
E-mail us at sales@upilabcom
Visit our website at www.upiiab.com.

KODAK 135, 120/220 PORTRA FILM processing and
proofing. Two day in-plant service. Complete senior finishing
services Wallets through 40x60’'s. HERFF JONES

PROFESSIONAL FINISHING DIVISION Herff Jones

Box 100. Lewiston .MN 55952, 507-523-2101, WATS
800-553-8030. Herff Jones, 12221 Riverwood Drive,
Burnsville. MN 55337,612-890-2200. WATS 800-328-2924.

SCHOOL PHOTOGRAPHERS

Call us now at 800-766-3686, Ext. 122, for all your
School Photography needs. We're experienced
Package Printing Specialists and we want to help
grow your business!

ALSTON SCHOOL PHOTOGRAPHY, INC.
54 Brunswick Ave., Edison, NJ 08617
American s Finest Portraits Since 1947~
We proudly offer School Photographers
«Top Quality School Portraits from long roll 35mm
and Split 70mm Film
*Sports & Proms from 120 220 and 35 perl.
* Fast Delivery
+CD-ROM based products including:
ID Cards, Certificates, Administrative Reports
and more!
*Volume Discounts
*« Fast Technical Support
«Co-op Marketing Programs
« Equipment Sales
«Convention Support & Materials
*24 Hour Customer Service
*The Finest Kodak Materials

CALL US NOW! 800-766-3686, X 122

REAL BLACK & WHITE RESIN and fiber base paper
professional printing for the portrait and wedding pho-
tographer. Pearl finish borderless of artistic (sloppy)
border proof prints, www.phototactorycom or call toll
free 800-479-4997.

LIGHTING SUPPLIES

LIGHT BULBS—Pureland Supply stocks every type of
photographic studio bulb including halogens, flash-
tubes, photofloods, and modeling lamps at deep
discounts. Secure online ordering at
www.PurelandSupply.com or call 800-664-6671

PHOTO RESTORATION

YOU'VE SEEN OUR WORK inthe movies and on TV and
read about us in magazines. When your name is on the line,
don't risk working with anyone but the best. After 9 years in
business and over 150,000 photo retouch and restorations,
we can honestly say we are the world's leading wholesale
only digital imaging company. We have the easiest web
based system, the latest software, the most talented and
experienced artists and the most satisfied customers!
We even hire Photoshop gurus to train our artists on-site!
Forget the headaches, and make photo restoration
profitable with  www.hotiywoodtototix.com Were so con-
fident that you will love our quality, pricing and service that
we're willing to prove it Send us your worst near unrestorable
(or retouchable) photo and we Il restore it for free Upload
up at www.Mlywoodfotofix.can or call 888-700-3686

C ementation boxes

BOXES—FREE SAMPLE PRESENTATION BOX—
Fast delivery, Finest quality 4 "x5". 5"x5", 5"x6". 8 "x10", 11 "x14
16"x20". 20 x24 AUFENGER BOX. 4807 COLLEY AVE.,
#10, NORFOLK,VIRGINIA 23508; 757-440-1147 (phone);
757-440-1149 (FAX), www.aufengerbox.com

PRESENTATION BOXES available for immediate
shipment; 19 sizes - 4 stock colors. For FREE catalog
& samples call 800-969-2697 or fax request 800-861 -4528.
BUY DIRECT AND SAVE. NPD Box Company. 3000
Quigley Road. Cleveland, OH 44113 www NPDBox.com

B 0 XES—'Ale carry a Full Line of Presentation Boxes. Con-
tact us for FREE sample and price list Paper Box &
Specialty Company, Box Makers Since 1929. Phone: 1-888-
240-3756, E-mail: pbslinda@excel net, Fax: 920-459-2463

SALES AIDS ~

BOXES— FREE SAMPLE PRESENTATION BOX—
Fast delivery, Finest quality 4"x5", 5"x5", 5"x6 ", 8'x10",
11"x14". 16"x20". 20"x24 AUFENGER BOX, 4807
COLLEY AVENUE, #10, NORFOLK,VIRGINIA 23508;
757-440-1147 (phone); 757-440-1149  (FAX).
www.aufengerbox.com

GRADUATION CAP AND GOWNS for kindergarten thru
college. 165-46A Baisley Blvd., Suite 9. Jamaica. NY 11434-
2517 Phone 718-978-9866 Fax 718-723-5009. E-mail
conjacq@att.net. Visit www.photographersgowns.com

SENIOR FRAMES: Dramatically increase your earnings
on school portraits. Call now and ask for our FREE
School flyer, to be used in each of your proof orders For
details, contact 1-888-673-3386. or visit us on the web at
www. creativetrame. com.

www.PhotographyProps.com
Your source for Photography Props and More! Call 1-866-
PROPS 4 U. Visit our site: www.PhotographyProps.com

PHOTO INVITATIONS printed on quality photo pain  tv
each, minimum 25. Free layout Weddings. Graduation,
Birthdays, etc Samples at www.photoinvitationsonline
com/reseller. E-mail bndev@evl.net. Photo Creations,
Box 5073, Waco. TX 76708.

SPORTS PHOTOGRAPHERS: Trading Cam
Football, Soccer, BB. Lax, Swim, Ballet etc. Only 65c
each -Multiples of 8~ Front & Back. Phone: 410-252
5355 Fax: 410-252-3684. wwwgaleonephotocom

FREE REPORT REVEALS— How | went from a
struggling, starving, nearly dead-broke studio owner
to earning over $100,000 a year using Breakthrough
Client Attraction Strategies and Powerful Business
Building Tactics” Call today 705-566-0111 for your
FREE copy or e-mail weslmount@beiinet.ca

SITUATION WANTED

PHOTOGRAPHER LOOKING tor school portrait work
etc. Contact John at 270 Lane Dr., Hazel Green, AL
35750, 256-541-0542.

STUDIO FOR SALE

PORTRAIT STUDIO established 16 years in Atlanta
Georgia, 3.000 sq.ft, schools/teams/weddings. A great
opportunity @ $95K. Great Location. Full color
lab/digital lab Call for Information 770-538-5829.

CENTRAL NEW YORK Residential Studio established 1976
Seniors. 8K+ underclass, sports, gross S260K+ Fall
season all set. Nice small city. Four bedroom home.
1500sq ft studio, outdoor shooting area. Great place to
raise a family. $235,000 complete. Will consider sale
without real estate. 607-865-7714.

CUSTOM PORTRAIT studio with great client base. Beautiful
facility in the heart of northern Michigan. Perfect opportunity
for a portrait artist to work and live in the finest outdoor back-
ground God has created 616-752-7230. Leave message.

CANADIAN COMMERCIAL PORTRAIT STUDIO forsale
South Central Ontario. Solid 17 year reputation to diversified
& affluent clientele. Digitally established and fully operational
Great opportunity at $95K. Please conta< tgnifkir@nv* com

IHAVE DONE THE HARD PART! My 12y«Mt 11 'ti.nt
wedding, senior and commercial studio located m N |

Ohio is an excellent opportunity tor a highly competent
photographer Do not start at the bottom when you can step
into this very successful business with a high quality repo
tation We are 100% digital but still maintain film base
equipment and B&W darkroom. I will stay on up to lyear
for proper transition. | am ready to retire and motivated to
selll E-mail inquiries to Studio4saleP003@yahoo.com

WORK AND PLAY In m'" j

Well-established Weddmg/Portrait studio for sale with
living quarters Excellent reputation and excellent
growth opportunities Call Mark toll free at 866-746 5340

HARD WORK inthe future for the experienced photr >y
rapher that buys this studio. A gross of $250,000 without
weddings is achieved through non-contract seniors, kids
and families A large metropolitan city on | ake Erie sup-
ports this 3500 sq It all digital shop established sixteen
years ago. All my headaches are yours for only $80,000.
Please E-mail me at urcrazy2photo@yahoo com

MIAMI FL— 1600 sq ft. Established 37 years Fully
equipped Call 305-266-0149

GREAT START-UP OPPORTUNITY—DES MOINES,
IA. WEDDING'PORTRAIT STUDIO. Perfect oppoi
tunity to work with brides. Could be digital/fiim studio
Owners retiring. Reasonably priced 515-280-8591

studio management

PHOTO ONE STUDIO MANAGEMENT SOFTWARt
studio management software used by America's best pho-
tographers Flexible and customizable to fit your studio's
individual needs Compatible with Microsoft products. Quick
Books, ProShots. Express Digital, and more Free technical
support and product upgrades for a full year Download your
free demo at wwwgramtebearcomor call 1-888-428-2824

SJUmcTs WANTJIED

COLUMBUS CAMERA GROUP, INC. buys whok
dios or any part including cameras, film darkroom,
long roll, lighting, and rnisc. No quantities too small
Call 800-325-7664 Ask for Eric
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wind/als

Deals, discounts and giveaways
-for our readers only. Auto px Software

Enhance your creativity with Auto FX Software. With
seven different programs to choose from, you never
have to settle for ordinary photos again! Add edges
and frames or adjust the lighting and shading in your
images to provide a whole new look! All Auto FX
Products work as stand-alone programs as well as plug-
ins to Photoshop. Explore galleries and download
demos at www.autofx.com. Call 205-980-0056 before
September 30, 2003, and receive 20 percent off of regular
priced products when you mention Windfalls.

General Products

Digital Showcase Albums are ideal for professionally
presenting your digital images. General Products offers
8)4x11-inch and NEW 10x13-inch digital albums. Buy 12
albums and get 1 FREE by mentioning PPA Windfalls. This
special offer expires October 31, 2003. Call 800-888-1934
or visit www.gpalbums.com for details.

Pop-Up Room

Bring convenience and privacy to your next
outdoor photo session. Pop-Up Room offers
the new "5 in 1 Multi Pop-Up" changing room.
This newly redesigned wider and taller
changing room is designed especially for
photographers. Each wall is a different fabric
(black, white, shiny silver and shiny gold) to
serve as a reflector when collapsed. Mention
Windfalls and only pay $99—regularly

$139.95. Call 888-305-2950 to order.

Price valid through 10/31/03.

Digital Juice Q\

Obtain the perfect starting point for any print
project. Juice Drops Layered Photoshop files make it
possible to add layers, tone down colors, change
layer compositing modes and customize Juice Drops
graphics and make them your own drop layers. Visit
www.digitaljuice.com or call 800-525-2203 and mention
code A83D522 for an additional $50 off when you buy 8
volumes or more. Offer expires September 15, 2003.
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Whether you re looking tor a digital proohng vehicle
or afinal album to present to your clients, GPs new
line for digital imaging captures just what you need.
You retain creative control with these easy-to-assemble
albums and folios. GP helps you keep costs low,

while making presentation quality

a high priority.
Digital Presentation Folios and Digital Slip-in Inserts for The Digital Mounting Inserts for The Idigital Premiere and Showcase
CD/DVD Folios Legacy Collection - available in I-egacy Collection - available in Albums - available in 8 1/2 x 11

10x10 and NEW 10x15 sizes 10x10 and 7x7 sizes and NEW 10x15 sizes

Make the most of your digital work with G.P.
For more information on our fine new products, call us at 1-800-888-19 M,
visit: www.gpalhums.com or e-mail: info@gpalbums.com

GENERAL PRODUCTS L. L C
Since 1934

Digital images courtesy of: Michael Ayers, Bmce Evensen, Peter Ilybhen, Larry’ Peters and 1llie Vayo More info? Circle 38
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LEAF'MAMIYA OGnAL
LEAF'MAMIYA ft DtGflAL

The Leaf Mamiya ProDigital 6 and ProDigital 11 are the result of an extraordinary
collaboration between the leaders of the digital capture and camera worlds.
Together they have designed a medium format system that excels at both digital and
film imaging. Add the Portable Power Solution option for the world's first large
6x7 preview screen, plus battery-powered interchangeable Digital Magazine, with
storage space for up to 350 uncompressed images. And, you'll be astounded
by the unparalled quality-of-file you get with legendary Leaf Capture V8 software.

IN THE STUDIO ON LOCATION.

STARTING at $9,999 LEASE: As low as $239/mo.
Only $1,000 down & 10% buyout.
Limited time offer based on approved credit.

For a personal demonstration call: 8Q6-4US-LEAF More info: www.leafamerica.com

LEAf AMERICA
8 Westchester Plaza

Elmsford, NY 10523 Le af
Phone: 866 487 5323

Photogiaph © Jock tautklti
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